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Introduction

Welcome to VisualAnalysis 5 

What’s New? 

This latest release of VisualAnalysis incorporates many improvements 

and changes over previous releases.  One of the biggest differences is the 

introduction of an advanced level of the product.  VisualAnalysis now 

comes in three levels: basic, standard, and advanced.   Some features 

described in this documentation may not be available if you have 

purchased the basic or standard level of the product. 

Note: VisualAnalysis Advanced is 
documented separately! 

This printed documentation provides the core documentation for all three 

product levels, but does not cover details of advanced-only features.   In 

fact, many of the advanced features are not even mentioned in this 

printed User's Guide.  Please refer to the on-line help or the 

supplementary PDF file for advanced features. 

Here is a short outline of the major changes, improvements, or features 

incorporated into version 5. 

Easier Than Ever 

More Automatic 

¶ Auto-Create New Project 

¶ Auto-Open Last Project 

Cool Modeling Tools 

¶ Mouse Wheel Support – Zoom, Pan, and Scroll  

¶ "Fly-By" Information – Hold the Mouse over an element to get 

its information  

¶ Automatic Cut Planes at key levels and elevations 

¶ Expanded Generate Standard Library 

¶ Invert Current Selection Feature 

¶ Quick Open Example Files menu item 

¶ Moveable Graphic Title Block 

Improved Databases 

¶ Shape Database includes over 6700 shapes 

¶ Design-Smart Shapes 

¶ Material Database includes over 50 different materials 

¶ Easily Add Custom Materials 

¶ New Design-Smart Materials 
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Enhanced Picture View 

¶ Clearer Graphics 

¶ Properly View Custom Shapes 

¶ Perspective Option 

Reporting 

¶ Simplified Wizard 

¶ Use Project Units 

¶ Enhanced Stability 

¶ Independent Result Filtering 

¶ More Information Reported 

Advanced Engineering 

Advanced Members 

¶ Faster, More Accurate Tapered Members 

¶ Faster, More Accurate Centerline Offsets 

¶ Distinct End-Zones on each end of Members 

¶ Thick Plate Element Formulation 

New Load Features 

¶ Auto-Created Load Cases 

¶ Automatic and Smarter Load Combinations to support Building 

Codes 

¶ Copy and Scale Loads to other Load Cases or other Elements 

¶ Supports Directional Wind and Seismic Loads 

¶ Filter Loads Values & Labels 

¶ Scale and Adjust Selected Loads 

¶ Filter Loads by Loaded Elements 

Enhanced Analysis and Results 

Analysis Features 

¶ Completely New FEA Engine 

¶ Get Results Up To 6 Times Faster

¶ P-Delta Plate Analysis

¶ Robust, Extensible, more Capabilities, "Multi-Threaded"

Result Features 

¶ "Fly-By" Results – Hold the Mouse over an element to get on-

the-fly results 

Release History 

VisualAnalysis 5 represents only the latest in a ten-year history of this 

product.  Here are the highlights of previous releases of the software 

¶ Version 4.01, December 2000 

¶ Version 4.0, June 2000 

¶ Version 3.5, November 1998 

¶ Version 3.11, November 1997 

¶ Version 3.1, September 1997 
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¶ Version 3.0, December 1996, 32-bit Windows 95 version. 

¶ Version 2.5, September 1995 

¶ Version 2.1, June 1995 

¶ Version 2.0, December 1994 

¶ Version 1.0, May 1994, first commercial release. (IES started in 

March 1994.) 

¶ WinFinite Version 1.5, January 1994  (WinFinite was a non-

commercial product developed by future IES partners at 

Montana State University) 

¶ WinFinite Version 1.0, January 1993 

First Installation 

VisualAnalysis and related add-ons are designed to work on the 32-bit 

Windows platform.  This includes Windows 98, Windows Me, Windows 

NT 4.0 (service pack 6 or higher), Windows 2000, and Windows XP.  It 

may also include future versions of this platform.  There is no support for 

the MAC OS (although some emulators may work), Windows CE, Linux 

or Unix, OS/2, or Palm OS.   

VisualAnalysis has minimal hardware requirements.  Most machines that 

can run Windows can run VisualAnalysis as well.  The minimum 

requirements are a Pentium class CPU, 64 MB of RAM, an SVGA 

monitor and video card.  Of course a faster CPU and more RAM will 

provide increased performance.  Problem size is unlimited, but there is a 

practical limit based on RAM.  For the best results, a video card that 

supports OpenGL and is updated with the latest drivers is also 

recommended. 

Installing VisualAnalysis is fairly simple.  If you received the program on 

CD, then you typically just need to insert the CD into your computer and 

it will auto-run.  Once the CD auto-runs you should see a presentation.  

Just follow the steps to install VisualAnalysis.  If you bypass the auto-run 

feature or for some reason the auto-run does not work, you may use 

Windows Explorer to browse the CD and find the installation software.  

If you downloaded a demo from our website, once it is installed you may 

proceed to entering the licensing information as described below. 
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Network Installation 

Introduction

Why install on a network? 

¶ Updates are centralized 

¶ Saves space on client machines 

¶ Works even with individual licensing 

This section is intended for network administrators installing VisualAnalysis 5 on a 

network system.  VisualAnalysis has been working fine on a variety of network 

platforms for many years.  This document will help you understand what happens 

when VisualAnalysis is installed and what you can do to minimize the time and 

energy it takes to get VisualAnalysis running on multiple client machines.  Because 

of the differences in goals and implementations of customer networks, IES has not 

tried to provide a specialized network installation and setup procedure.  Instead, we 

describe here how everything works, what needs to get installed, and some possible 

suggestions. 

VisualAnalysis package consists of VisualAnalysis, VisualDesign and 

VisualTools.  These products are all installed with their own 

SETUP.EXE file and should be done in that order.  For simplicity, this 

document references just VisualAnalysis, but all three products are 

implied. 

What Happens during VisualAnalysis Installation 

The installation of VisualAnalysis is really a very simple, conventional 

installation for a Windows application.  There are five main operations 

that take place: 

1. Copy program files to the installation folder 

2. Copy or update shared files in the appropriate system folder 

3. Copy or update IES shared and customizable data files 

4. Write entries into the system registry 

5. Setup Start menu entries and desktop icons. 

Step 1: Program Files 

Normally, these operations are performed on each client machine.  To 

save space, and reduce effort in maintenance, you will probably want to 

place the program files on an application server machine.  This group of 

files includes help files, example projects (read-only!) and other 

miscellaneous files that go in the application folders. 

Step 2: Shared Files 

The shared and system files in step 2 must be available to each client 

machine and are best installed on each client machine.  For minimum 

update work, you may choose to move these files into the program folder 

on the application server.  See the "System or Shared DLL Components" 

section for more information. 

Step 3: Shared Data 

The IES shared and customizable data files must be located on each 

client machine (or more accurately, each client must have a private copy 
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of this data).  VisualAnalysis does not support concurrent editing of 

customizable data, so allowing clients to share these files is a recipe for 

disaster!

Step 4: System Registry 

Finally, we store basic application information in the system registry.  

This information includes paths to program files and data, version 

numbers, and more.   This information must be stored in the local system 

registry for each client machine.  You may also have other means as a 

network administrator for distributing registry keys.   

Step 5: Start Menu 

The normal workstation setup software also creates program groups for 

the Start menu, and will place an icon on the desktop.  In a network 

environment, you will want to do this manually or by replicating the 

shortcut entries that are created. 

VisualAnalysis Licensing 

Note:  Individual license keys may not be 
shared or distributed. 

There is actually a sixth step in the installation of VisualAnalysis that involves 

entering a license key to unlock the software.  Without this key, VisualAnalysis will 

run as a 30-day free-trial program on each client and after the time has expired it will 

no longer function. 

The licensing step simply writes the licensing information (Name, 

Company, Key) to the system registry where VisualAnalysis finds it and 

validates it.  This information must be stored on the client machine’s 

registry and will have to be entered on each machine one time only.  You 

may do this manually, or you may publish the registry key in the form of 

a .REG file.   

VisualAnalysis Customizations 

When running VisualAnalysis, an engineer has the ability to customize 

the behavior, organization, and other attributes of the software.  This 

information is stored in the system registry (for the most part).  You may 

want to define these customizations before distributing the registry 

information required for installation, and include them in the distribution.  

If you do not, each client will start with all of the default values.  Most of 

these customizations are accessible and modified through the Tools | 
Customize Toolbars, Tools | Customize Keyboard, Tools | 
Customize Appearances, and Tools | Customize Behavior menu 

items in VisualAnalysis.

There are also customizable data files that include report styles, shape 

database, load case templates, material database, and unit systems.  These 

customizations are recorded in files that go into the IESCommonFiles 

folder (step 3) in the installation process.  You may want to distribute 

pre-customized files to each client during the installation to ensure that 

all clients have access to company standards for these items. 



6 ¶ Introduction User's Guide VisualAnalysis 

Networking Limitations in VisualAnalysis 

While VisualAnalysis software generally functions OK in a network 

environment it is not really a full-fledged network application.  There are 

two key limitations:  

1. No CONCURRENT ACCESS of Projects (.VAP files). 

2. No CONCURRENT ACCESS OF customizable data files. 

Proposed Method for Network Setup  

The first step in a network installation is to install the software normally 

on a single machine.  Most simply this will be the network application 

server, but it can be any machine.  After installing the software make sure 

it runs OK, and enter the license key for your company using Help | 
Software License.   

Then you (or a “chief engineer”) may want to make various 

customization modifications as discussed above.  You may want to make 

additional customizations to the various data files.  You might want to 

define unit systems, report styles, load case templates and more.  See the 

VisualAnalysis (and VisualDesign and VisualTools) User’s Guides for 

more information. 

If you are updating or upgrading an installation, you might want to copy 

the customizations from one engineer’s machine.  The registry key to 

copy is “HKEY_CURRENT_USER\Software\IES\VisualAnalysis\5.0”.  

If you are installing more than just VisualAnalysis you might want to 

copy the whole IES registry folder.  The customizable data files are 

located (by default) in the \Program Files\IES\IESCommonFiles folder, 

and you can overwrite the default files with modified versions. 

Prepare for Client Installations 

The next step is to make preparations to install the appropriate files and 

registry entries on each client machine.  There are four items to install.  

You can gather these components into a staging area on the server and 

then use a batch or script method to distribute the components to each 

client. 

System or Shared DLL Components 

There are a number of files that IES normally installs or updates in the 

system folder on the installation machine.  There are two approaches to 

making these available on client machines.  The safest method is to copy 

or update these files in the system folder on each client machine.  This 

method ensures that the appropriate files are up-to-date for all 

applications.  This would be the preferred method for any Microsoft or 

other 3rd-party files that we install.  (These files change much less 

frequently than IES files.) 

IES uses a number of shared component DLL files that are used for 

multiple IES applications.  These files are also (currently) installed in the 
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system folder to make them easily accessible.  You may move these files 

into the VA50 folder (or its equivalent) on the Application server.  If you 

are running multiple IES applications you should update all occurrences 

of these files in other application folders as well.  This approach will 

make updating to later versions of the files a one-machine problem, as 

each client machine will not need separate copies of the files. 

Customizable Data Files 

The IESCommonFiles folder should be duplicated on each client 

machine with all of the customizable data files included.  This folder can 

be installed anywhere, but if you change the default location (\Program 

Files\IES\IESCommonFiles) then you will need to make appropriate 

edits in the registry entries, as discussed next. 

Save IES registry Entries to .REG files 

There are two registry sections that you should distribute to each client 

machine.  These are: 

1. HKEY_LOCAL_MACHINE\Software\IES 

2. HKEY_CURRENT_USER\Software\IES 

You can run the registry editor, locate the above keys and save them as 

.REG files.  These files can then be “merged” into the local registry for 

each client machine.  You can merge the two .REG files with Notepad, 

and then simply double-click on the file from the client machine.  You 

may also have tools at your disposal to automatically merge this 

information to the client registries. 

Start Menu and Desktop 

The only other items that you may wish to install on the client machines 

are Start menu entries and keyboard shortcuts.  You may copy the 

relevant shortcut files from the application server machine to the client 

machines.  A small batch file will probably do the trick, after you copy 

the shortcuts and modify the target paths to point to the application server 

installation of the program or help file. 

Client Installations 

Once you have the necessary files and registry entries organized 

installation to the client machines is fairly simple.  You can set it all up 

as a batch file that is just run once from each client machine to copy the 

files and merge the registry entries.  You may also have more powerful 

tools available for distributing this information directly from the 

application server to each client automatically. 



8 ¶ Introduction User's Guide VisualAnalysis 

Updating Previously Installed Software 

IES posts updates to www.iesweb.com/freetrial.htm periodically.  We 

normally send out an email when any major changes are made, but you 

might check monthly.   

In most cases, updating the IES software for newer builds (bug fixes) 

requires you to simply re-install on the application server machine and 

then move any system or shared DLL components that have changed.  It 

is rare that information installed on individual client machines will need 

updating, but you can check the dates on files and distribute those 

changes with the same procedure developed for the fist installation. 

Upgrading from VA 4.x, 3.x 

If you are upgrading from a previous version of VisualAnalysis, the 

software will be installed to a different folder than the older version by 

default.  VisualAnalysis 5.0 should open most of your old project files.  If 

you save them in this version, you will not be able to read them in the old 

version.  Prior versions of VisualAnalysis should not conflict with the 

new version, therefore, you may elect to leave the old version on your 

computer or you may uninstall it.  We recommend you make backup 

copies of all of your old project files before tying to open them in the 

new version to avoid any possible loss of data. 

You may wish to import your old VisualAnalysis 4 Report Styles into this 

version.  See the chapters on Reporting and Customizing for more 

information. 

Installing Updates 

There are two main ways to keep VisualAnalysis up to date; through 

WebUpdate or download the updates from iesweb.com.  To use 

WebUpdate, go to Help | iesweb.com | Update VisualAnalysis.

Upon doing this it will prompt you to save and VisualAnalysis will close.  

The simply follow the on-screen instructions to update VisualAnalysis.

The other way to update your software is by downloading the updates 

from Help | iesweb.com | Customer Center, which will bring you 

to the IES Customer Center on the web.  Choose the Install Updates link 

and then choose the latest version of VisualAnalysis to download and 

install. 

When installing updates, please do not uninstall the current version of the 

software on your machine.  See the section below about uninstalling for 

more information, but in general uninstalling is usually not the solution 

to a problem.  The updates, no matter which method you use, are 

designed to replace only those files that are out of date and therefore 

should be applied to the version currently on your machine. 

The update process should not jeopardize project files or customizations 

you have done, but as always, IES recommends you keep backup copies 

of any saved projects or customized data files. 
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Uninstalling

When should I uninstall IES software?  You may need to uninstall 

your IES software for obvious reasons, for example you are removing it 

from an old machine.  Please do not uninstall the software for errors or 

bugs unless instructed to do so by technical support.  Often times the 

problem or error can be solved much more easily by other methods.  If 

you are having problems with your software, one of the very first things 

to check before calling technical support is that you have the latest 

updates and patches.  You can determine which version you have by 

going to Help | About VisualAnalysis.  You can then visit the 

Customer Center on our website and determine if you have the most 

current version or not. 

To uninstall, use the Windows built-in uninstall support.  Go to Start | 
Settings | Control Panel and choose the Add/Remove Programs
icon.  Locate VisualAnalysis in the list and follow the instructions there 

to uninstall the software.  Uninstalling the software will not always

remove all components of the software.  On occasion shared system 

components, data files, and registry entries that were not originally 

installed cannot be removed by the uninstall script.  It is possible to 

remove these files manually but often they cause no harm and can be left 

as is. 

Installation Problems and Solutions 

If you experience problems during installation there are a few known 

issues you should check before calling IES technical support.  If you are 

trying to install on a Windows NT, 2000, or XP machine you may not 

have administrative privileges associated with your account.  You should 

see your computer administrator about getting these privileges or having 

them install the software for you.  If you are running Windows 98 or ME 

you may need to simply reboot your machine after the installation has 

finished. 

About License Keys 

VisualAnalysis, like all IES software, operates as a free trial version until 

you enter your licensing information.  The license key is not 

automatically entered when the software is installed.  Go to the menu 

Help | Software License and enter your name, company name, and 

license key exactly as it appears on your CD. 

This information is usually attached to your CD, but you may have 

received it via email or fax as well.  If the licensing information is valid, 

a message will appear indicating which products have valid licenses.   

Licensing information needs to be entered: 

¶ To convert a free trial to a fully licensed version. 

¶ To transfer the license to a new individual. 
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¶ After a system crash that destroys the registry. 

¶ If you have purchased add-ons or other IES products.  (You 

only need to enter the new key once in any IES program.) 

Why doesn't my license key work?  Before calling technical support 

please try re-entering you license key exactly as it appears.  The license 

keys are CaSe SeNsItIvE.  Please verify that we have spelled your name 

and company name correctly.  Occasionally, we may misspell your name 

or company name on the license key, however, if you correct the spelling 

as you enter the key, it will not work.  You may email or call to obtain a 

corrected key. 

The license agreement is included with the software when you install it, 

and is posted on our website.  Essentially, the single-user license 

agreement states that you may personally use the software on as many 

machines as you want, but that additional licenses are required to allow 

others to use the software.  If you have purchased a network-concurrent 

license, then the software is for anyone to use on the network at your 

location, up to the maximum number specified at any one time.  For 

more information please visit the IES Customer Center on our website. 

Resources for Learning 

Need help, instruction, or just general information?  One of the first 

places to start is with the built-in help in the software.  Go to Help | 
Contents to browse the documentation by topic or search for a specific 

item.   

The very manual you are reading is a good source of help and 

information, but is not as current or easily or comprehensively searched 

as the built-in help. 
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Web Site 

Many helpful PDF documents can be 

found on our website.  Many of these 
documents also exist on the CD your IES 

software was shipped on. 

For the most current information, included in VisualAnalysis are links to various 

resources on our website.  Go to Help | iesweb.com where you may access the 

Customer Center, Frequently Asked Questions, and much more.  The Customer 

Center is the main hub; from here you can access our Tips and Tricks section, latest 

Newsletters, subscribe to the User's Group, and do many other things. 

Trial and Error 

We believe one of the best ways to learn VisualAnalysis is through trial 

and error.  It may help to see one of the presentations on the CD or to go 

through the Quick Start, to jump-start the process.  But you will learn the 

most by doing.  We build VisualAnalysis as though there was no manual 

or help available.  You should be able to find your way around. 

The User’s Guide 

This book contains the core reference that you can read in an easy chair.  

In answers the questions “How Do I?” and “Why?” that you may ask 

when using VisualAnalysis.  If you are new to VisualAnalysis, or 

Windows software in general, you will benefit greatly from reading the 

Essentials chapter.  If you are new to finite element analysis, you should 

definitely read the chapters on Analyzing and Engineering. 

The Quick Start 

The Quick Start booklet is a five to fifteen minute walk-through of a 

small 2D project.  We offer tips along the way.  If you only have five 

minutes, work through this book. 

The Tutorials 

The VisualAnalysis Tutorial is a collection of step-by-step solutions to 

problems like ones you might face.  There are two very detailed tutorials 

that are almost as good as having one of our engineers come and type for 

you!  Then there are a number of example projects that demonstrate 
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various capabilities of the software.  They are detailed enough that you 

should be able to follow along and do the steps yourself. 

User's Group 

Lastly, the User's Group is a great place for engineers using IES software 

to discuss ideas, ask questions, and bring up concerns relevant to using 

the software.  A couple of things the User's Group is NOT.  The User's 

Group is not the official IES email notification list, which is maintained 

by IES for notifying customers and interested engineers of updates, 

specials, new products, marketing surveys, newsletters, and other official 

IES correspondence.  The User's Group is not the way to contact the IES 

Technical Support staff.  Although IES may monitor the User's Group 

and jump in with answers or suggestions, we can provide much faster 

and specific service to customers through direct support channels.  As 

mentioned, for all the latest information regarding the User's Group and 

subscribing information visit the Customer Center at 

www.iesweb.com/customer.htm.

Extending

VisualDesign 

VisualAnalysis by itself will provide displacements, reactions, and 

internal forces and stresses.  It will not tell you whether your members 

are adequate to meet building code requirements.  IES offers an optional 

add-on called VisualDesign that will take you full-circle.  VisualDesign

can check members against AISC, ACI, NDS, and AISI specifications.  It 

will also resize members based on your criteria using a least-weight 

search.

If you did not purchase VisualDesign, you may try it free for 30 days, 

whenever you like.  It is on the CD and the clock does not start until after 

you install it and run it the first time.  (This is true for all our products!) 

VisualTools

VisualTools is strictly for the VisualAnalysis power-user.  It contains 

extra features that did not quite fit within the scope of VisualAnalysis or 

VisualDesign.  Currently the tools include a Continuous Beam Generator, 

Tributary Area Load Generator, Preliminary Member Sizer, Steel Base 

Plate Design, Concrete Footing Design, Soil-Spring Generator, UBC 

Response Spectrum, Bill of Materials Reporting, and the Clipboard 

Exchange Tool.  If you could use just one of these tools it will justify the 

cost for this add-on. 

ShapeBuilder

VisualAnalysis includes a newly expanded and enhanced database of 

shapes and a new material database.  Unfortunately, engineering can be 

more complicated than just picking a steel shape from a table.  
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ShapeBuilder will provide geometric section properties for just about any 

shape an architect could dream up.  You can build a section from 

manufactured shapes, parametric shapes, or simply sketch them 

graphically.  Use ShapeBuilder to directly add custom shapes to the 

database for use in VisualAnalysis and potentially VisualDesign.  That’s 

right, no more Custom.dat! 

Shape and Material Database Editors 

These two editors are used for importing and editing the new material 

and shape databases in IES products.  Check under Start | Program 
Files | IES or contact IES for availability. 
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Essentials

This chapter contains the information critical for getting the most out of VisualAnalysis.  You will 

learn to control the software and get your work done efficiently. 

Directing

Understand the Layout 

Here is the default layout of windows and controls in VisualAnalysis.

The major sections of the window are named for easier reference later.   

Please note that many of the screen elements can be hidden or moved to 

create a custom working environment. 
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Use the Main Menu 

The main menu in VisualAnalysis is the backbone.  It is generally not 

customizable or overly dynamic and will always provide the commands 

you need.  The menu is organized according to standards set by 

Microsoft guidelines and software to help make it easier for you to use.  

It is also organized logically for the engineering tasks that you will 

perform. 

Many menu items have Keyboard Shortcuts so that you can access the 

command without actually locating it in the menu.  For example, by 

default, Ctrl+F toggles the Find tool. 

Menu items are necessarily short.  If you are not quite sure what a menu 

item does you should look to the Status Bar.  The Status Bar normally 

provides menu hints, which are one-sentence descriptions of commands.  

If a menu item is disabled, the Status Bar hint changes to tell you why the 

command is not available. 

Use the Context Menu 

Most windows in VisualAnalysis provide a Context Menu.  This menu 

provides a subset of the commands in the main menu that have been 

dynamically chosen by the software depending on the situation.  Access 

this menu by using your right (or alternate) mouse button.  (We normally 

think of this as a Right-Click, but your mouse may be configured 

differently.) 

This should be your first choice when looking for a command because 

the available commands have been reduced to a more meaningful set.  

The commands in this menu are generally grouped according to their 

position in the main menu to help you locate them faster. 

Use the Mouse 

The mouse is a key component of the VisualAnalysis interface.  You will 

use it extensively to sketch models, select objects, bring up the Context 

Menu, activate controls, and more.   

In version 5 the mouse becomes even more useful with the addition of 

mouse wheel support.  The commands are documented at the bottom of 

the table below.  

To Click the mouse means to press and release a button.  To Drag the 

mouse is to press a button and hold it down while moving the mouse. 

When you see Shift+ or Ctrl+ this means that you should press and hold 

the appropriate key on the keyboard as you click or drag the mouse.  

Here are some of the commands available in most graphic views: 
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Mouse Operation Description 

Click

or Left Click

(Primary Button)

Selects the item or object under the mouse cursor.  

All other items are usually unselected.   

Some lists allow a single click to toggle the selected 

item without changing the state of other items. 

If the View | Zoom | Area command is active this 

will either start or finish the creation of a “Zoom 

Box”.

Right Click

(Alternate Button)

Open the Context Menu (also called a popup menu).  

Also used to access “What’s This?” help in some 

situations. 

Shift+Click In a list, selects everything in a range. In a graphic 

view, selects all objects of one type. 

Ctrl+Click In a list or in a graphic view, it toggles the selection 

of the item under the mouse without affecting the 

selection status of other items. 

Shift+Ctrl+Click Selects all the model items with the same Name 

Prefix as the item clicked on. 

Double Click In a Model View or Report View, opens the edit 

dialog for the object.  In a Result View or Design 

View this will generate a Report View for the object. 

Drag In a Model View, this can create members or plates.   

Ctrl+Drag Holding down the Ctrl key and dragging a node will 

move it to a new location in a Model View. 

Shift+Drag In a graphic view, draws a “Selection Box”—

anything visible inside the box is selected.  

Everything else is unselected. 

Shift+Ctrl+Drag Same as Shift+Drag, but does not change the 

selected state of other objects. 

Wheel Rotation Zooms in or out of the model at the mouse location. 

Click and Drag 

Mouse Wheel 

When drag the mouse wheel (click and hold), a hand 

icon will display.  Drag in some direction and release 

the mouse wheel and the model will pan in that 

direction.

Double Click 

Wheel Mouse 

This performs the same function as the Zoom Normal 

menu command. 

Shift + Wheel 

Mouse 

This scrolls the vertical scroll bar if it is present. 

Ctrl + Wheel 

Mouse 

This scrolls the horizontal scroll bar if it is present. 

Use the Toolbars 

By default there are two toolbars just under the main menu.  These 

toolbars represent frequently used menu items.  Hold your mouse over a 

button for a “Tool Tip”, which is usually the name of the command as it 
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appears in the menu.  Clicking the button is the same as choosing the 

equivalent menu item. 

Toolbars are highly customizable.  You may drag the “gripper” at the 

left or top edge of a toolbar to make it “float” or to “dock it” along a 

different edge of the window.  You can use Alt+Drag to delete a button 

or move it to a different location or toolbar.  Use Tools | Toolbars to 

add your own toolbars or change any of the existing toolbars.  Find more 

information about toolbars in the Customizing chapter. 

Use the Status Bar 

Just like most Windows applications, VisualAnalysis provides a Status 

Bar at the bottom of the window.  Unlike many programs, though, ours is 

an active participant that provides a few key pieces of functionality.  The 

Status Bar takes two major forms of display.   

Normally it will show you a number of Window Tools including these: 

Status Bar Description and Use 

Saved Status Shows “S” to indicate project is saved, “M” to 

indicate project has been modified.  Click on the “M” 

to save the project. 

Project Title Shows the name of the project.  Click on this area as 

a shortcut to Edit | Project Information.

Load Case List or 

Result Case List 

Select the load case to display in the active window.  

For Model Views only Service Load Cases are 

available.  Result Views list all of the various result 

types and times*. 

* times apply to the VisualAnalysis Advanced level 

only. 

Window Type List Change the type of window, select from custom 

Named Views.  Right Click for a Named View 

context menu. 

View Orientation List Select from standard view orientations.  Shows a “?” 

if the rotation angles are not standard. 

Coordinate Display Shows the location of the mouse cursor in a Graphic 

View.  Useful when sketching models in a Model 

View.  If a Cut Plane is active, this will show which 

coordinate is fixed. 

When a menu item is highlighted, the Status Bar changes to show a 

description of the command or why it is not available.  You can turn off 

the display of these menu hints if they are distracting.  Use Tools | 
Customize Behavior, and go to the Desktop tab. 

Use the Project Manager 

The Project Manager provides immediate access to frequent operations in 

VisualAnalysis.  This tool is docked on the left side of the window by 

default and displays two or three tabs at the top.  If for some reason you 

do not see the Project Manager press the F2 Key or go to View | Show 
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or Hide | Project Manager. You may toggle this window if you need 

more space to work, and it can be docked on the left or made to float 

independently—just drag the gripper at the top.  You can also drag the 

side border to make it wider or narrower. 

The Modify tab is used to inspect or modify selected model and load 

objects, while a Model View is active. 

The Filter tab provides many toggle switches and a few other settings to 

control what and how information is displayed in the active view. 

The Grid tab controls the Sketch Grid to help you draw models in a 

Model View.  It also allows you to create or modify a Cut Plane, or 2D 

slice for a 3D view. 

The Result tab replaces the Modify tab if a Result View is active.  This 

tab provides key result information for the active load case.  Most of this 

information is also available in reports, but is displayed here for more 

convenient access as you inspect and verify your results.   

Use the Find Tool 

The Find Tool provides a very efficient way to view, select, and edit 

nodes, members, loads, load cases, design groups and many other aspects 

of your model.  The Find tool is accessed by pressing Ctrl+F, selecting 

View | Show or Hide | Find, selecting Edit | Find, or clicking on the 

"binoculars" button.  The Find tool is especially powerful with more 

complicated projects.  The Find tool will also allow you to find, select, 

edit, and delete objects even if they are not visible in the active window. 

Lists shown in the Find tool may be sorted, resized, and reorganized.  

Double Click on the column titles to sort the list by that column, repeat 

to reverse the sorting order.  Drag the dividers between column titles to 

make columns wider or narrower.  Drag the column title to a new 

position to rearrange the order of the columns.  (Other lists in 

VisualAnalysis also support these features!)  The invert selection button 
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toggles the state of the items listed.  Note that you may also right click on 

the Find tool and make it "float" for easier viewing of it and your model. 

Use the Help Available 

We design VisualAnalysis to be used without any help or manuals as best 

we can.  However, we understand that it offers many features and 

capabilities that might not be discovered or fully understood without this 

documentation.  Please make use of the many forms of help available 

before you contact our support staff. 

Help Source Description 

What’s This? 

Shift+F1

Short, concise descriptions for screen objects and 

dialog box controls.  Look for the “?” button in the 

upper right corner of dialog boxes.  Simply click on 

the "What's This?" icon and your mouse cursor will 

change, then click on the item in question. 

Help | Contents

F1

The full User’s Guide is available within the 

program through Help | Contents or by pressing 

F1.

Web Site FAQ We keep our website updated with technical 

supplements including answers to Frequently Asked 

Questions (FAQs) and Tips and Tricks.  The FAQ 

section of our website may be directly accessed 

through VisualAnalysis by going to Help | 
iesweb.com | FAQ Answers.  The Tips and 

Tricks section and others may be accessed by going 

to Help | iesweb.com | Customer Center.  Be 

sure to check here if you have unanswered questions.

Menu Hints The Status Bar shows descriptions of commands and 

explanations of why they are disabled.

Message Boxes Message Boxes convey important information, 

please take the time to notice the title and read the 

messages carefully.  Often times, messages indicate 

a problem, but they also suggest solutions. 

Dialog Hints Some dialogs offer hints with pictures or text to 

indicate the implications of a choice or setting. 

Quick Start Booklet You should receive a printed or printable version of 

this short book.  It will help you get started with 

VisualAnalysis.

Tutorial Book You should receive a printable version of the tutorial 

book.  These take you step-by-step through common 

projects and demonstrate many of the features of the 

software.

Example Projects There is a folder of example projects that go along 

with the tutorials.  Open these projects and see how 

they are set up.  Experiment with them to understand 

the various features.  Many of these are described in 

a tutorial! 

User’s Guide This book describes each task that you will perform 

with the software and includes detailed information 
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Help Source Description 

about what the commands do exactly, why they 

exist, where to find them, and how you might use 

them.  It also includes some theory and background 

information that you might find useful. 

CD Presentations & 

Documents

We often produce short animated tutorials and sales 

presentations for our free-trial customers.  These are 

often helpful in understanding the software’s 

intended use.  Learn a lot in a short amount of time! 

Keep Current 

VisualAnalysis software is constantly evolving to meet the needs of 

customers.  We find problems and customers find problems by modeling 

unique situations, on a variety of machines.  As we make corrections, 

they are published to our web site (www.iesweb.com/customer.htm).  We 

strongly encourage customers to check for updates on a regular basis.  

You can use the built-in command Help | iesweb.com | Update 
VisualAnalysis to check our web site for these free patches and 

improvements. 

Viewing

Understand Window Types 

VisualAnalysis can show you many different views of your model, loads, 

analysis results, and design results.  You may choose to work with one 

main window or you may prefer to have many windows open and 

available—the choice is yours.  The commands described in this section 

will provide useful tips for helping you manage these windows and to 

control the content each view provides. 

There are seven main types of Windows in VisualAnalysis for you to use.  

These include the four graphic views of your model: 

¶ Model View, for creating and editing models. 

¶ Picture View, for checking element orientations, sizes, and 

materials. 

¶ Result View, for inspecting and finding analysis results. 

¶ Design View, for working with VisualDesign.  (Available only 

if VisualDesign is installed.) 

¶ Object View, other views may be available only in the 

advanced level of VisualAnalysis 

There are also the following supplementary window types for getting 

more specific or detailed information: 

¶ Report View, for custom text and graphic documents. 

¶ Member Graph, for detailed deflection, moment, shear, and 

stress diagrams of member results. 

¶ Plate Graph, for detailed contour plots of plate mesh results. 
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Create a New Window 

When you create a Project, a single Model View is created automatically.  

After you run an analysis, a single Result View is also created by 

default—although you can turn this feature off using Tools | 
Customize Behavior.  To create a new Graphic window (Model, 

Picture, Result, or Design View) use Window | New View and select 

the type of view you would like to create. 

To create a new Report, use one of the Report menu commands. 

To create a new Member Graph, select one or more members in a Result 

View and choose Window | New Member Graph.  To create a new 

Plate Graph, select plate elements in a Result View and choose Window 
| New Plate Graph.

Close a Window 

Windows are not closed automatically in VisualAnalysis.  If you do not 

close them, they will accumulate and could hinder performance.  To 

close a window, locate the ‘X’ button in the upper right corner of the 

window and click it.  If you close all windows in the Project, it is the 

same as choosing File | Close.

Find a Window 

With many windows open or if you use maximized windows, you may 

have trouble finding a hidden window.  Use the Window | Cascade
command to arrange all the open windows so you can see them.  Use the 

Window menu list to find and bring a specific window to the foreground.  

This is also a good way to see how many windows you really have open.  

You may want to close any that are duplicates or that you are not using. 

Change the Window Type 

You may switch a graphic view among the four types: Model, Picture, 

Result and Design using the drop down list in the Status Bar.  This 

changes the information shown while retaining the current set of window 

filters.  Note that Custom Named Views also show up in this list. 

Reports, Member and Plate Graphs cannot be switched to different types 

because they show specialized information. 

Determine what is Visible in a View 

The Filter tab in Project Manager lets you control what is shown in the 

active view.  Check or clear boxes to toggle objects or labels.  There are 

toolbar buttons available for toggling major model objects: nodes, 

members, plates, spring supports, loads, and the sketch grid. 

It is useful to turn off objects when you are not working with them.  For 

example, it is easier to select and edit plate elements if you first hide 

nodes. 
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Rotate the View a Small Amount 

Use the View | Rotate commands, or their associated buttons or 

keyboard short cuts, to “nudge” the view a little.  These commands rotate 

in a positive or negative direction about one of the global axes. 

The amount of the rotation is customizable through Tools | 
Customize, under the Filter tab. 

 A very handy shortcut for rotating your model is by holding the Ctrl key 

and using the arrows to rotate the model. 

Rotate to a Standard View Orientation 

VisualAnalysis provides sixteen predefined view orientations.  These are 

the “standard” views in orthotropic and isotropic projections.  The first 

six show a different face of an imaginary cube located at the origin.  The 

rest bring three faces of the cube into view as shown here: 

Pan the View 

Drag the scroll bar tab to slide the view left, right or up, down.  Moving 

the tab to one extreme position will shift the model in the view in the 

opposite direction such that the extreme edge of the model is centered in 

the window.   
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Alternatively, hold the Shift or Ctrl keys and use your mouse wheel to 

pan the view left, right, up, or down. 

If the entire model is visible the scroll bars are hidden, they will reappear 

when you use View | Zoom | In and you can then pan the view. 

Zoom In or Out 

Use View | Zoom | In to bring the model closer or make it larger in the 

view.  View | Zoom | Out will make the model smaller or appear 

farther away.  The View | Zoom | Normal command will restore the 

default view—the entire model is made visible in the window.  Adjust 

the amount of zooming for these commands using Tools | Customize,

under the Filter tab. 

Now with Mouse Wheel support, just scroll your mouse wheel to zoom 

in or out of the model.  Note that the model will zoom in or out at the 

location the mouse is at.  For example, if you wanted to zoom in on a 

particular node, just hold the mouse near that node and scroll the mouse 

wheel.  The rest of the mouse wheel commands are documented in the 

mouse operation table above. 

Zoom a Specific Area 

To get a closer view of a specific portion of the model, you can draw a 

Zoom Box around the area.  This portion of the model will be shown in 

the window.  Use View | Zoom | Area to start the procedure, the cursor 

will change while you define the area.  You can click to define the upper 

left and then click again to define the lower right corner of a box.  

Alternately you can drag from one corner to the other. 

For best results, you should try to make the zoom box the same shape as 

the window.  VisualAnalysis will not distort the information in the box to 

make it fit.  Instead, the view will be expanded as necessary to conform 

to the window dimensions. 

As mentioned above, the new mouse wheel support allows you to zoom 

an area just by holding your mouse cursor over the area of interest and 

scrolling the mouse wheel. 

Return to a Previous View 

VisualAnalysis records most filter changes and zoom operations.  You 

may undo a series of these changes using the View | Previous View
command.  The record is thrown out if you change the view type. 

View a 2D Slice of a 3D Model 

Working with 3D models can be very confusing if you try to view the 

whole model at once.  One way to simplify things is to view only a 

“slice” of the 3D space.  To do this, use the Grid tab in the Project 

Manager and define a Cut Plane.   

Hint:  A cut plane defines the location of the edit grid, which controls 

drawing in 3D models. 
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The Cut Plane is defined by a plane parallel to one of the global planes 

{XY, YZ, ZX}, a center point or node, and a depth.  The depth is divided 

with half in front and half behind the actual Cut Plane.  The center of the 

Cut Plane is the location of the sketch grid.  If you use a very large depth 

it has the effect of making everything visible. 

Now in version 5, cut planes are automatically setup for your model.  

These planes can be found under Smart Planes on the Grid Tab of the 

Project Manager.  For special cut planes, you may still have to define 

them manually. 

The Cut Plane acts as a filter, anything entirely within the slice volume is 

visible.  A good place to use a Cut Plane is when you want to see only 

one floor level in a multi-story building model.  Cut planes are only 

useful for isolating planes perpendicular to a global axis.  Use Name 

Filters to isolate objects by name rather than location. 

When looking at deflected shapes in a Result View, you may find that 

some objects are hidden because their exaggerated deflections cause 

them to fall outside of a Cut Plane.  The default view in VisualAnalysis is 

an XY slice at Z = 0, with a very large depth. 

Clip the View to Selected Objects 

One easy way to define a Cut Plane is to select two or three nodes or 

elements in your model and choose View | Clip to Selected.  This 

command has the effect of automatically adjusting the Cut Plane settings 

to show objects in the "plane" of the selected objects.    

Use this command as a faster and easier way to define a Cut Plane for 

most typical situations.  This command is not available if the selected 

objects do not define a plane.  For example, three collinear points define 

an infinite number of planes. 

Filter by Object Names 

A great way to simplify and organize large projects is to use a good 

naming system for nodes, members, plates and spring supports.  You can 

filter a view to show only objects with certain types of names.  Use the 

Name Filter area under each object type in the Filter tab of Project 

Manager.  Use the Model | Rename command to help you define good 

names in the first place. 



26 ¶ Essentials User's Guide VisualAnalysis 

A simple name filter might be a single character, “M”.  Think of this as 

saying, “Show me all the members whose names begin with a capital 

letter M.” 

Name filters are very powerful and you can be very creative in their use.  

The software will accept a list of name filters and you can also use 

regular expressions for more control.  For example, [^M] is interpreted to 

mean, “Show me all the members whose names do not begin with a 

capital letter M.” 

The following table provides some of the symbols used to control this 

powerful feature, along with some examples.  Effective use of name 

filters requires some forethought when naming objects.  Spending the 

time to setup a good convention right away though will save you a lot of 

time later, especially with larger projects. 

Symbol Interpretation 

. Matches any single character. 

[…] Denotes a class of characters to match. 

Examples: [0-9] will match a digit,  

                 [A-Z] will match a capital letter,  

                 [A-Za-z0-9] will match any alphanumeric. 

[^…] Negates the class of characters. 

Example: [^a..c] will not match an a, b, or c. 

[…|…] (OR) Match either class of characters. 

Example: [1|3|5|7|9] will match an odd digit. 

+ Matches preceding character or class one or more times. 

Example: ab+c matches “abc”, “abbc”, “abbbc”, etc. 

? Matches preceding character or class zero or one time. 

Example: ab?c matches “ac”, “abc”, but not “axc” or 

“abbc” 

* Matches preceding character or class zero or more times. 

Example: ab*c matches “ac”, “abc”, “abbc”, “abbbc”, etc. 

Animate a Picture View 

Picture Views can show the deflected shape of the model if analysis 

results are available.  You can also animate this view by selecting the 

View | Animate Picture View command when a picture view is 

active.

For static results, the animation will help you see where the structure is 

deflecting, for dynamic results you can also see real-time behavior. 
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Use Named Views 

Hint:  Result Views are great candidates 
for named views.  When analysis results 

are lost – these windows are 

automatically closed, and you can "lose" 
all your filter settings.  Naming the view 

will protect these. 

When working with large, complicated models, you will often spend considerable 

time setting up a good view.  VisualAnalysis will save your views either with the 

project or in a generic form for use on future projects.  Use the View | Name 
Current View command to save the current window type and filters as a named 

window type.  Project specific views also include the zoom level, rotation setting 

and active load case.  You can return to this view by selecting the name from the 

window type selector in the Status Bar. 

Some examples for named views include a Model View of the second 

floor plan, viewed from the top, with section properties turned on and 

other labels turned off, and nodes hidden.  This makes it easy to work 

with the members only. 

Sometimes you will return to a previously named view and decide it is 

not quite right.  In this instance, make your changes and then choose 

View | Update Current View.

To Delete a previously named view use View | Delete Named Views
and select the view(s) to remove. 

Finding 

Find Objects Graphically 

There are many ways to find objects graphically.  The Filter tab in 

Project Manager allows you to display a variety of labels on objects, 

especially in a Model View.  The Modify tab will show you many of the 

properties of a selected object or group.  Combine these features with the 

Cut Plane, Name Filtering and the various window types and you will 

usually find what you need quickly. 

Find Objects by Name 

There are a couple of good ways to find objects by name.  The first is to 

use the Filter tab of Project manager and enter the name of the object in 

the appropriate Name Filter.  This has the effect of hiding all objects (of 

this type) except for the named object. 

A second approach is to use the Find tool (Edit | Find).  This tool will 

show you a list of all objects in the model.  The list will be sorted by 

name, unless you have changed the sorting order.  If you have many 

objects in your model, you might want to use the Name Filter within the 

Find tool to reduce the list. 

Find Objects by Properties 

Use Edit | Find to open the Find tool if it is not already shown.  Select 

the type of object you are searching for and then click the column header 

for the property you wish to find.  This will sort the list based on this 

property, clicking again will reverse the order of sorting. 
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Select Found Objects 

Hint:  To select all but a few objects and 
then use the "invert selection" button. 

In the Find tool you can select items in the list by Clicking anywhere in the row.  A 

single Click will select that row while unselecting all the others.  To add or remove 

a row from the current selection state, hold down the Control (Ctrl) key.  To select a 

group of rows, first select the first item in the group, then hold the Shift key and 

select the last item. Finally, if there are already items selected in the list and you 

wish to add another group of items to the selection, hold down the Ctrl key while 

selecting the first item and both the Ctrl and Shift keys while selecting the last item.

Inspect Found Objects 

Once items are selected, either graphically or in the Find tool, you can 

easily inspect them using the Modify tab of Project Manager.  If more 

than one type of object is selected, you may need to use the type selector 

at the very top of the Modify tab. 

Edit Found Objects 

While the Modify tab of Project Manager is usually the most convenient 

way to inspect or edit selected objects, you may wish to edit through a 

dialog box.  In the Find tool, click the Edit button to open this dialog 

box.  If the Find tool is not open, you can also use menu command Edit | 
Edit XXX, where XXX shows the type of object to edit. 

Delete Found Objects 

To delete objects found in the Find tool, or selected graphically you can 

use the Edit | Delete command.  In some cases, this will have the effect 

of deleting more objects than what is explicitly selected.  For example, if 

you delete both a node and the members attached to the node, then any 

loads on the member are also deleted.  Below is a flow chart showing the 

effects of deleting an item. 
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Subsequent items deleted by deleting an initial item. 

If a Design View is active, and members or plates are selected, the Edit | 
Delete command is used to delete design groups or meshes rather than 

members or plates. 

Selecting

Select Single Objects Graphically 

In a Model View or other graphic view, Click on an object to select it.  

You will see its color invert to indicate the selection status.  All other 

items are unselected. 

Select all Objects of One Type 

Hold down the Shift key and Click on an object to select that object and 

all other objects of the same type. 

Select Objects with the Same Name 

Hold down the Shift and Ctrl keys and Click on an element to select all 

elements with the same name.  This is a faster alternative to filtering the 

elements by Name, then holding the Shift key and Clicking on one of the 

elements. 

Select Objects in an Area 

Position the mouse cursor in the upper left corner of the area to select.  

Hold the Shift key and Drag the mouse to the lower right corner.  When 

you release the mouse, all objects shown in the area are selected.  All 

other objects are unselected, unless you also hold the Ctrl key. 

To prevent selection of some objects in the area you can hide them.  

Alternatively, you can also use the Ctrl key to Click and unselect specific 

items after they have been selected. 

Toggle Object Selection 

Clicking on an object repeatedly will toggle its selection on and off.  If 

you also hold the Control key (Ctrl), the state of other objects will not be 

affected.  Use this feature to add an object to the current selection or to 

remove an object from the selected group. 

Unselect Everything 

Click in the white space or background area of a window to unselect 

everything. 

Selecting Objects through Edit | Find 

The Find tool provides many ways to locate and sort objects.  Once they 

are organized and filtered the way you like, they are easily selected.  Use 
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this feature to select objects based on their name, or other properties.  

Also use this when objects are not visible in an active view. 

Select List Items 

VisualAnalysis' lists follow standard Windows user-interface conventions 

and also parallel the graphical methods of selection.  Click on an item to 

select it.  Use Ctrl+Click to toggle its selection status without affecting 

other items in the list.  Use Shift+Click to select a range of items in a 

list. (Click on the first item, then use Shift+Click on the last item in the 

range.) 

Some lists allow only single selection.  Other lists expect multiple 

selections and do not require the Ctrl key to add items to the selection.  

Some lists also allow editing in the first column, so if you Click twice, or 

Double Click, on the first column you may get selection and be able to 

edit. 

Editing

Inspect Selected Objects 

Use the Modify tab in Project Manager to view the properties of one or 

more selected objects.  If you have multiple types of objects selected, you 

can use the type selector near the top to choose which type of object to 

inspect.  Objects have precedence as follows: nodes, members, plates, 

nodal loads, member loads, plate loads, design groups, design meshes, 

and service load cases.  The first type of selected object determines what 

is shown by default.  Design items are only available if VisualDesign is 

installed and a Design View is active. 

Make Changes in Project Manager 

Once you are inspecting an object or group of objects with the Modify 

tab of Project manager, you are in a position to make changes.  The tool 

supports distinct types of editing as shown in the table.  In each case, you 

should click the mouse once on a control to make it active—it will 

display a darkened border to indicate that it is active. 

Control Type Description 

Drop Down List Click or use the spacebar to expose the choices, then 

click on a choice to select it.  Click away from the list to 

leave it unchanged. 

Check Box Click or use the spacebar to toggle the option on or off.  

Note that you may have to "double-click" a check box; 

the first click selects the item, the second click actually 

toggles the control.  In some situations check boxes have 

three states: on, off, and both!  A gray box means that 

some of the selected objects have this setting on and 

others have it off, if you leave it alone no objects are 

changed.  If you check or clear the box, the change is 

made on all objects, regardless of their previous state. 
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Text or Number Click or use the spacebar to start editing.  Type your 

value, expression or text into the box.  This is a standard 

edit control, so you can use the clipboard, normal editing 

keys (Backspace, Delete, Shift+Arrows, etc.).  It 

also has a context menu. 

… The three dots following a menu item indicates that 

selecting this item will open a dialog for more options, as 

opposed to a menu item without the dots which will 

actually perform a command with no further options. 

Sometimes you will make a change and you will get an error message 

indicating why the change failed.  Often this is due to something simple, 

like forgetting to add units to a numerical value. 

Make Changes in Dialogs 

Selected objects may be modified using specialized dialog boxes instead 

of the Modify tab in Project Manager.  Use the Edit | Edit XXX
command to open the appropriate dialog window.  This can also be 

accessed by right-clicking and selecting Edit XXX (i.e. Edit Member, 

Edit Node, etc.). 

Making Group Changes 

The Modify tab of Project Manager and most Edit dialogs support 

changes to a group of objects simultaneously.  If multiple objects of the 

same type are selected, this is the behavior you will get. 

On the Modify tab you will see some properties with the word “varies” to 

indicate that different objects have different values.  You can replace this 

with a valid setting to change all the objects. 

In Dialog boxes, you might see a control that is blank to indicate that 

different objects have different settings.  If you enter a value, or make a 

choice, it will be applied to the selected objects when you click the OK
button. 

Delete Objects 

To delete objects, you first need to select them.  This can be done 

graphically or with the Find tool.  Use the Edit | Delete command or its 

keyboard shortcut (the Del key by default). 

The default behavior is to present a warning message to confirm the 

operation, but you can turn this warning off through the Tools | 
Customize Behavior dialog under the Desktop tab. 

Undo Changes or Deletions 

VisualAnalysis keeps an unlimited record of changes to your model, 

loads, and design groups.  You do not need to be afraid of making a 

mistake.  Use the Edit | Undo command to trace back through these 

operations to undo the additions, deletions, or modifications.   

Be careful not to undo too much; currently no Redo command is 

implemented!  Also there are certain operations that clear the undo 
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history.  These include explicitly saving your project, and running an 

analysis.

Use Unit Expressions 

Most VisualAnalysis edit controls accept both a value and an associated 

physical unit.  The unit displayed is controlled by the Edit | Project 
Units command and the type of value displayed.  You may enter data 

using any of the built-in units appropriate to the type of data.  Here are 

the basic units supported in VisualAnalysis.

Quantity Type Units 

Length feet (ft), inches (in), millimeters (mm), centimeters 

(cm), meters (m), mixed feet, inches and sixteenths. (ft-

in-16)

Force pounds (lb), kips (K), Newtons (N), kilonewtons (kN), 

kilogram force (kgf), and tons (t) 

Temperature degrees Fahrenheit (F), degrees Celsius (C) 

Time seconds (s), 1/seconds (Hz) 

Other physical quantities are based on these units and will use some 

practical combination.  For example a moment may be expressed in K-ft 

or K-in, but not in K-mm. 

For length units you may also enter and display values in a mixed feet, 

inches, and sixteenths format.  VisualAnalysis will recognize 13 ft 5 3/16 

in, or 13’ 5 3/16” if you choose that style of units. 

Use Math Expressions 

Just about every place where you enter a number in VisualAnalysis, you 

may also enter a mathematical expression.  These boxes will accept 

expressions including arithmetic operators.  Type in expressions as you 

would any value. Use parentheses () to control order of evaluation.  If the 

value is a physical quantity, place the unit last on the line.   

Math Available 

Operators +, -, *, /, ^, (, ) 

Constant PI 

Exponential Functions LOG, EXP 

Trigonometric Functions SIN, COS, TAN, ASIN, ACOS, ATAN 

VisualAnalysis evaluates the expression and stores only the result.  In 

Project Manager, expressions are evaluated immediately after you click 

away from the control.  In a Dialog box, the expression stays around until 

you dismiss the dialog, or press the F2 key to cause the expression to 

evaluate immediately.  
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Printing

Setup for Printing Graphics 

Hint:  Use Edit | Copy to put the graphic 
image on the clipboard, then you can 

paste it into a report or a word 
processor.

There are two steps required for successfully printing a graphic view in 

VisualAnalysis.  First, make the window on the screen the same shape as the paper 

you are printing to.  Second, adjust the filters, zoom and rotation to make sure things 

display clearly. 

The first step will provide for a better mapping between what you see in 

the window and what you see on the printed page.  It does not matter 

how big the window is on the screen, but having a good aspect ratio 

(width/height) is critical. 

You can change the orientation of the page (portrait or landscape) using 

the File | Page Setup command. 

Setup for Printing Reports 

Typically you can just print a report without any setup or modifications.  

There are many adjustable features for reports like margins, headers, 

footers, and fonts.  These are adjusted through Tools | Customize,

where you will normally set them just once. 

You can change the orientation of the page (portrait or landscape) using 

the File | Page Setup command.  For more advanced formatting of 

reports, you might try saving it to a file and editing it with your favorite 

word processor. 

Use Print Preview 

The File | Print Preview command will save you a lot of paper.  We 

recommend that you use this tool before you send anything to the printer.  

A preview is especially useful when printing graphics to make sure they 

scale correctly and that everything you need is visible. 

There is one known flaw in our print preview implementation.  If it 

shows you more information than what you see in a graphic window, it is 

not correct.  What you see on paper will be only what you can see in the 

graphic window you are printing!  (Typically this will happen if you are 

zoomed in, and your window is wider than it is tall, but you are printing 

in portrait mode.) 
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Print a Report 

With a Report View open and active, choose File | Print to send the 

report to your printer.  The File | Print Preview command will let you 

verify how many pages the report is and the exact layout.  You may also 

use File | Save Report As to save the report to a file. 

Print a Graphic View 

With a Graphic View open and active, choose File | Print to send the 

picture to your printer.  The information shown in the window will be 

placed on the page without distortion.  See Setup for Printing Graphics 

for more information.  You may also send the graphic image to the 

clipboard as a Bitmap by using Edit | Copy.  This will allow you to edit 

and enhance the graphic in your favorite graphics program. 

Filing

Open a Project File 

To open an existing Project, use the File | Open command.  For a 

project you worked on recently you might find the file on the quick list at 

the bottom of the File menu.   

When you use File | Open, you will have a number of options regarding 

how the file will be opened.  The open dialog allows you to ignore load 

cases, analysis results, window layouts, and design information that 

might be in the file.  You can sometimes use this feature to recover data 

from a partially corrupted file.  This is useful if the file is corrupt, or if 

you no longer need this information.  If you ignore information and then 

save the file again to the same name that information will be lost. 

Prior version project files are recognized and opened automatically.  We 

do not attempt to read ALL information from older format files, but the 

model and loads, in most cases, will be preserved.  For POL files, refer to 

the POL.HLP file in the Help folder on your disk and the sections below. 

Open a POL Script 

Problem Oriented Language files are text files with model and load 

information, they represent the old way of describing a model.  Use File
| Open to import a POL Script.  Choose the POL type from the Files Of 

Type list in the dialog box.  POL Scripts may only be used to create a 

new project, you cannot import a script into an existing project.  Find 

more documentation for POL commands in a separate help file installed 

with the software. 

Import a DXF File 

Use File | Import from DXF to read a drawing into the current project.  

This is a good way to create a model with complex geometry or to save 

work when a drawing is available before you begin.  Look in the chapter 

on Modeling for more information about DXF files.  There are a number 
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of options in the Import from DXF dialog box.  After selecting a file 

name, you should verify that the options are set to your liking. 

Swap Y and Z coordinates:  VisualAnalysis uses Y as the vertical axis 

by default, while most CAD programs use Z.  You can perform this 

translation automatically.  The default is to swap the coordinates. 

Units in DXF: Select the units that should be used based on the DXF 

file.

Scale factor: You can scale the dimensions of the DXF model up or 

down by a constant factor.  Every nodal coordinate position in the DXF 

file will be multiplied by the scale factor before it is displayed in 

VisualAnalysis. 

Use History Files 

VisualAnalysis will create files to record multiple versions of a project 

file as you create and modify it.  These project files are called History 

Files and are saved with a name like “Your Project Version 1.vap”.  

These files can be used to return to a previous state of the project.  You 

might do this if you accidentally delete a file, if it becomes corrupt, or if 

you have saved changes that you wish to undo.  History Files are created 

every time you open a project file.  Typically, History Files are saved in 

your temp directory.  By default, in Windows XP this is typically 

C:\Documents and Settings\Your_Profile_Name\Local Settings\Temp.   

This path may vary somewhat depending on operating system and 

configuration. 

The number of History Files and whether they are created at all is up to 

you.  See the chapter on Customizing for more information. 

Use Timed Backups 

VisualAnalysis will automatically save your project every ten minutes by 

default.   The Timed Backup file is automatically named “Your 

Project_Timed_Backup.va!”.  This file will be overwritten whenever a 

timed backup is made.  These files will allow you to recover quickly 

from a disastrous crash in VisualAnalysis or your system.  The file is 

automatically deleted when you close a project successfully.   

When you start VisualAnalysis it will check for the existence of these 

files and if one exists you will be given the opportunity to open it.  If you 

do not like this feature you may turn it off.  For more details on 

controlling timed backup files, see the chapter on Customizing. 

Save a Project File 

To ensure that your work is protected you should periodically save your 

project.  Use File | Save to store the information in a VisualAnalysis
Project File (.vap).  Project files save your model and optionally, loads, 

analysis results, design information, and window layouts.  Project with 

results are much larger than projects without, so you will want to balance 

disk space with analysis time in deciding what to save. 
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Save a POL Script 

To save a project as a POL Script use the File | Save As command and 

select the appropriate file type.  Be sure to change the name and or 

extension on the file name to avoid overwriting your VisualAnalysis
Project File.  POL Scripts do not record all of the information in your 

project.  The following items are not recorded in scripts: object names, 

analysis results, design information, and window layouts.  Also, the POL 

script does not support most of the features added to VisualAnalysis since 

version 1!  Find more documentation for POL commands in a separate 

help file installed with the software. 

Export a DXF File 

To save a model, or the visible portion of a model, as a CAD drawing use 

File | Export to DXF.  There are a number of options in the Export to 

DXF dialog box.  After selecting a file name and location, you should 

verify that the options are set to your liking. 

Swap Y and Z coordinates:  VisualAnalysis uses Y as the vertical axis 

by default, while most CAD programs use Z.  You can perform this 

translation automatically.  The default is to swap the coordinates. 

Units in DXF: Select the units to display information in the DXF file.  

For the maximum precision, you may want to use a “small” unit like 

inches or millimeters. 

Scale factor: You can scale the dimensions of the model up or down by 

a constant factor.  Every nodal coordinate position in VisualAnalysis will 

be multiplied by the scale factor before it is written to the DXF file. 

Items to Export 

Active Model View only: Selecting this option (on by default) lets you 

limit the items exported only to those items that appear in the Active 

Model View.  This does NOT limit values that are clipped by zooming or 

scrolling the model view.  To see what will be exported, use the View | 

Zoom Normal command before choosing to export.  You can limit the 

export by using Cut Planes, Toggling the display of members, plates, or 

springs, or by Name Filters. 

Section names for members: Select this option to export a simple text 

label for each line in the DXF that shows the “section name”.  For a steel 

shape this is something like “W12x14”. 

Names of plates and members: Check this box to include the 

VisualAnalysis names for members and plates.  These are the “M1, M2, 

etc.” names that you normally see.  You have full control over these 

names by renaming individual elements, or using the Model | Rename 

command to change groups of elements. 

Plate Entities 

There are two options for exporting plate elements.  Choose either 

3DFACE or SOLID, depending on your CAD software and preference. 
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Modeling

Creating Models 

Getting Started 

VisualAnalysis 5 is different from past versions in that it automatically 

creates a project when it is first opened.  This project already has the 

units setup as well as load cases for dead, live, roof live, snow, and wind 

from four directions.  Simply start drawing your model and applying 

loads to get started.  If you need to add project information to the model, 

go to Edit | Project Information.  Similarly, if you need to change the 

unit system, this can be done under Edit | Project Units.

Start a New Project 

As in previous versions of VisualAnalysis, you can still go through the 

usual steps to create a Project.  The project is the document you save to 

disk.  It contains all the information about your model and results.  

Create your project using the File | New menu item, and follow the 

instructions in the wizard. 

Set Title, Billing, or Structure Type 

The New Project Wizard lets you define general information about a 

project.  With an existing project, use Edit | Project Information to 

update this information.  The Field names are suggestions only, you can 

type any information you like in the Title and Billing fields. 

You may change the Structure type at any time.  Be aware however that 

you may lose information.  Sometimes it is useful in a 2D model to 

switch to 3D temporarily in order to take advantage of a rotation out of 

plane.

In a truss model joints are assumed to be frictionless hinges that do not 

transmit any moment.  In a frame or grid model, the joints are all rigid 

moment connections by default.  Use member end releases to create a 

hinge in a frame model. 

Add Notes to a Project 

Type up to two pages of text into the project notes area.  This 

information will stay with the project file and can be included in a 

Report.  Use Edit | Project Information to update this text. 
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Set Project Units 

Project units define how physical quantities are displayed throughout the 

software.  Use Edit | Project Units to change the units used for the 

current project or to load or save Unit Styles that are available to all 

projects.

Each quantity has an associated unit type, a number to control how many 

digits are displayed after a decimal point, and a format style.  You may 

experiment with these settings if the default behavior does not work well 

for you. 

Use the first two tabs in the dialog box to adjust units for the current 

project.  Use the Saved Styles tab to create, modify, select or delete Unit 

Styles.

Historically, VisualAnalysis report styles would retain their own units.  

This has been changed in version 5 so that reports now use the same units 

as the rest of the project.  This should make reports more flexible and 

units easier to control.  To change any of these units use Edit | Project 
Units.

Save a Project’s Units for Future Projects 

Once you have defined a set of units that you like, you should save them 

in a Unit Style.  Use the Edit | Project Units dialog to save the current 

unit choices to a New Unit Style. 

You might wish to have a number of unit styles available depending on 

the types of work you do.  For example for your wood design projects, 

you might wish to use pounds and psi for forces and stresses 

respectively, but when you do a steel project, kips and ksi might be more 

appropriate.  You can create as many unit styles as you like and switch 

among them at any time. 

Use the Sketch Grid 

VisualAnalysis lets you draw your members and plates in the Model 

View.  The most effective way to sketch is to set up a good Sketch Grid.  

The sketch grid lets you predefine the exact spacing and locations for 

nodes (joints or connections) in your model. 

To set the grid, Click on the Grid tab in Project Manager.  The grid is 

defined in one of the three global planes (XY, YZ, or ZX) and may be 

rectangular (Cartesian) or polar in arrangement.  Normally you will 

define the grid spacing according to the geometry of your model.  Enable 

it (you should see dots in the Model View), and start drawing.   

You may adjust the grid spacing at any time, and it will determine the 

locations of any new nodes you create.  You may sketch from current 

nodes to new grid points even if the existing nodes do not lie on a grid 

point.  Turn the grid off to prevent accidental sketching once your model 

is complete. 

The grid is a 2D plane, the third coordinate defaults to zero, but is 

defined by the Cut Plane.  Thus, in a 3D model, you may draw in any 

plane parallel to a global axis. 
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Sketch a 2D Model 

The easiest way to create models is to sketch them in the Model View.  

Before you begin you should set up the sketch Grid and choose between 

drawing members or plates.  Sometimes you might sketch without 

worrying about exact locations of nodes, later you can move nodes to 

correct the geometry.  With the Grid turned off, you are only allowed to 

sketch members or plates between existing nodes in the model. 

Sketch a 3D Model 

Sketch a 3D model in two phases.  First, sketch on a plane of the model, 

like a wall elevation or a floor plan.  To do this, define a Cut Plane in the 

3D space, and turn on the sketch Grid.  Rotate the view to see this plane 

clearly and then sketch just as you would for a 2D model.  Repeat this 

process for multiple planes in the model, changing the plane center to a 

different value. 

Once you have at least two planes of elements created, you can switch to 

full 3D sketching.  Here you can remove the Cut Plane setting to see the 

entire model, and then you can rotate the view and sketch between any 

existing nodes.  You could also create a Cut Plane in a perpendicular 

direction to draw members. 

Import a DXF File 

While sketching is very easy for most models, you might be more 

comfortable drawing in a CAD package.  You may import geometry and 

connectivity information directly through a DXF file.  This is especially 

useful for complex configurations involving angles, curved structures, or 

many offsets.  The command is File | Import from DXF   

VisualAnalysis reads only the ENTITIES section of the file with the 

following interpretation.  A LINE becomes a member element, a SOLID 

or 3DFACE becomes a plate element, and a POINT becomes a spring.  

There is little or no further processing that takes place.  Members that 

cross may be split automatically by VisualAnalysis, and nodes that are 

very close together are merged.  The closeness is controlled through node 

tolerances.  (See the Customizing chapter regarding node tolerances.) 

Tip:  In VisualAnalysis beam webs line 

up with the global Y-axis, and self-weight 
is normally applied in the Y direction so 

Y makes a good "vertical" axis.  Yet, you 

can orient your model any way you 
choose. 

VisualAnalysis allows you to swap the Y and Z coordinates when importing because 

CAD programs typically use Z for the vertical axis, and Y is best for VisualAnalysis.

You may also scale the drawing or convert the units as it is imported. 

Open a POL Script 

Problem Oriented Language Files (POL) are text scripts describing the 

input data for a project.  This is the old way of doing structural analysis 

and we provide them for the rare instances when they are useful.  For 

example, they can make it possible to transfer a project from one 

proprietary software package to another without having to re-key all of 

the information.  Another use is for merging two models together. 
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To open a POL Script, use File | Open, and select the type of file as 

POL Script.  POL files may use any file name and extension, the default 

is .POL. 

VisualAnalysis supports the POL language only for basic model and load 

information.  The POL format is fairly limited with respect to the 

capabilities provided in the current version of VisualAnalysis.  Find more 

documentation for POL commands in a separate help file installed with 

the software. 

Generate Typical Models 

The standard version of VisualAnalysis allows you to quickly generate 

parametric models of common structures or structural components.  This 

feature is available as the last page in the New Project Wizard.  Use 

Model | Generate Standard to access this feature for a model that is 

already in progress.  The Generate Standard library has been expanded in 

version 5 and includes options such as typical trusses, building frames, 

walls, slabs, floor systems, tanks, and more.  You may also add your own 

parametric definitions for generating the types of models you create 

often.  (See the chapter on Customizing.) 

Generate Copies 

You can copy any selected model objects using Model | Generate 
Copies.  The following list describes some of the many things you can 

do with the Copy and Paste approach to modeling: 

¶ Generate rectangular or circular patterns of model objects.  For 

example, copy a floor plan of beams to the next level. 

¶ Generate a "mirror" image of a plane portion of the structure.  

(By rotating about the vertical axis.) 
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¶ Make a separate copy of your model, change it slightly and run 

a side-by-side comparison with the original model. 

¶ Copy member loads from one member to another within a single 

load case and scale them. 

¶ Copy loads from one load case to another and scale them if 

necessary. 

Menu and Dialog Creation 

Sometimes drawing or generating models will not work for your type of 

model.  In this rare circumstance, you can create models completely 

through the menu system.  Choose Model | Generate One | New 
Node to create nodes at specific locations.  Then use Model | 
Generate One | New Member or Model | Generate One | New 
Plate to create elements between existing nodes.  This is normally more 

tedious than other modeling approaches in VisualAnalysis, but it is 

available if you need it. 

Create Multiple Models 

It is often helpful to compare two models side-by-side.  You may create 

two or more separate models in a single project file.  This works well for 

static analysis to see how different configurations or conditions will 

affect the behavior of simple structures.   

Obviously, for large projects you will incur significant performance 

problems if you try to do this. 

Creating Model Objects 

Sketch a Member 

You can sketch a member in the Model View.  Make sure that you are in 

the “Draw Members” mode by selecting this item from the Model menu. 

The direction of drawing 

determines the local x-axis for 
the member. 

Then drag your mouse—hold the button down while moving.  You may 

drag to and from grid points or existing nodes.  The mouse cursor will 

change to show that you are creating a member and will “rubber band” a 

line to show where it will go.  Simply lift the mouse button to create the 

member.  Hit the Esc key to abort the operation. 

If the grid is not turned on you will not be able to create any new nodes 

by sketching members.  You may also sketch beyond the border of the 

window, and watch the coordinates in the lower right corner of the Status 

Bar to determine when to release the button, or you may wish to "zoom 

out" before drawing. 

Members that you sketch default to the properties of the previously 

drawn or edited member, so it is helpful to define properties as you create 

your model. 
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Sketch a Plate 

Make sure that you are in the “Draw Plates” mode by selecting this item 

from the Model menu.  

Create plates in a consistent 
fashion, usually counter-

clockwise, to align local axes. 

To sketch a plate element in the Model View, Click once on a grid point 

or existing node, to define the first corner.  Then as you move the mouse 

you will see a “rubber band” line and a special cursor.  Click (push and 

release) on each subsequent corner of the plate to define the four corners. 

For a triangular element, click on the starting node to finish.  Hit the 

Esc key to abort the operation.  The operation might fail if the plate 

edges cross, or if the plate would otherwise be ill formed. 

Create a Plate Mesh 

One way to create a plate mesh is to sketch a large plate element and then 

split it accordingly.  Another way is to select any three or four nodes in 

your model and use Model | Generate Standard then select 

Quadrilateral Mesh. 

Create a Node 

Nodes are created automatically when you sketch or generate elements.  

You may create nodes explicitly through Model | Generate One | 
New Node as well. 

Most nodes in your model will be unsupported or free from external 

restraint.  Nodal supports are used to model an external constraint on the 

structure.  For example, a building frame is modeled with supported 

nodes only where the columns connect to footings (assuming the footings 

are not modeled). 

Be careful not to confuse nodal supports with member connection 

types.  A rigid or pin connection between members is controlled by the 

structure type and member end releases—not nodal supports! 

Create a Node on a Member 

If you wish to create a node on an existing member you should use the 

Model | Split Member command.  Alternatively, if you generate or 

draw members that intersect, the software will offer to split the members 

for you. 

You should rarely, if ever, model a node such that a member or plate 

edge runs through it, unbroken.  If you do, it means there is no 

connection between the two components. 

Create a Line of Nodes 

If you wish to create a series of nodes along an arbitrary line, the easiest 

way to do this is to draw a member along this line and then split it 

accordingly.  If you do not need the member elements you may then 

delete them. 



User's Guide VisualAnalysis Modeling ¶ 45 

Create a Spring Support 

Spring elements are used to model elastic support conditions.  A spring is 

attached to a node and is fixed at its other end.  To create one, select a 

node in the Model View and choose Model | Generate Spring 
Supports from the menu.  If multiple nodes are selected, a spring will 

be placed at each node. 

Spring supports may be inclined, rigid, and rotational.  Use them 

whenever you have a support that is not an infinitely stiff support or not 

aligned with one of the global coordinate axes.  Spring supports may be 

combined with normal supports at the same node if they are in different 

directions.  Compression only springs are often used to model soil 

supports.

Prevent Accidental Sketching 

To prevent drawing elements in a Model View use Model | Draw 
Nothing.  If you wish to draw elements between existing nodes but not 

between Grid points, then disable the Grid using the Project Manager. 

Editing Models 

Name Objects 

Model objects are given default names when created.  For example, 

members are often labeled M1, M2, and so on.  You should provide your 

own descriptive names to help you find, filter, and sort information.  

Both the Filter tab in Project Manager and the Find Tool allow you to 

filter visible or listed items by their name prefix. 

To name a single object (node, member, plate, or spring), select it in the 

Model View and use the Modify tab of Project Manager to type a new 

name.  To rename a group of objects use Model | Rename.  Although 

this may take a little extra time initially, it can really save time later by 

making elements easier to view, edit, and report. 

Rename Objects 

The Model | Rename command allows you to rename all objects or 

selected objects of a single type in one step.  The command takes a name 

prefix, a starting number and an increment number.  You can also specify 

a directional ordering for the renaming process. 
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This command can fail if there are already objects with the new names.  

VisualAnalysis requires that objects of the same type must have unique 

names. 

Move the Model 

To move the entire model, or a selected portion of the model, use Model
| Move.  This command will move nodes (and anything attached to 

them) specific distances in the global X, Y, or Z coordinate system. 

Move Nodes 

To move nodes, and anything attached to them, select the nodes to move.  

Use the Modify tab in Project Manager, and enter a move distance for 

either X, Y, or Z.  At present, there is no support for moving nodes in 

polar or spherical coordinate directions.  The Clipboard Exchange tool in 

VisualTools provides another powerful option for moving nodes in a 

spreadsheet. 

Align Nodes 

You may align a group of nodes to a common X, Y, or Z coordinate.  

Select the nodes, and then enter a new coordinate value through the 

Modify tab in Project Manager.   

If you need to align nodes along an arbitrary line, you can do that by 

drawing a member and splitting it into multiple pieces.  Then delete the 

member elements if you do not need them. 

Rotate the Model 

You may rotate all or selected portions of the model about any arbitrary 

center and any arbitrary axis of rotation.  Select the portion of the model 

to rotate and use Model | Rotate.

You should note that member orientations are partially defined by the 

location of the member relative to the global Y-axis.  As you rotate the 

model, you may also be rotating members within the model as well as 

loads, end releases, and results that depend on the orientation of local 

coordinates. 
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Combine Members 

This command combines individual member elements into one 

continuous member element externally, while retaining the complete 

model internally.  

For finite element analysis, it is often necessary to split continuous 

beams, columns or other structural components into multiple member 

elements.  VisualAnalysis allows you to re-combine these elements into a 

single “Continuous Member” for easier management and reporting.  

Select a line of members and choose Model | Combine Members.

This feature is powerful but comes with some drawbacks and limitations.  

Member elements between the first node and the last node must have 

their local axes aligned.  The feature was not intended for curved or bent 

members.  The properties of the first member in the chain are used for the 

new continuous member.  There is one exception: the end release at the 

last node is taken from the last member in the chain.  Once the 

continuous member is created, you may edit its properties normally, and 

they are internally distributed to the individual elements accordingly.   

Any loads on the individual members are moved onto the continuous 

member, but they are not merged.  For example, a uniform load of the 

same value on all the member elements is converted to multiple partial-

span uniform loads on the continuous member. 

No provision, beyond an immediate Edit | Undo command, is made for 

returning a continuous member back to its individual members.  Certain 

operations are not supported for continuous members (e.g., Model | 
Split Member) and others may have undefined behavior. 

Split Members 

Note:  Continuous members are not split 
in the current version. 

This command breaks a member element into multiple pieces, inserting nodes as 

necessary.  To connect something to a member, you need to split the member to get a 

node at the connection point.  Examples include, beams framing into a girder, or a 

shear wall modeled as a plate mesh connecting to a column. 

Nodes are created automatically and member elements are renamed 

according to the name of the member getting split.  For example, member 

M1 may become members M1-1 and M1-2. 

Split Plates 

Use this feature to break plate elements into smaller pieces.  Plates are 

approximate elements.  You will often need to refine your model by 

using smaller plates.  This is done using Model | Split Plate, after 

selecting one or more plate elements.   

Internal nodes are created automatically and you have the option to split 

members that lie along plate boundaries.  Normally, you should split 

members to retain the continuous connection between the two types of 

elements.  Newly created plates are given names based on the original 

plate.
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Reverse Local Axes 

Model | Reverse Local Axes has the effect of changing the direction of the local 

coordinate system for the element.  This command can be applied to member and 

plate elements.  Local coordinate directions will affect local loads, member end 

releases, possibly member orientation, and local results. 

Move a Member in the Model 

Two nodes define a member location.  To move a member, while 

retaining its same connections to the model, simply move the nodes.  

Select the node and use the Modify tab of Project Manager to change its 

coordinates.  This will also affect all other elements connected to the 

node. 

To change where in the model a member is connected, you should 

change the member’s start node or end node to be a different node.  

Select the member and use the Modify tab of Project Manager to change 

its nodes. 

Change a Member’s Length 

The distance between its two nodes defines a member’s length.  To 

lengthen or shorten a member, simply move one of the end nodes.  Select 

the node and use the Modify tab of Project Manager to change its 

coordinates.  This will also affect all other elements connected to the 

node. 
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Change a Plate’s Size 

Plate size is defined by the locations of the nodes, to change the size of a 

plate element, move one or more of these nodes. 
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Loading

VisualAnalysis provides built-in support to manage loads, load cases, 

and load combinations.  These features, while designed to support US 

building codes, are also very flexible and customizable.  Currently 

VisualAnalysis does not directly generate loads according to building 

code requirements.  The software does make it easy for you to create 

your own loads, organize them into groups, copy and scale them, and 

combine them in various ways.  This chapter introduces you to these 

loading features in the software. 

Load Cases 

Create Service Load Cases 

Service load cases are containers for real loads.  Before you can apply 

static loads to your model at least one service load case must exist to 

contain the loads.  Common service load cases are automatically created 

with a new project in VisualAnalysis 5, but, more can always be added by 

going to Load | New Service Case.  The weight of a piece of 

machinery, the pressure of the wind, and the settlement of a support are 

all real, static loads that you may include in a service load case.  All static 

loads must reside in a service load case. 

You may put all your loads in one load case, but we do not recommend 

this except for very small projects.  Typically, you will separate the loads 

based on where they come from or where they are located.  

VisualAnalysis allows you to associate each service case with a load 

source.  This source is for descriptive purposes and will come in handy 

when you start combining loads with equation combinations.  Load 

sources are described in the Engineering chapter. 

A service load case may also include the weight of the model.  Typically 

you will include this self-weight in one load case.  The weight of the 

model itself is automatically calculated based on plate and member 

properties, but you can, if necessary, scale or factor this value.  

VA4 Service Load Cases 

If you are upgrading to VisualAnalysis 5 from VisualAnalysis 4 you will 

probably notice fairly soon that the load sources for wind and seismic 

have explicit directions associated with them.  You may also notice that 

the old "seismic loads" and "wind loads" load sources are still in the list 

as well.  These "old" load sources are really only in there for backward 
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compatability.  If you open an old VisualAnalysis 4 project it should 

work just fine in VisualAnalysis 5.   

For the best results, we recommend that you "convert" your old (non-

directional) wind and seismic load sources to their appropriate directions 

and update any combinations accordingly. 

Create Equation Load Combinations 

Design codes require that you check your structure against the combined 

effects of loads.  The typical combination looks like this: 1.2D + 1.6L.  In 

VisualAnalysis you will use an Equation Load Combination to 

accomplish this.  Use Load | New Custom Combination to create a 

single factored combination of service load cases. 

Before you create an equation combination, it is important to have 

service cases defined with appropriate load sources.  The load factors are 

implicitly determined by the equation you choose and these load sources.   

You may be able to generate most of the Equation load combinations you 

need automatically through the Load | Building Code 
Combinations command. 

Create Factored Load Combinations 

When an equation load combination does not work, you should use a 

Factored Load Combination.  Use Load | New Custom Combination
to create a factored load combination.  One common use for this type of 

load combination is patterned loading. 

Sometimes you want to combine loads with different factors on cases 

with the same source.  For example, you may have two live load cases to 

include in a combination, but you want a load factor of 1 on the first and 

1.5 on the second.  Factored load combinations are more flexible than the 

equation load combinations because you control the factors explicitly. 

Create Response Load Cases 

To perform a dynamic response analysis you need to have at least one 

Response Load Case defined.  A response case contains direction 

multipliers and a design spectrum.   Use Load | New Dynamic 
Response Case to create a Response Load Case. 

The direction multipliers define the direction of the seismic event and 

also scale the magnitude. You might think of them as direction cosines.  

If you want to simulate an earthquake in the X direction use X=1, 

Y=Z=0.  Similarly to indicate the direction in the XZ plane, 45 degrees 

off the X-axis, use X=Z=0.707 and Y-0.   If the square root of the sum of 

the squares of the direction cosines adds up to a number other than 1.0, 

then this scale factor is also applied. 

The design spectrum is a data set representing a seismic event.  Building 

codes often provide design spectra to use, or you may have more accurate 

local information from previous events.  The data represents a time 

history of displacements or accelerations.  You can include your own 

custom data in the file (the default is 'spectrum.txt' located in the 

IESCommonFiles folder).  For more information see the chapter on 
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Customizing.  VisualTools also provides a way to generate response 

spectra.

Generate Building Code Combinations 

VisualAnalysis 5 introduces a new system for generating building code 

combinations of service load cases.  These combinations are 

automatically maintained as you add or remove loads and service load 

cases.  The building code or codes that are used are selected through the 

Load | Building Code Combinations command, while the default 

settings (for new projects) are defined under Tools | Customize 
Behavior, on the Loads tab.   

When one of the buiding code combinations is selected, VisualAnalysis
will use the current service load cases and generate the necessary 

combinations prescribed for that code.  Note that any custom equation or 

factored combinations that you create manually will remain unaffected.  

When VisualAnalysis generates building code combinations, it will 

generate combinations including the effects of wind and seismic in six 

directions (+/-X, +/-Y, +/-Z).  Only load cases that actually contain loads 

or self-weight are included in the combinations.   

VisualAnalysis will attempt to eliminate redundant combinations or 

combinations that will not control the design of components, but this 

process is conservative so you may have a load combination calculated 

that you really do not need, but it will only cause reports to be a little 

longer, and you can exclude the redundant combination from reports 

manually if you so desire. 

Many of the common building code combinations are predefined, but if 

you want to add more it is easy to do.  The load combination equations 

are prescribed in a text file called LoadCombo.txt.  In the IESCommon 

Files folder (the default location) you will also find an Excel spreadsheet 

file titled LoadCombo.xls.  We recommend you edit the spreadsheet, and 

when you are finished choose File | Save As in Excel and save it as a 

tab delimited text file.  The spreadsheet file is much easier to edit.  This 

file should be saved to the IESCommon Files directory (or your custom 

location) and can just overwrite the old LoadCombo.txt file that is 

already there.  Instructions and definitions are also contained in the file to 

assist you in your efforts. 

Edit a Load Case or Combination 

You can make changes to existing service load cases or manually created 

load combinations by choosing the Load | Edit Case or 
Combination.  At this time load cases or combinations must be 

modified one at a time.   

Service load cases may also be modified directly using the Project 

Manager: simply open a Model View, select the appropriate service case 

from the drop-down list in the Status Bar, and then click on the white-

space to unselect everything in the model.  The load case will be shown 

on the Modify tab of Project Manager. 

Changing a service load case may cause building code combinations to 

be recalculated. 
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Delete Load Cases or Combinations 

To delete one or more load cases or combinations choose the Load | 
Delete Cases or Combinations.  You may delete more than one load 

case or combination at a time by selecting them in the list. 

Deleting a service load case may cause building code combinations to be 

recalculated.

Loads

Static and Dynamic Loads 

Most loads you apply in VisualAnalysis are static loads.  If you have the 

advanced level of VisualAnalysis , then these loads can vary with time in 

a dynamic time history analysis.   Each physical load is contained inside 

a single service load case.  Self-weight of members and plates can be 

included automatically in a service load case that uses the Dead Load 

source type.   

If you have set up VisualAnalysis to automatically generate service load 

cases for dead loads, this load case will include the self-weight. 

Apply Nodal Loads 

First select the appropriate service load case in the Status Bar and then 

select one or more nodes in the Model View.  Right-click to bring up 

the Context Menu and choose Apply Nodal Load(s).  You may also 

use the main menu command: Load | New Nodal Loads.  If multiple 

nodes are selected, multiple loads are generated. 

Specify the type of load (force, moment or settlement), the direction, and 

magnitude.  Use the Placement tab only if you need to change which 

nodes get the load.  Settlements may only be applied at nodes that are 

supported, in the direction of the support. 

Apply a Support Settlement 

A settlement is a specified displacement or rotation at a node.  In 

VisualAnalysis settlements are treated very similarly to nodal forces.  To 

create a settlement, first make sure the node is supported in the direction 

of the settlement and then select the node(s) to displace. Use the Context 

Menu Apply Nodal Load(s) command or Load | New Nodal 
Loads.  Select the type and direction of the settlement or rotation. 

Apply Concentrated Member Loads 

Select the member(s) to load and then select Apply Member Load(s)
from the Context Menu.   Load | New Member Loads is also 

available in the main menu.   

Choose Single, Concentrated as the load type.  Choose the direction as 

global or local. Switch to the Magnitude tab to define the load value 

and its position from the start node of the member.  Check the member’s 
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length on the Placement tab if you need to, otherwise this is used to 

change where the load is applied. 

Loads are most easily applied using a Model View with the correct load 

case selected in the Status Bar.  Member loads are not permitted on truss 

structures, if you need to load a member in a truss you can either split the 

member into pieces and apply the load at the new nodes, or change the 

model to a frame and use member end releases to hinge the joints. 

Generate Multiple Member Point Loads 

VisualAnalysis has a feature for rapidly generating multiple point loads 

across members.  Select the member(s) and then choose Apply Member 
Load(s) from the Context Menu.   

Select either Fractional Span Points or Evenly Spaced Points to generate 

multiple concentrated loads on each member.  Fractional loads may be 

placed randomly; they also work well for placing loads at say 1/3 points 

of members with different span lengths.  Use the evenly spaced option to 

create loads a fixed distance apart. 

Although the multiple point loads are generated in a single step, they 

immediately become independent concentrated loads for editing or 

deleting. 

Apply Distributed Member Loads 

Select the member(s) to load and then select Apply Member Load(s)
from the Context Menu.  Select a uniform or linear distributed load as the 

type.  Specify the direction as global or local.  On the Magnitude page 

enter the load value(s).  For a full span load check the box, otherwise 

enter a starting and ending offset.  If you are not sure of the member 

length, check under the Placement tab. 

Linear member loads are calculated on individual member elements only.  

That is, there is no feature in VisualAnalysis to apply a linear member 

load along a line of member elements.  You could use the Model | 
Combine Members command to first make members continuous—but 

check the implications of this in the Modeling chapter. 

Note: You may apply multipl distributed loads to a single member,  to 

model stepped loading conditions, for example.  The only restriction is 

that the loads do not overlap.  This restriction is in place, primarily to 

keep the graphical displays easy to read. 
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Apply Thermal Member Loads 

Select the member(s) to load and then select Apply Member Load(s)
from the Context Menu.  Use a Change in Temperature to induce an axial 

lengthening or shortening.  Use Gradient Temperature to induce bending. 

Apply Pressure on Plates 

Select the plates to load and then select Apply Plate Load(s) from the 

Context Menu.  Load | New Plate Loads is also available in the main 

menu.  Select Uniform or Linear and enter the magnitude.  Use a 

negative magnitude to reverse the direction of the pressure.  Refer to the 

Placement tab if you need to change which plates are loaded or to check 

the area of the plate. 

Loads are most easily applied using a Model View with the correct load 

case selected in the Status Bar.  Plate pressures are applied perpendicular 

to the plate in the local z direction.  To apply loads that are not 

perpendicular to a plate mesh, you must apply them at the nodes.  If plate 

elements are sketched individually, you probably want to be consistent 

with the direction the plate nodes are drawn.  If some are drawn 

clockwise and others counter-clockwise, the local z direction will be 

opposite and plate pressures will then be applied in different directions.  

This is usually a non-issue if a plate is drawn, then split into a finer mesh. 

Generally you will want to avoid using a single plate element to model a 

wall or slab.  Plate loads are distributed internally to the nodes at the 

corners of the plate.  With a single plate element you will not get good 

results. 

Apply Pressure on a Plate Mesh 

VisualAnalysis will generate plate pressures across an entire mesh or 

even an entire model in one step.  Select the plates and choose Apply 
Plate Loads from the Context Menu.  Choose Hydrostatic (across 

mesh) or Linear (across mesh) to get a linear variation calculated 

automatically based on the location in the mesh.  For a hydrostatic 

pressure you may use a negative fluid density to reverse the direction of 

the load. 

Although these plate pressures may be generated in a single step, they 

become independent loads on each plate element for editing or deleting.  

You can certainly edit the loads as a group, however, by selecting all of 

them graphically or through the Find tool. 

Apply Thermal Plate Loads 

VisualAnalysis supports two types of thermal loads in plates:  a 

temperature change and a temperature gradient.  Select the plates and 

choose Apply Plate Loads from the Context Menu.   

A Change in Temperature induces an in-plane stretching or shrinking. A 

Gradient Temperature causes bending in the plate.  Reverse the sign on 

the magnitude to reverse the direction. 
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Apply Concentrated Loads on Plates 

VisualAnalysis does not directly support concentrated plate element 

loads.  Generally you will be modeling your plate as a plate mesh and 

you can apply the concentrated load to the nearest node.  You can even 

move the node (distorting the neighboring plate elements) to position the 

load in the correct location. 

Apply Edge Loads on Plates 

VisualAnalysis does not directly support loads on plate edges, either in-

plane or out-of-plane.  You will need to approximate this type of loading 

with equivalent nodal loads.  In some situations, you may be able to use a 

member element along the edge and apply your loads to the member.  

Just remember that members and plates are only connected at common 

nodes. 

Find Loads 

Loads may be filtered in a Model View and selected individually or in 

groups just like other model objects.  Sometimes it is difficult to locate 

loads visually.  Use Edit | Find to view loads in the Find tool’s lists. 

When using the Find tool with loads, you will need to use the load case 

selector that is in the Find tool rather than the one in the Status Bar. 

The Find tool lists may be sorted on any column (Click the column title) 

and the columns may be resized (Drag the divider between column 

titles).  See the Essentials chapter for more information about the Find 

tool. 

Select Loads 

Select loads just like other model objects.  Use the Filter tab in Project 

Manager to make them visible in the Model View.  Use the mouse to 

Click on the load to select it.  Loads may be in different directions, so 

you may need to hunt for where to click in order to select it.  If you turn 

off the nodes, members, and plates, it makes it easier sometimes. 

See the Essentials chapter for more information about selecting. 
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Edit Loads 

Loads are edited just like other model objects.  Select a load, or multiple 

loads of the same type and use the Modify tab in Project Manager.  With 

multiple loads selected you may also right click and choose Edit
Selected Loads.  To quickly edit a load individually simply double 

click it.   

Delete Loads 

Select loads in a Model View or Find tool and then delete them with Edit
| Delete or by pressing the Del key on your keyboard. 

Copy Loads to Another Load Case 

Select the loads and choose Model | Generate Copies to open the 

Generate Copies Wizard.  Choose Copy to Other Load Cases and enter a 

scale factor if necessary, then press Next.  Select the destination load 

case(s) in the list and press Finish.

You can also use this faster procedure to copy loads to another load case. 

Select the loads, then use Edit | Copy.  Now switch the active load case 

in the Status Bar and choose  Edit | Paste Load from Other Case.

During the copy operation you will have an opportunity to scale the load 

magnitudes in a linear (Ax + B) fashion. 

Copy Loads to Other Objects 

Select the loads and choose Edit | Copy.  Now select the destination 

objects in the Model View.  Be careful to not change the active load case.  

Finally, choose Edit | Paste Special to open the Generate Copies 

Wizard.  Choose Copy to Other Nodes or Elements and enter a 

scale factor if necessary.  Press Next and check the list of objects to 

make sure the correct nodes or elements are selected and then press 

Finish.

In some cases, VisualAnalysis will recognize what you are doing after 

you have done the copy and selected other objects.  In this case, a special 

menu item will appear similar to this:  Edit | Paste Load on Selected 
Members.  When this command appears, you will not see the Generate 

Copies Wizard, the loads will simply be copied. 

After the copy operation you can scale the load magnitudes in a linear 

(Ax + B) fashion, by selecting them and choosing the Load | Adjust 
Selected Loads command. 

Factor the Loads 

Building codes often require that you factor your loads.  Normally these 

factors are applied through building code combinations that are 

automatically generated by VisualAnalysis . 

You may manually factor loads as you create them in a Service Load 

Case, but this is not very flexible.  VisualAnalysis also provides custom 

Equation and Factored Load Combinations to combine and factor loads.  

The Load menu provides commands to generate factored combinations. 
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Finally, after loads are created you can apply manual factors to them by 

selecting them and using the Load | Adjust Selected Loads
command. 

Make Patterned Loads 

Although VisualAnalysis does not provide any built-in support for load 

applications in patterns you can accomplish this with a manual 

procedure.  The trick is to split your loads into multiple Service Load 

Cases, perhaps one load per load case.  Then use custom Factored Load 

Combinations to create combinations with different factors on each load. 

Include Self-weight 

Self-weight is included through a Service Load Case.  The load source 

must be specified as dead load, and then you will have the option to 

include it.  Typically, you will want to include the self-weight in just one 

service load case, whose sole purpose is to include this (and perhaps 

some other dead loads).  Then combine it with other loads using 

Equation or Factored combinations. 

Use a factored self-weight to change the direction that gravity acts on 

your model.  The default is –Z for plane grids and –Y for all other 

structure types.  You could also use the factors to include a factor of 

safety or load factor on the self-weight, but this might be done more 

appropriately in a load combination. 

Note: If VisualAnalysis is set up to generate service load cases 

automatically, and one of these load cases is for Dead Loads, then Self-

Weight is included in this load case.  You may modify the settings for 

this load case manually after the project is created. 

Simulate Moving Loads 

VisualAnalysis Basic and Standard levels do not directly support moving 

loads, however there are some techniques you can use to simulate them.  

You may use Edit | Copy and Edit | Paste Special to copy loads 

from one load case to another and then adjust their positions.  Others 

have used POL Scripts and a spreadsheet to generate loads and load cases 

programmatically.  

For more information about analyzing moving loads, refer to the 

VisualAnalysis 5 Advanced level documentation.  

Dynamic Loads 

Include Mass of Model 

The mass of member and plate elements is automatically calculated and 

included in a dynamic analysis.  Internally, these masses are distributed 

to the nodes.  For more accurate dynamic modeling, you might consider 

splitting members and plates to get a better distribution of mass. 
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Apply Extra Nodal Mass 

You can specify additional mass in your model through lumped nodal 

mass.  Use the Modify tab in Project Manager to edit nodes to define 

additional displacement mass or rotational mass at this location in the 

structure.

Nodal masses are entered in mass units, which is not very convenient in 

the US system.  You might find it easier to apply extra mass as static 

loads that are included through the Analysis Wizard. 

The self-weight of the model is included automatically in the dynamic 

analysis.

Use Static Loads for Additional Mass 

One way to include additional mass on a model is to specify a single 

static load case under Analyze | Analysis Options.  This may be a 

Service Load Case or one of the factored load combinations.  You will 

also need to specify which direction gravity is acting.  Only loads with a 

component in the gravity direction will be included in the mass 

calculation.

The self-weight of the model is included automatically in the dynamic 

analysis.

Use Response Spectra 

A Response Spectrum Analysis determines the behavior of the structure 

when subjected to a specified ground acceleration or displacement, e.g., 

an earthquake.  The magnitude of the acceleration or displacement is a 

function of time and is referred to as a Design Spectrum in 

VisualAnalysis.  Building codes often prescribe a seismic Design 

Spectrum.  Include a Design Spectrum in a Response Load Case using 

Load | New Response Case.

Create a Custom Response Spectrum 

The data for response spectra used in VisualAnalysis is stored in a text 

file called spectrum.txt, normally located in the IESCommonFiles folder.  

You can open this text file yourself and add custom response spectrum 

data, a specific earthquake's ground motion for example, or other 

historical seismic data.  See the Customizing chapter for more 

information. 

VisualTools includes a tool for automatic generation of new response 

spectra based on building codes. 

For more Dynamic Analysis capabilities, refer to the VisualAnalysis 5 

Advanced level documentation.  
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Viewing Loads 

Select the Active Load Case 

Use the Status Bar to select which load case is visible and active.  A 

Model View shows one Service Load Case at a time.  Result Views, 

Picture Views, Member Graphs and Plate Graphs will show any load 

case with results, which may be a Service Load Case, an Equation Load 

Combination, Factored Load Combination, Mode Shape, or Response 

Load Case.    

Design Views do not show any one load case but rather results for all 

Strength or Serviceability load cases.  See the VisualDesign User’s Guide 

for more information. 

See Factored Loads? 

There is no graphical way to show the factored loads in an Equation or 

Factored Load Combination.  Loads are only shown in a Model View for 

Service Load Cases.  The primary reason for this is that the graphics 

would get very cluttered and most likely unreadable where many loads 

exist in the same locations in different load cases. 

Find the Total Load in a Load Case 

To find the sum total of loads in a load case you will need to analyze to 

get results.  Look on the Result tab of Project Manager, available when 

a Result View is active, to see the Static Check.  The Static Check 

balances the total load in each direction with the total reaction force in 

each direction. 
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Analyzing

VisualAnalysis exists for one primary purpose: structural analysis.  This 

chapter covers the analysis specific features in the software from pre-

analysis checking and analysis options through some basic-level theory.  

For additional discussions of the analysis assumptions, limitations, and 

interpretation, please refer to the Engineering chapter. 

Understanding Analysis 

Get Ready For Analysis 

The following checklist outlines many common problems that you 

should check to ensure a successful analysis.  Many of these issues are 

addressed automatically in VisualAnalysis 5 through the Analyze | 
Check Model for Errors menu command.  This command checks 

many of the discussed items below and provides the results in a report.  

These issues need to be corrected before an analysis is performed. 

1 Geometry is properly defined using members, plates, and springs.  

Your model does not contain a mechanism. 

2 Enough nodes are properly constrained using supports or spring 

supports to prevent the model from having rigid body displacement 

or rotation in any direction. 

3 Any Equation and Factored Load Combinations include at least 

one Service Load Case with a non-zero factor.  Included cases 

must not all be empty. 

4 If you need to perform a 2nd order (P-Delta) analysis, your model 

must not contain one-way members or one-way spring supports. 



64 ¶ Analyzing User's Guide VisualAnalysis 

5 If you intend to perform a mode-shape or response spectrum 

dynamic analysis, your model should not contain any one-way 

members or one-way spring supports. 

Understand Analysis Limitations 

With the exception of P-Delta analysis results, VisualAnalysis assumes 

that the deformation of the structure is not large enough to severly affect 

equilibruim.  Most often it is large rotations of members and plates that 

can bend which can cause results in the finite elements to deviate from 

their real-world behavior.  Currently, VisualAnalysis does not implement 

any finite elements which can handle large rotations and therefore you 

should always question their results if deflections appear large.   

One indicator of problems will be that the Statics Check tabluated on the 

Results tab of the Project Manager (or in a report) will show a 

difference between the Applied Loads and Reaction forces and moments.  

This is a key indicator that equilibrium of the structure has not been met 

and that your results are questionable.  The reaction results are based on 

the deformed shape of the structure whereas the Applied results are based 

on the undeformed shape.  When these deviate (which should never 

happen in reality) deflections are large enough to generate false results. 

When P-Delta results are shown, a process in which siffness nonlinearity 

resulting from large axial forces and stresses is taken into account.  

VisualAnalysis utilizes a one iteration approach as described below which 

has the effect of accounting for bending magnification of structures 

resulting from lateral motions.  This process does account for some of the 

large rotation effect but is not complete and therefore even P-Delta 

results can be different from real-world behavior especially when large 

deflections are predicted. 
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VisualAnalysis makes a number 

of self-checks.  However, it is 
possible to analyze without 

warnings and still have 

meaningless results.  Please

check results carefully!

Stresses are assumed to be small so that the classical first derivative 

definitions apply.  In addition, rotations and displacements are also 

assumed to be small.  If any of these assumptions are violated for the 

actual structure response, the use of VisualAnalysis as a prediction 

tool must be questioned.

Presently, the only material model utilized by VisualAnalysis is an 

isotropic model.  Material properties are assumed the same in all 

directions.  If materials are orthotropic or anisotropic, VisualAnalysis

may be unable to accurately predict response. 

Analyze Large Projects 

The only practical limit on model size is the amount of memory you have 

on your computer.  The amount of memory available is of two forms: 

physical memory (RAM), and virtual memory (secondary storage, like a 

hard drive). 

The largest size problem depends upon many things including: 

1. The speed of your machine (CPU, cache, hard drive, etc.) 

2. The structure type chosen (number of degrees of freedom at each 

node). 

3. The number of nodes and elements. 

4. The number of load cases and loads. 

5. Performance vs. Accuracy settings.  See below. 

6. The number of other applications and processes running on your 

system. 

7. The number of windows you have open. 

8. The phase of the moon. (Just kidding, although solar flares can and 

do affect the accuracy of your CPU.) 

In other words, it is nearly impossible to estimate the largest problem you 

can solve.  Trial and error is the best means to get a handle on a practical 

limit.   

In many situations you will not run out of memory, but rather just slow 

down to a crawl.  In these cases, try a faster machine with more memory, 

or subdivide you model and only analyze say a wing at a time for a 

multiwing structure.  Seriously question whether you need all those load 

cases you’ve defined or all the plates you subdivided.  Do you really 

need an iterative analysis or frame instability when you know these 

effects are negligible?  There will probably come a day where our word 

processors will demand entry level computers which surpass all 

structural analysis needs but we are not quite there yet. 

Solve Lack of Support Errors 

VisualAnalysis traps the common support problems, such as no support 

in the Y-direction.  The analysis will stop and a message indicating the 

deficiency.  In most cases this is just an oversight on your part and you 

will simply define your supports and go on.   
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There are situations in 3D modeling where you think you have enough 

supports, and indeed you might have enough support to restrain against 

the direction of loads.  For example if you have a rectangular mat 

footing, loaded vertically only, you might think that vertical supports are 

all you need.  But if you have modeled this as a Space Frame then you 

also need to support against horizontal translation in two directions and 

rotations about all three axes.  Even though your model may not be 

loaded in one of these directions, you still need to constraint it.  In 

situations like this you should just pick arbitrary supports in a way that 

will constrain the problem mathematically without affecting your results. 

Solve Mechanism Errors 

You might receive a message during an analysis regarding a negative or 

zero diagonal in the stiffness matrix.  This is a technical way to say to 

you that your structure is unstable or nearly unstable.  Consider the frame 

below that demonstrates this behavior.  We have supported the overall 

frame, yet the center column line is unsupported and all beams are pin 

connected using member moment releases.  The center column line can 

move up and down unopposed.  Running this model with just self-weight 

fails and VisualAnalysis reports a “…zero on the diagonal of the stiffness 

matrix.  It appears that node N8 has no support in the DY direction.”  We 

can see that N4, at the bottom of the center column, is where a support 

should probably go, or some member end releases need to be removed. 

One procedure that we at IES have followed in our pursuits to solve 

mechanism errors is as follows.  Begin in a section of structure that you 

believe to be the culprit and start applying nodal supports and taking out 

member releases until you get the analysis to proceed.  Look at the 

resulting deflected shape and verify its correctness.  Many times this 

alone will point out the violating members, plates, and nodes.  Once 
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you’ve got it analyzing, slowly take the supports back off and put 

releases back in until failure.  Again this should give you some insight 

into the problem. 

Another procedure is to remove all the member end releases, analyze to 

ensure stability, and then slowly put them back only where you really 

need them.  Continue analyzing (one or two load cases) to verify that you 

still have stability.  Inspect the results to look for moments or torsions 

you do not want, and continue adding releases until you get the results 

you need. 

Solve Member Connection Errors 

A common mistake with members is to over-release them, leaving them 

partially connected.  VisualAnalysis does not allow the obvious things 

such as releasing the torsional restraint at both member ends, which 

would allow the member to spin about its own x-axis.  However, you can 

easily over release a member as shown below.  There is a moment release 

at the supporting end of the cantilever beam. 

The cantilever on the frame is certainly unstable and would result in a 

zero diagonal type problem.  You need to think like a builder: would it 

stand up if I really built it?  You also need to think like a mathematician 

– things that will not rotate in the real structure might in your "pure" 

model!  (The classic example in VA is a column pinned at its base and 

able to rotate around its own axis because all the beams are released.) 

Investigate Static Imbalance 

A Statics Check is made for each load case analyzed.  You can see the 

check in a Report View or view the check in the Result tab of Project 

Manager.   

The total applied load or moment in each coordinate direction is 

calculated.  These real loads are applied at their load points on the 

deflected shape of the structure.  These values are affected by large 

deflections.  A comparison is made against the sum of all support 

reactions or moments.  If the structure is in equilibrium, the values are 

equal and opposite in magnitude.   

If there is an imbalance, VisualAnalysis will give a message to flag the 

condition.  The tolerance on the imbalance is arbitrarily set at 1%.  If the 

imbalance is small, you may not have a problem—you will need to use 

your best judgment after inspecting your model and results carefully.   
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A large imbalance is a problem that cannot be ignored.  Errors are 

usually caused by large displacements or rotations.  These can be global 

or very localized problems.  This check has also (on very rare occasions, 

usually during development) found errors in VisualAnalysis algorithms. 

See the Validation section in the Engineering chapter for more 

information about checking your results. 

Investigate Large Displacements 

It is possible to analyze without error or warning messages and yet have 

results that are meaningless.  VisualAnalysis will make a check and 

provide a warning if it detects “large displacements”.  However there is 

no fixed definition of what is large.  

VisualAnalysis tries to safeguard against this.  However, in structures 

where loads have been misapplied, or geometric and material properties 

have been incorrectly entered, large displacements can arise.  You may 

get large displacements if you do not use reasonable preliminary sizes for 

members and plates. 

You should review the Validation section in the Engineering chapter for 

more information. 

Investigate Yielding, Cracking, Crushing, Buckling 

Your analysis may "succeed" in VisualAnalysis, but your results may not 

be realistic!  The software may report (in ignorance) that the stress in 

your steel member is well beyond the material's yield stress.  The 

software may provide some checks against abnormally large stresses that 

would cause yielding, cracking or crushing of materials, but you should 

verify that your forces and stresses are within reasonable limits.  

VisualAnalysis does not (indeed cannot) check against code-specified 

allowable or ultimate forces, buckling limits, bearing stresses, or other 

criteria defined in building codes. 

This type of checking is mostly beyond the scope of VisualAnalysis.

Some types of checks are supported in the VisualDesign or VisualTools

add-on programs. 

These tools are purchased and documented separately. 

Re-Analyze after Changes 

When you make changes to your model after an analysis, certain results 

will become invalid.  VisualAnalysis tries to be intelligent when it 

“throws out” your results.  For example, if you modify loading 

information, only the affected load case results are invalidated.  On the 

other hand, if you modify the structure geometry, all results are 

invalidated.  By default, you will be prompted to confirm the changes 

and remove the results, but you can turn this warning message off using 

Tools | Customize Behavior on the Desktop tab. 

Remove Analysis Results 

Remove all analysis results manually with Analyze | Toss All 
Results. This feature is useful if you know you have bad results and 
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don’t want anyone to use them.  Also, you may want to recover memory 

on your system.   

To save your project without results you can use this command or you 

can keep your results in memory but not write them to the file.  Use File
| Save As, and uncheck the Analysis Result box before saving.  We 

recommend that you always keep a copy of your projects without results, 

because the significantly smaller files are less prone to corruption. 

Running a Static Analysis 

Run a Static Linear Analysis 

After running through the checklist in the Get Ready for Analysis 

section and using the Check Model for Errors command, an analysis 

can be performed using Analyze | Analyze Now.   

The simplest and most common analysis is a static linear analysis.  In this 

case, there are no one-way members, and instability effects are assumed 

to be negligible.  The principle of superposition of results is valid for 

static linear analyses.  Most properly designed structures acting under 

normal design loads will behave in a manner that is adequately predicted 

by a static linear analysis.  The followings sections describe complicating 

factors to consider as you decide which type of static analysis to perform.   

Analyze with One-way Elements 

Whenever a structure has one or more one-way (tension-only or 

compression-only) elements, the analysis becomes iterative and 

nonlinear.  This means that results from separate load cases cannot be 

superimposed.  

The iterative procedure performs automatically, what you would do 

manually.  For the first run on any load case, all of the one-way elements 

are included in the model.  Forces are then calculated for the one-way 

elements and if any constraints are violated, those elements are removed.  

If elements have been removed, another analysis is performed on the 

modified structure.  Again forces are calculated to determine whether or 

not violations exist and if so these elements are removed.  Also, the 

removed elements are checked to see if they should be returned to the 

model by calculating what force they would have had.  If changes are 

made the analysis is repeated for the modified model.   

This process repeats until no changes are necessary or until the iteration 

limit is reached.  This process can be very time consuming, especially for 

large models or many load cases.  Choose your load cases carefully. 

Use Analyze | Performance vs. Accuracy to adjust the limit on 

iterations.  The default value should be enough to determine whether the 

analysis will converge to a solution or not.   

There is no guarantee that this type of analysis will succeed.  If too many 

elements are removed the model may become unstable.  If too many 

elements are marked as one-way, the software may “bog down” trying all 

the possible combinations.  If you have problems, we recommend that 
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you take a semi-manual approach to modeling your project and keep the 

number of one-way elements to a minimum. 

P-Delta Analysis 

VisualAnalysis has the ability to consider geometric stiffness affects for 

both members and plate elements.  These P-Delta results are only 

available when geometric or material nonlinearity is not present from 

elements such as one-way springs or semi-rigid end connections without 

constant rigidity.  

When P-Delta results are presented, two affects are incorporated into the 

results.  The first affect applies to members only and involves modified 

bending moment acting along the length of the member. To demonstrate 

the affect which is sometimes attributed to member local instability,   

consider the case below where a simple span beam is loaded with both 

transverse loads (W) and axial compression (P). 

In considering equilibrium at the centerline of this beam-column you 

would find that the moment is increased by an amount Pd over what is 

determined from a normal analysis considering the effects of W only.  If 

the axial force (P) and/or the lateral deflection (d) are large, the effect can 

be significant.   

It is important to note that this method is only approximate. In reality, the 

Pd moment will cause more deflection, which will cause more Pd 

moment suggesting an iterative procedure.  As long as d is not large, the 

one step approximate approach is reasonably accurate.   

The member instability modification described here is automatically 

accounted for in the member results presented for the P-Delta cases. 

Where the member instability analysis takes into account the effects of 

member displacements, P-Delta analysis results also include more global 

effects.   Consider the case of a moment frame where there is some 

appreciable story drift (D). 

If the column base moments were calculated in this case considering the 

lateral movement shown, you would find that they are increased by an 

amount PD over the normal first order moments produced by W.  Similar 

to member instability, if the axial force (P) or the lateral deflection (D) is 



User's Guide VisualAnalysis Analyzing ¶ 71 

large, the effect can be significant.  It is common to tie this effect to the 

term frame instability. 

VisualAnalysis will approximate this frame instability affect in all P-

Delta results.  The approximation is performed as follows.  First a 

standard first-order analysis is performed to calculate the deflection, D.  

Then a second pass, “deflected” analysis is made where individual 

member stiffness matrices are modified to include a geometric stiffness 

correction using member axial forces from the first run.  In addition, if 

the model contains plate elements, similar geometric stiffness corrections 

are made to the plates utilizing the membrane stresses from the first run. 

The member and plate forces and moments are based on the second 

"deflected" run.  Displacements are obtained by adding the offsets of the 

first-order run to the displacements calculated in the "deflected" run. 

Frame instability results are 

only as accurate as your 
preliminary member sizes.  

Most standard texts on the finite element method include this geometric 

correction in their discussions.  There are two drawbacks to using this 

approach.  If the axial force is too large for the member, a negative term 

may appear on the diagonal of the member's stiffness matrix.  This is an 

indication of buckling.  If you grossly underestimate member size, the 

analysis will not be able to continue and will indicate that a member has 

potentially buckled. 

There is a second drawback to using the geometric stiffness correction 

that becomes apparent if D is large.  Because VisualAnalysis does not do 

a complete iterative analysis for P-Delta results, nodes may not be in 

equilibrium.  The amount of unbalance is directly related to the size of D.  

All things considered however, the benefits resulting from the inclusion 

of the geometric stiffness correction outweigh its potential drawbacks. 

In all cases, when d or D are "large", you should carefully examine the 

results from any computer program.  The potential problems resulting 

from large deflections and rotations have been discussed above.  If these 

assumptions are violated, the results are no longer valid. 

Running a Dynamic Analysis 

Find Dynamic Mode Shapes 

A modal analysis is used to determine the fundamental frequencies of 

vibration for a structure.  This can be useful for isolating vibration 

problems due to machinery, human activity or seismic events.  

Historically in VisualAnalysis this has been a separate analysis type.  

With version 5, mode shapes are calculated automatically if enabled 

through Analyze | Analysis Options.  Here you can decide whether 

or not to compute the mode shapes when an analysis is run, and if so, 

how many mode shapes to extract.  To run a modal analysis, you only 

need to have a stable and supported model with at least one element.   

You will need to consider how many mode shapes are necessary.  

Theoretically, there is one mode shape for each degree of freedom in 

your model.  Generally only the first few in each direction are really 

important.  Still, you may need to generate many mode shapes to obtain a 
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few in each direction.  VisualAnalysis extracts the lowest frequencies 

(largest periods) from the frequency spectrum. 

In a dynamic analysis you need to model both the stiffness and the mass 

of the structure correctly.  The modal analysis calculates undamped 

frequencies and mode shapes for the structure.  Lumped mass properties 

are calculated in the process of a modal analysis.  Lumped masses come 

from three sources: 

1. Mass associated with the structural members and plates. This is 

included automatically and calculated based on material density and 

element sizes.  This mass is lumped at the nodes, except for tapered 

members, where a consistent mass matrix is used. 

2. Additional mass you include at each node.  You should apply 

concentrated masses at the nodes to account for any mass not 

associated with the structural elements themselves.  Rotational mass 

should be applied where there exist nonstructural entities that are 

affixed to the structure and have appreciable rotational inertia. 

3. Additional mass you include through a static load case.  The load 

case and global direction are specified through the Analyze | 
Analysis Options command. 

The sum of this mass for the structure can be included in a report.  You 

should check this total to make sure that you have accounted for all the 

mass in the structure. 

Reports generated for a dynamic modal analysis provide the nodal 

displacements for each mode shape.  These displacements are not "real" 

values but rather shape displacements resulting from the modal solution.  

Mode shape values in VisualAnalysis reports are based on normalization 

to a unit mass matrix, in other words, the value S(Mi x Di
2 ) = 1, where: 

Mi = mass associated with degree of freedom i, 

Di = modal displacement associated with degree of freedom I 

The sum is carried out for all degrees of freedom in the structure. 

Frequency, period, and modal participation factors (for each direction) 

are shown in the title bar of each mode shape Result window. 

Modal participation factors are normally checked to see if enough mode 

shapes have been included in a response spectrum analysis.  Building 

codes usually require a percentage (like 90%) of all the modal weight to 

be accounted for when performing a modal superposition analysis.  

Modal participation factors are calculated for all translational directions 

in the model.   For a discussion of the effective modal weight calculation, 

see the following reference: 

Mario Paz, Structural Dynamics Theory and Computation,

Van Nostrand Reinhold, 3rd Edition, 1991, pp. 572. 

VisualAnalysis uses a Sparse Lanzcos procedure which has proven to be 

very robust.

Find Dynamic Response 

Response Spectrum Analysis is based on modal superposition.  Results 

from a modal superposition analysis are all non-negative numbers.  This 
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includes displacements, forces, and stresses.  You may select from the 

CQC (recommended) method, or the old SRSS method: 

CQC Method

This commonly used method allows specification of a uniform modal 

damping factor.  This method and the combination equation are outlined 

in the following reference: 

Paz, M., Structural Dynamics Theory and Computation, Van 
Nostrand Reinhold, 3rd Edition, 1991, pp. 254. 

Specifically, equation 11.59 in this reference is used. 

Symbol Definition 

U Response (force, moment, translations, etc.) 

UIXX Response in Ith mode, X earthquake direction, X spectrum input 

UIXY Response in Ith mode, X earthquake direction, Y spectrum input 

… … 

UIZZ Response in Ith mode, Z earthquake direction, Z spectrum input 

SRSS Method (Square Root of the Sum of the Squares) 

All sums are sums of absolute values. 

UIIX = UIXX + UIXY + UIXZ

UIX = Õ (U1IX
2 + U2IX

2 + U3IX
2 +  . . . + UNIX

2)

N = Number of Modes 

Tuning Analysis Performance 

Understand Member Results 

The member element in VisualAnalysis can be used to accurately model 

behavior for a multitude of applied loads.  End forces and rotations are 

“exact” based on the elasticity theory.  However, intermediate results 

along the length of the member are calculated only at discrete positions.  

This leads to small errors between these result points.  

When we calculate intermediate member results (moments, shears, 

stresses, and displacements) each member is broken into sections. Each 

section requires equilibrium calculations and computer memory.  More 

sections yield smoother, more precise results but also require more time 

and computer memory.  An ideal solution balances computer resources 

and accuracy.  

By default, VisualAnalysis will automatically adjust the number of 

member result sections based on the size of your model and the types of 

loads on a given member in each load case.  This will give you the best 

results for small projects and reasonable results for large projects. 

The number of result sections is independent of how you report your 

results or see them graphically.  For display, we interpolate linearly 

between the calculated results positions and the reported positions.  

Although you can sometimes “miss” critical results by reporting too few 

positions along a member, you will never improve your results by 
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reporting them at more places than were calculated!  Some result tables 

will automatically search the calculated results to find extreme values for 

you. 

Set Member Result Sections 

Use Analyze | Performance to adjust how VisualAnalysis will create 

member result sections.  Here are the choices available. 

Setting Description 

Automatic Internally adjusts number of member result sections 

based on the model size.  This is the default setting.

Academic Uses a large number of member result sections to get 

very accurate results and smooth diagrams.  This is the 

slowest performance setting. 

Normal Provides a balance between accuracy and computer 

resources.  Good for most real-world projects. 

Fast Reduces the number of result sections down to a 

minimum for best performance.  Intermediate results will 

be crude and you may miss peak moments if they do not 

fall near the center of members or if you have 

concentrated loads.  Sometimes necessary for very large 

projects.

Custom You decide how many sections to use for member results.  

There are four settings depending on the types of loads 

on a member in each load case.  You should specify odd 

numbers to get a result point at the center.  The minimum 

value is 3: end points and midpoint results only. 

Set One-Way Iteration Limit 

You may set the maximum number of iterations for an iterative static 

analysis.  This is the analysis performed if you have tension-only or 

compression-only elements in the model.  Use Analyze | Performance 
vs. Accuracy and adjust the value as you see fit.  The default value has 

proven effective for most projects in the past. 

Minimize Plate Elements 

Plate elements are approximate.  To get good results you will usually 

need to use a mesh of elements.  To know if you have good results, you 

will need to run multiple models and compare the results to see if the 

results are converging on the “true” solution.  (Remember, the theory 

tells us that as we make the plates smaller and smaller, we will converge 

if we have a converging element, something VisualAnalysis has.) 

The best approach, from a performance standpoint, is to start with some 

minimum number of plate elements.  Use just enough to model the 

geometry of your structure.  Then work from this point.  Use the Model | 
Split Plates feature to refine the model after loads are applied.  When 

successive refinements give the same results (displacments, forces, etc.) 

as the last iteration, the plate mesh is probably adequate. 
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Control Dynamic Mass Distribution 

In a static analysis, member behavior is exact.  In a dynamic analysis a 

member’s mass is lumped at its nodes.  In order to get the best dynamic 

results, you should consider splitting members into multiple pieces.   

You might use a trial and error procedure starting with single members, 

analyzing, splitting, and re-analyzing to compare results.  Repeat this 

process until you are comfortable that the results are converging toward 

the real-world system of distributed mass. 
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Reporting

Your analysis is done and you have the answers calculated, but you still 

need to find them and document your work.  This chapter shows how to 

get information out of VisualAnalysis, whether you need graphic on-

screen images, printed reports, or electronic transfer to other applications. 

Result View Windows 

Understand Result Views 

The Result View is your primary access point for analysis results.  You 

will use this view to see analysis results graphically.  It provides filters, 

legends, and images to help you find the information you need quickly.  

It also works well as a starting point for generating printed reports of 

selected objects.  A Result View shows the results of one result case at a 

time.   In the advanced level of VisualAnalysis, you will also have the 

ability to view envelope (or extreme) results. 

Result Views can be used as interactive or printed reports themselves.  

Use File | Print Preview to see how a Result View will look when 

printed. 

Use the View Filter 

Use the Filter tab of Project Manager to determine which results show 

and how they are displayed.   You can toggle the displaced shape, on-

frame diagrams, or show color contours.  You can include extreme force 

(or displacement or stress) labels, as well as object names and some 

properties.  The filter will help you see only the information you need, 

while hiding that which is not important. 

"Fly By" Tips 

Result Views have the ability to show tips when you hold your mouse 

over an object.  You must turn this feature on in the Filter settings.  (If 

you want to turn it on by default, use the Filter tab under Tools | 
Customize Appearance.

These result tips show you a very concise summary of the results for the 

object in this result case.  Tips are provided for immediate interactive 

convenience.  When you need to save results or find more complete 

results, you should use a Report or other features of the software. 
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Show Different Analysis Results 

On the Filter tab of Project Manager, use the Results option under 

Members or Plates to change which type of results to display.  For 

members you can show deflections, local forces, or local stresses.  The 

table below shows the options, for more details and information, please 

refer to the Engineering chapter.  The displaced shape of the model is 

toggled using an option under the General section of the filter. 

The following results are available for member elements.  In general, 

small x, y, and z refer to the member’s local coordinate system.  For 

more information about member results and notation, please see the 

Engineering chapter. 

Member Results Description 

dx, dy, dz Local member deflections.  (Local x is always the 

longitudinal or axial direction.) 

Fx The local axial force, where positive is tension, 

and negative is compression. 

Vy, Vz Internal shear forces in the local y and z 

directions, respectively. 

Mx Internal torsional moment.  Positive according to 

the right-hand-rule. 

My, Mz Local bending moments about the local y and z-

axis, respectively.  Positive according to the 

engineering mechanics sign convention. 

fa Axial stress. 

fby(+z), fby(-z),  

fbz(+y), fbz(-y) 

Local bending moments.  fby is bending about 

the local y axis, usually weak bending and fbz is 

usually strong axis bending.  The (+/-) indicate 

the location of the stress.  For example, a beam 

bent with a positive moment about its strong 

axis(z) will have a maximum compressive stress 

at fbz(+y) and a maximum tension stress at fbz(-

y). 

fc(+y+z), fc(-y+z),  

fc(+y-z), fc(-y-z) 

Combined axial and bending stresses at the four 

“corners” of the shape. 

fc(max), fc(min) The extreme values (largest and smalles, 

respectively) of the combined axial and bending 

stresses shown above. 

No Results Show the members with no result information. 

For plates, you can show membrane stresses (local or global), bending 

forces (local or global) and principal membrane stresses.  In general, 

small x, y, and z are in the element’s local coordinate system, capital X, 

Y, and Z are global directions.  Note that plate forces are distributed.  For 

example, plate moment units are kip-feet per foot, and plate shear units 

are kips per foot.  For more information about plate results and notation, 

please see the Engineering chapter. 

Plate Result Description 

Mx, My Local distributed bending moment, bending about the 
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Plate Result Description 

local x-face and local y-face, respectively. 

Mxy Local distributed twisting moment on the local x and y 

faces. 

Vx, Vy Local distributed shear forces on the local x and y 

faces. 

Sigma x, Sigma y Local membrane stresses in the x and y directions. 

Tau xy Local membrane shearing stress in the plane of the 

plate. 

Max & Min 

Principal

Local principal stresses in the plane of the plate. 

Tau Principal Local principal shear stress in the plane of the plate. 

MX, MY, MZ Global distributed bending moments about the global 

X, Y, and Z axes, respectively. 

Sigma X, Sigma Y, 

Sigma Z 

Global membrane stresses in the X, Y, and Z axis 

directions, respectively. 

Tau XY, Tau YZ, 

Tau ZX 

Global membrane shear stresses in the XY, YZ, and 

ZX planes, respectively. 

No Results Plates are shown without any result information. 

For plate stresses you also choose a location in the plates.  Choose from 

Top-Surface, Mid-Plane, or Bottom-Surface with the Plane dropdown 

list.  These are defined as through-thickness directions according to the 

local coordinate system of the plates.  Bending stresses are always zero at 

the mid-plane (z=0), but combine with membrane stresses at the top (+z) 

and bottom (-z) surfaces. 

Display On-Frame Graphs 

Choosing Diagram from the Graphics dropdown list under the Filter
tab of Project Manager will display on-frame member graphs.  By default 

the displaced shape is disabled when this option is chosen to clarify the 

diagrams.  If you prefer to view the displaced shape and the member 

diagram you can always turn the displaced shape back on. 
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Use the Result Legend 

The result Legend is the small window that floats in the Result View, 

when enabled.  Turn this option on through the Filter tab in Project 

Manager. This is useful for interpreting the colors used in plots and for 

finding the extreme values for all objects or selected objects when 

diagrams are shown.  Members and plates each have a separate legend 

and they can be turned on or off independently.  These legends may be 

dragged to any position within the window, and they are included if you 

print the window. 

The legend may display one or more "Range Controls".  These controls 

will allow you to filter the Result View to show only results in a 

specified range of values.  To restrict the range, Drag the top or bottom 

arrow with the mouse. 

Use the Result Inspector 

The Result tab of Project Manager is used to quickly get a feel for the 

Extreme Absolute, Maximum positive, or Minimum negative value of 

each result for the current result case.    You will find a Statics Check for 

each direction, information about your model’s self-weight and center of 

gravity, and summary information for dynamic results. 

Check Statics 

The Static Check under the Result tab of Project Manager is a very 

good check on analysis validity.  This is an excellent place to stop and 

ask, "Do these results make sense?"  This check also totals the loads in a 
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load case, providing a good way to verify the loading data you entered.  

For more information about the Statics Check and validating your results 

see the chapter on Engineering. 

Find Load Case Extremes 

Under each section: nodes, members, plates, and springs, of the Result
tab of Project Manager is a list of the result types and the corresponding 

extreme value for the active result case.  Use this for an extremely fast 

check of the range of results for a result case.  You may also get more 

detailed reports with extremes using Report | Report Wizard.

Print the Result Inspector 

To document what you see in the Result tab, Right-Click the mouse 

while the cursor is anywhere over the Project Manager and choose Print
Grid from the Context Menu.  This will print the table of information 

similar to the way you see it on screen. 

Print a Result View 

Use the File | Print command to print an active Result View.  For best 

results when printing a graphic view make the window the same shape as 

the paper you are printing to, and use the File | Print Preview to see 

how it will look.   

Find more hints and details about printing see the Essentials chapter. 

Capture a Result View 

If you wish to export a Result View for presentation in another program, 

use Edit | Copy to place a bitmap image on the clipboard.  Use Edit | 
Paste, or Edit | Paste Special in your other applications to retrieve 

the image. 

The bitmap or metafile image will be the exact same size and image you 

see in the window.  For the best quality image, make the window as large 

as possible.  Most word processors will scale images nicely to a smaller 

size for printing, but trying to make the image bigger will not improve 

the quality.  For the best possible image, you should print directly from 

VisualAnalysis.

Using Member Graphs 

Create a Member Graph 

Member Graphs display detailed diagrams of internal forces, stresses and 

deflections for members.  They show the results for one member (or 

chain of members) and one load case at a time. Create Member Graphs 

using Window | Graph Member item after selecting one or more 

members in a Result View. 
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Create a Multi-Member Graph 

You may create a single Member Graph for a chain of member elements.  

Select two or more connected members that form a straight line, and have 

commonly aligned local axes.  An example is a girder with beams 

framing into it.  The girder is typically split into separate elements where 

the beams frame in.  After selecting the members in the Result View use 

the Context Menu to choose Graph Member.

Customize a Member Graph 

To change the appearance of a Member Graph, Right-Click in the 

window to bring up the Context Menu.  Choose Customize This to 

display the graph customization dialog.  You may change the graph 

colors, display types, font sizes, and many other aspects of the member 

graphs.  These changes are recorded and the new settings will be applied 

to the next member graph that you create. 

Print a Member Graph 

To print a Member Graph, Right-Click in the window and choose Print
Preview.  If the preview is good, Click the Print button.  If you need to 

make some changes before printing, try resizing the Member Graph 

window, changing the customizable settings, or adjusting using File | 
Page Setup.

Export a Member Graph 

To export a Member Graph from VisualAnalysis for presentation in 

another program, choose Edit | Copy to paste a copy of the active 

Member Graph to the clipboard.  Use Edit | Paste or Edit | Paste 
Special to insert the picture into almost any other application.  You may 

also use the Customize This menu to export the graph to a file or to the 

clipboard. 

Using Plate Graphs 

Create a Plate Graph 

A Plate Graph window will show detailed contours or stress colors for 

plate mesh results.  To create a Plate Graph, select two or more plates in 

a Result View that lie in a plane, and have commonly aligned local axes, 

and then choose Window | Plate Graph.  A Plate Graph contour plot is 

displayed in a separate window.  The plot is placed in a rectangular frame 

and is best used for viewing results in a rectangular mesh.  It will show 

results for an irregular mesh shape but you will need to study the plot 

more carefully to interpret these results. 
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Customize a Plate Graph 

Right-Click on a Plate Graph and choose Customize This from the 

Context Menu to activate the Graph Customization dialog.  This allows 

you to change the type of plot, colors, fonts, sizes, and more.  Changes 

are recorded for future Plate Graphs you create. 

Print a Plate Graph 

To print a Plate Graph, Right-Click in the window and choose Print
Preview.  If the preview is good, Click the Pint button.  If you need to 

make some changes before printing, try resizing the Plate Graph window, 

changing the customizable settings, or adjusting using File | Page 
Setup.

Export a Plate Graph 

To export a Plate Graph from VisualAnalysis for presentation in another 

program, choose Edit | Copy to paste a copy of the active Plate Graph 

to the clipboard.  Use Edit | Paste or Edit | Paste Special to insert 

the picture into almost any other application.  Similar to member graphs, 

plate graphs can be exported to the clipboard, to a file, or to the printer 

through the Customize This menu. 
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Creating Reports 

Understand Report Views 

A Report View provides a text-based report mainly for the purpose of 

printing.  These reports appear in a window and represent views of the 

information in your model and results.  These reports may be 

interactive—depending on the selected objects.   You may use reports to 

quickly find a piece of information you need, but generally you will 

create them to save or print in order to completely document the results 

you have found.   

VisualAnalysis reports can show a tremendous amount of information.  If 

you have a medium to large project, you will need to be careful when you 

generate a report.  It is not hard to create a report with hundreds of 

printed pages worth of information.  You will want to take advantage of 

the filtering and selective reporting features available as you generate 

your reports. 

Report windows should be closed manually when you are finished with 

them.  If you keep them open they can hinder performance.  For example, 

if you save a project with Report Views open, the reports will be 

regenerated when you later reopen the file. 

Understand Reports 

A VisualAnalysis report is a collection of tables, summaries, graphics, 

and notes that are defined and recorded elsewhere in the software.  The 

reports are for information presentation only.  That is, you may not edit a 

report to change the model or results in any way.   

Reports may be interactive, displaying information based on what is 

selected, and updating if you change that selection.  You may type 

directly in a report to add custom notes, but if the report automatically 

updates this typing will be lost.  Also, there is no interface to control text 

formatting or fonts.  We recommend that you save a report to a file and 

use a word processor for editing and additions not supported directly in 

VisualAnalysis.

If you have VisualDesign  or VisualTools add-on software installed, your 

reports may also include information that comes from these distinct 

pieces of software.  These sections of the report may not have the same 

options or formatting as those produced by VisualAnalysis.

Controlling What is in a Report 

Reports in VisualAnalysis are highly customizable.  You can include 

many different pieces of information including both input data and output 

results.  The Report | Report Wizard command allows you to specify 

exactly what information to report, and in what order.  Often times it is 

easier to create a report based on selected objects and the modify the 

report using the Report | Report Properties command. 

You can modify the report until it is exactly what you need and then print 

it or save it.  If you wish to obtain this same report in the future, you will 
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want to save it as a Style before you close it (use Report | Save 
Report as Style).

When you set up a report you are given independent options for both 

Load Cases and Result Cases.  This allows you to report service loads in 

the same report as only the factored results.  These options are both 

defined at the time the report is created.  You can minimize unwanted 

information by excluding information you do not need. 

The same is true for members, plates, spring supports and nodes, and 

other entities is you have the advanced level or VisualDesign installed. 

Improving Report Performance 

If you are modeling a typical structure, you will have hundreds or 

thousands of elements in your model, half a dozen load cases, and 

perhaps twice as many load combinations.  It is not unusual to create a 

report that is hundreds of pages long! 

VisualAnalysis will blindly generate these huge reports for you and you 

will find yourself waiting many minutes to get them created!  You can 

improve report performance tremendously by carefully choosing which 

information to report, dividing your reports into distinct pieces, and 

working with report styles to provide pre-defined reports that work most 

efficiently.

The recommendation from IES engineers is that you report your model in 

one report, your loads in a second, and result information in a third, etc.  

You may wish to set up reports for different types of purposes.  For 

example, during the heat of the project, you need fast answers on very 

isolated (or selected!) portions of the model.  You need extremes.  You 

need averages.  But for documenting the completion of your projects you 

need a professional look, you need intermediate information to help 

others validate your work, and you need completeness.  Creating report 

styles can help you get just the report you need, at the right time, and 

save you lots of time on your future projects as well. 

Note: If your reports exceed 100 pages (by default) VisualAnalysis will 

automatically revert to an "unformatted" report.  This report will generate 

much faster than it would if all the table lines, bold fonts, etc. were 

retained.  You can customize this threshold value to meet your needs 

under Tools | Customize Behavior on the Reports tab.

Reporting on the Report! 

You can include two self-describing pieces of information in a report to 

help you understand what is contained in the report.   
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Report Context will tell you what filter settings are used in the report so 

that you can better understand what is NOT reported!  The Table of 

Contents will help you locate the various sections of the report by giving 

you a quick idea of whether th information is near the beginning or the 

end.

Understand Report Notation 

Column Heading Description 

% Damping Damping factor used in modal superposition 

%Iy, %Iz, %J Percent of stiffness to use during analysis of cracked 

materials 

Area Area of plate 

Ax Cross sectional area 

Beta Beta Angle - rotates the member local coordinates 

Cases Number of load cases included in the combination 

Category Type of shape within a database 

Cluster Factor Cluster factor used in modal superposition 

Combination Method Response case modal combination method 

Continuous Is this a continuous member? 

D. Mass Lumped translational mass 

Density Weight density of a material 

Design Spectrum Name of design spectrum 

Dim. 1 - Dim. 6 Cross section dimensions, meaning depends on type 

of shape 

Direction Global direction of a nodal load or member load.  
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Column Heading Description 

Direction of spring support.  Also direction of a 

Semi-Rigid connection (advanced only) 

Displacement Displacement result in spring 

DX, DY, DZ Displacement in the global X, Y, or Z direction 

Dx, Dy, Dz Local member displacements in the x, y, or z 

direction

Dx1, Dy1, Dz1, 

Dx2, Dy2, Dz2 

Displacement release in the local x, y, or z direction 

at the starting(1) or ending(2) node 

Elasticity Modulus of elasticity or Young's Modulus 

Elements Number of members or elements in the group or 

mesh 

End Offset Distance from the starting end of the member 

Endzone % 1, 

Endzone % 2 

Percent of the member stiffness to use in the end 

zone region at the start(1) or end(2) of a member 

Endzone Dist. 1,

Endzone Dist. 2 

Width of the end zone at the start(1) or end(2) of a 

member 

Endzone Type 1 

Endzone Type 2 

Type of end zone (normal, panel, or rigid) at the 

start(1) or end(2) of a member 

Equation Equation name or description 

Exclusive True or false, indicates whether the load case 

requires unique building code combinations, as for 

directional wind or seismic load sources. 

Extreme Item Type of results 

f(Hz) Frequency of vibration in cycles per second 

fa Axial stress in a member (tension is positive, 

compression is negative). 

fby(+z), fby(-z) Bending stress in a member bending about the 

section y-axis, at the extreme z fiber 

fbz(+y), fbz(-y) Bending stress in a member bending about the 

section z-axis, at the extreme y fiber 

fc max, fc min Extreme value of combined bending and axial stress 

at the section "corners", may be incorrect for non-

rectangular shapes! 

fc(+z+y), fc(+z-y), fc(-

z+y), fc(-z-y) 

Combined bending and axial stress at the section 

"corner", may be incorrect for non-rectangular 

shapes! 

Final Shape Designed member size or section name 

Fix DX, Fix DY,  

Fix DZ 

Supported against translation in X, Y, or Z 

Fix RX, RY, RZ Supported against rotation about X, Y or Z 

Force Reaction force in spring supports. 

Fx Axial force in a member (tension is positive, 

compression is negative). 

FX, FY, FZ Reaction force in the global X, Y, or Z direction 
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Column Heading Description 

Iy, Iz Moment of inertia about the local axis 

J Torsion constant 

L.FX, L.FY, L.FZ Sum of applied loads in the global X, Y, or Z 

direction

L.MX, L.MY, L.MZ Total moment about X, Y, or Z of applied loads, 

taken about the global origin 

Length Length of member 

LL Factor Live load reduction factor 

Load Case Name of a load case 

Load Source Type of loads in this load case 

Loads Number of loads in the service load case 

Location Node name or plate centroid where plate results are 

located 

Magnitude Force, moment, displacement or rotation of a nodal 

load.  Value of member load. 

Magnitude1, 2 Starting or ending distributed member load 

Mass Case Static load case included in a response analysis 

Mass Dir. Direction of gravity for loads in response analysis 

Material Material type name 

Max, Min Principal Principle direction membrane stresses in plates 

Member Member name 

Member Loads Number of member loads in the service load case 

Modal Method Method used to analyze for mode shapes 

Mode Mode number 

Modes Used Number of modes included in a response analysis 

Moment The semi-rigid connection moment value.  Advanced 

level only 

Mx Torsional moment in a member 

Mx, My Distributed moment on local x or y face of plate 

MX, MY, MZ Nodal reaction moment in the global X, Y, or Z 

direction,  Distributed plate bending moment 

transformed to global directions 

Mxy Distributed twisting moment on plate edge 

MXY Distributed twisting moment transformed to global 

directions

My, Mz Bending moment in a member about local y or z 

Name Name of the Design Group or Mesh 

Nodal Loads Number of nodal loads in the service load case 

Node Node name. 

Offset Distance from the starting end of the member 
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Column Heading Description 

Offset y, Offset z Member centerline offset in the local y or z direction.

One Way Normal, tension-only or compression-only member 

or spring support 

Parameters Are design parameters set and valid? 

Phi Angle to the global Z axis for a spherical coordinate 

Plane Top, bottom, or mid-plane of plate element 

Plate Plate name 

Plate Loads Number of plate loads in the service load case 

Points Number of data points in a design spectrum 

Poisson Poisson's Ratio 

Pressure 1 - Pressure 4 Plate pressure load at node 1 through 4 

Projected Is the load on the projected length? 

Power Semi-rigid connection power factor, advanced level 

only 

R Distance from the origin in polar coordinates 

R. Mass Lumped rotational mass 

R.FX, R.FY, R.FZ Sum of reactions in the global X, Y, or Z direction 

R.MX, R.MY, R.MZ Total moment about X, Y, or Z of reactions, taken 

about the global origin 

Result Case Name The name of the result case for a specific load case. 

Result Type Indicates the type of the result case (1st order, 2nd

order, or dynamic time results) 

Results Load case has valid analysis results? 

Rho Spherical coordinate 

RX, RY, RZ Rotation in the global X, Y, or Z direction 

Rx1, Ry1, Rz1 Rotation release, local x, y, or z at the starting node 

Rx2, Ry2, Rz2 Rotation release, local x, y, or z at the ending node 

Scale Factor A load factor applied to an entire load combination 

equation.  (e.g. .75 in .75(1.4D + 1.7L + 1.2W)) 

Section Section name of a shape in a database 

Self Weight Includes self-weight of model 

Self X, Y, or Z Factor on self-weight in the X, Y, or Z direction 

Service Checked for design serviceability 

Shear Ay, Shear Ay Shear Area, area that participates in shear resistence 

(i.e., the web on a wide flange)  Ignored if zero. 

Sigma x, Sigma y Membrane normal stress perpendicular to the local x 

or y face of a plate 

Sigma X, Sigma Y, 

Sigma Z 

Membrane normal stresses in plates transformed to 

global directions 

Span/Dy, Span/Dz Ratio of member element length to local deflection in 

the y or z direction 
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Column Heading Description 

Spring Spring support name 

Stiffness Stiffness of spring 

Stiffness 1, 

Stiffness 2 

Semi-rigid connection stiffness parameters, advanced 

level only 

Strength Load case is checked for design strength. Concrete or 

masonry material compressive strength. 

Sy(+z), Sy(-z) Section modulus about local y, at the extreme z fiber 

Sz(+y), Sz(-y) Section modulus about local z, at the extreme y fiber 

T Delta Change in temperature on a member or plate 

T Gradient Gradient temperature through a member or plate 

T(sec) Period of vibration in seconds 

Taper Depth Depth of member at end of taper 

Taper End Distance from the start of member to end taper 

Taper Start Distance from the start of member to begin taper 

Taper Type Type of member taper 

Tau Principal Principal shear stress in a plate 

Tau xy In-plane shear stress on a plate 

Tau XY, YZ, or ZX Membrane shear stresses in plates transformed to 

global directions 

Therm. Coeff. Thermal coefficient of expansion 

Theta Theta Angle.  Polar or spherical coordinate. 

Thickness Thickness of plate element 

Time The time for a time-history result case, this may be a 

time-step or an actual time in seconds, advanced 

level only 

Type Type of spectrum.  Design code or specification. 

Unity Unity check ratio (<= 1 is good, >1 is bad) 

Vx, Vy Distributed shear force on x or y face of plate 

Vy, Vz Shear force in the local y or z direction 

Warping Constant The warping constant, Cw, a property of the cross 

section of a member element, advanced level only 

Weight Weight of member or plate 

Weight-X, Y,  or Z Self-weight of the model in the X, Y, or Z direction 

X C.M., Y,  or Z  X, Y, or Z location of the center of mass 

X Cosine, Y, or Z Spring direction cosine in X, Y, or Z 

X Dir, Y, or Z Direction factors for a Response Case 

X Mass, Y, or  Z Contributing mass in the X, Y, or Z 

X Part, Y, or Z Modal Participation factors in X, Y, or Z  

X, Y, Z Global Cartesian X, Y or Z position in space 
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Report a Single Object 

Both Result Views and Design Views allow you to create a quick report 

by Double-Clicking on an object.  A Report View is created with 

information about analysis results, or design results, depending on the 

window type. 

This report is interactive.  If you change the selection to include other 

objects of the same type and then return to the Report View, it will 

automatically update to show the new selection.  This is a great way to 

inspect results without wasting a lot of paper. 

You can customize the report using the Report | Report Properties
and Report | Table Properties commands.  Changes are recorded and 

used on future reports generated using a Double-Click.

Report Selected Objects 

To generate reports for a group of selected objects, and objects of 

different types, first select the objects and then use the Report | Report 
Selected XXX command.  This command is also available in the Result 

View Context Menu. 

This report is interactive.  If you change the selected objects to other of 

the same type and then return to the Report View, it will automatically 

update to show the new selection.  If you select object types that were not 

reported originally, you should probably close the first report and create a 

new one.  This is a great way to inspect results without wasting a lot of 

paper. 

Changes made to this type of report are not automatically remembered.  

If you wish to create custom reports for groups of selected objects, you 

should customize this report and then use Report | Save Report 
Report as Style to save it as a style to use later. 

Reporting Member Results 

VisualAnalysis provide wide variety of ways to extract member results 

through reports.  Remember too that in addition to reports, you can create 

Member Graph Views and inspect member results directly in the Result 

View using the Filter settings. 

Types of Member Result Tables 

Member results are available through a number of distinct tables in the 

reporting system.  These tables are summarized below.  Note that the 

table names all begin with "Member" when you see them in the Report 

Wizard: 

Member Result 
Table Name 

Description & Usage 

Local Displacements Simple listing of local displacements: dx, dy, dz.  

One line per member and offset location.  One 

column for each local displacement direction. 

Internal Forces Simple listing of local forces, axial Fx, shears Vy, 

Vz; and moments My, Mz.  Torsion is reported as 

Mx.  One line per member and offset location.  
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One column for each local force direction.  Forces 

are calculated with respect to the local axes, which 

may be different than the section axes. 

Internal Stresses Simple listing of section stresses, axial fa, average 

shears fy, fz; and bending  fby, fbz at the extreme 

fibers.  Torsional stress is not calculated.  One line 

per member and offset location.  One column for 

each stress type.  Stresses are calculate with 

resepect to the section axes, which may be 

different than the local axes. 

Results This table can include any combination of 

displacements, forces, and stresses as defined in 

the three tables above. 

Use this table, and the above three tables, as your 

basic reporting tool for member results.  Base the 

report on selected members to keep the tables 

short, and rearrange the columns to sort them on 

various columns. 

End Reactions This table lists internal forces but only at the end 

points of the member, otherwise it is identical to 

the Internal Forces table. 

Min/Max Displacements

Min/Max Forces 

Min/Max Stresses 

This table lists two rows for each displacement 

direction (or force or stress).  One is the maximum 

value, one is the minimum value.  You can 

determine member, the result case, the offset, and 

the other displacement (or force or stress) at the 

point of the extreme result. 

Use this table most effectively with selected 

members, perhaps even one member, to get values 

necessary for design purposes in an interactive 

fashion.  Hint: These tables are always short! 

Extreme Results This table lists two rows for each member.  The 

first row lists the maximum extreme result and the 

second row lists the minimum extreme results.  

The columns may be any of the displacement, 

force or stress results available for members.   

This table automatically looks across all of the 

member offsets and all of the result cases and 

pulls out the extreme results.  Each result is 

followed by a number in parenthesis that contains 

a result case index.  Include a Result Cases table 

to identify which result case the extreme value 

came from. 

Use this table to get a quick overview of all of 

your results for all members. 

Member Results: Reported vs. Calculated 

In some of the member result tables, the results are reported along the 

member lengths at various offsets ranging from 0 at the starting node to 

L at the ending node.  In many tables you can specify how many places 

along each member to report the results.  The default is 11 places 

(including the end points).  To reduce the size of your reports, you can 
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reduce this number to a minimum of 2.  To make sure you don't "miss" 

critical result values, you can increase this number. 

Keep in mind that results are calculated at a limited number of discrete 

points along the member and the reports simply interpolate between these 

values.  To make sure you do not miss extreme result values, you can use 

the Member Graphs, the Member Extreme Results or Member Min/Max 

report tables, or you can use the VisualDesign add-on tool to check 

members. 

Reporting Extreme Results 

When reporting most result tables, you can have VisualAnalysis 

automatically "condense" the table to show only the rows that contain an 

extreme value.  Normally these values are indicated in the table with a 

bold font so that you can find them more easily, but you can greatly 

reduce the size of the report by showing only the extremes. 

Use a ‘Top Five’ Report Style 

VisualAnalysis lets you use custom report styles that you can create, 

modify, and delete using Report | Manage Report Styles.  For easier 

access, you may generate one of the first five styles by selecting from the 

numbered commands at the bottom of the Report menu.  

The styles that appear in this menu are simply the first five recorded in 

the style file controlled by the Report Style Manager.  There is no easy 

way (currently) to reorganize these styles, but you can add and remove 

styles and you can edit the existing styles to make them show what you 

want.   

Use any Report Style 

Use Report | Report Wizard to allow access to all of the report styles 

you have created and saved for the current structure type.  You can even 

start with a saved report style and customize it further before generating 

the report. 

Create a Custom Report 

The most general and most powerful way to create a Report View is to 

use Report | Report Wizard.  This command will let you generate a 

complete custom report from scratch.  It will also allow you to create a 

custom report based on any of the previously saved report styles.   

Editing Reports 

Add or Remove Items 

To add or remove sections in a report, Right-Click the Report View and 

choose Report Properties from the Context Menu.  The Report 

Properties dialog has two lists.  The left list shows items (tables, 

summaries, or graphics) that are available to include in the report while 

the right list shows items that are already included. 
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Use these two lists to add or remove items from the report.  You may 

also reorder the items that are included in the report. 

In some cases you may wish to include a table more than once.  You 

might use the first instance to show some of the columns in the table, and 

the second to show other columns. 

Change Table Properties 

To modify an individual table or summary, Double-Click on the section 

you wish to modify.  The Table Properties dialog will open.  Use the 

Choose Table Columns tab to add or remove columns from the table 

in the same way you add or remove items from the report.  The Column 
Options tab lets you change the width, decimal places,  title, and sort-

order for each column.  The Result Table Options tab is available for 

some tables with additional options for displaying or filtering results. 

Units in a report are controlled by the project settings under Edit | 
Project Units.

Sorting Table Columns 

You can sort any table in a report by re-ordering the columns.  Use the 

Report | Table Properties command, or simply Double-Click on the 

table in the Report View.  Tables sort based on the first column, then the 

second, then the third, etc. until the lines are different or the end of the 

line is reached.  This provides a quick way to organize tables differently 

than the default—especially result tables where you may want to 

organize a table by member element, by result case, by member offset, or 

by bending moment magnitude. 

There is also a preference setting under Tools | Customize Behavior,

on the Reports tab to "Show Results by Load Case".  By default result 

tables are sorted by node, member, plate or spring support (that is the 
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first column), by checking this option you can have result tables 

automatically place the Result Case first. 

Insert a Picture 

There are two types of graphics available for reports.  Use Report | 
Report Properties to include a Member (Graphic) Summary or Nodal 

(Graphic) Summary in your report.  These pictures are generated 

automatically and are not customizable.  If they do not serve your 

purpose, you may insert your own custom image as described below. 

You may paste any image from the Windows clipboard.  This is a good 

way to get your current Result View included in a report.  Use Edit | 
Copy when the Result View is active, and then switch to the Report 

View, position the cursor, and choose Edit | Paste.   Once the image is 

in the report, you may be able to resize it by selecting it and Dragging

one of the corners with your mouse. 

Filter Table Information 

It is easy to create a report that tells you everything about your project all 

at once.  For models of any real size that report would be hundreds of 

pages long, and nearly worthless.  You will want to trim or filter the 

information in tables by only including the columns that you need, using 

Report | Table Properties, and by reporting information for selected 

objects only, using Report | Report Properties under the Objects
tab.   

Result tables in particular can show just the extreme rows.  You can also 

report just selected load cases and selected result cases. 

Add Text to a Report 

You may type additional text inside a Report View or replace text that is 

already in the report.  Use the mouse to position the cursor or select text 

by Dragging.  Headers and footers are included and somewhat 

modifyable through Tools | Customize Behavior, but you cannot 

type directly in headers or footers.  

Be careful when adding text to reports, if the report is caused to 

regenerate your text will be lost.  We recommend that you save a report 

to a file and use a word processor for any significant additions or 

modification you wish to make manually. 

Deleting Selected Text 

To delete any portion of a report highlight a selection and press the 

Delete key.  You may not delete the portion of the first section 

containing the project name and your name and company information.  

Some of this information may be changed through Edit | Project 
Information.  Currently, Edit | Undo does not work for manual 

deletion in a Report View. 
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Other Report Operations 

Save a Report as a New Style 

Save a report that you have customized as a style using Report | Save 
Report as Style.  This preserves all customizations you make, allowing 

you to re-create this same report later with this project or other project 

using the same structure type. 

Save a Report to a File 

You may wish to save a report permanently to archive the information it 

contains.  Perhaps you want to use a spreadsheet to further process the 

numbers in a report.  You may also need to edit it in a word processor or 

email the report to someone.  In all these situations, you will use File | 
Save Report As to create a file.  Reports may be saved in Rich Text 

File (.RTF), Plain text (.TXT), Comma Delimited (.CSV), or Tab 

Delimited format (also .TXT).  The delimited formats work best for 

going to spreadsheets. 

Export a Table to a Spreadsheet 

Highlight a section of a Report View by Dragging the mouse.  Choose 

Edit | Copy from the main menu.  Start your favorite spreadsheet with a 

new worksheet and choose Edit | Paste from the spreadsheet menu.  

The information will be pasted as text, so you may need to use a 

command to parse the text into numbers.  For example, in Microsoft 

Excel, use Data | Convert Text To Columns.

Hint: If you routinely use this feature you might wish to customize 

reports so they import more easily into the spreadsheet.  You may turn 

clear the box for "Use Table Lines" and  the box for "No Table 

Duplicates".   These options are found under Tools | Customize 
Behavior under the Report tab. 

Print a Report 

Use File | Print to print the active Report View or File | Print 
Preview first to verify how it will appear.   

If you need to make some changes before printing, use File | Page 
Setup, or Tools | Customize Behavior on the Report tab or Font
tab. 

Close a Report Window 

Unlike Result Views and Design Views that close if you remove the 

project results, Report windows do not close automatically, you must 

close them manually.  Click the X button in the upper right corner of the 

Report View.   

If you do not close Report Views they are saved with the project file.  

When the file is reopened the Report Views are regenerated which can 

take some time! 
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Managing Report Styles 

Edit a Report Style 

Use Report | Manage Report Styles to access the report styles 

defined for the current structure type.  The dialog presents a list of styles 

found in the style file and gives some information about the contents of 

each style. 

To edit a style, select it in the Report Style Manager and choose Edit
Style.  You can customize any feature of the report except which load 

cases it will contain.  Although you can specify that it contain all load 

cases or selected cases.  If you flag the report as showing selected load 

cases, you will be prompted to select the actual cases whenever this style 

is used. 

Delete a Report Style 

To delete a style, select it using Report | Manage Report Styles and 

choose Delete Style.  No warning is presented, but if you decide you 

really do not want to delete the style, just hit Cancel in the dialog box.  

All changes you have made to styles will be lost.  Once a style is deleted, 

there is no way to restore it, except to recreate it from scratch or to 

import it from a backup copy of the style file.  See the chapter on 

Customizing for more information about style files. 

Import Report Styles 

You may import the report styles that created using an earlier version of 

VisualAnalysis or that you get from another person using VisualAnalysis.

Companies that have several licenses of the software may wish to 
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standardize report styles among employees.  We may also create more 

styles in the future that you can download from our web site and import. 

Use Report | Manage Report Styles and the Import Styles button 

to bring in more styles.   

To import styles from VA4.0 installations you need to locate the 

directory that contains your old report styles.  The default location is 

C:\Program Files\IES\IESCommonFiles\, and the files are named 

"VAReportXX.dat", where XX represents the structure type as one of 

(PT, PF, PG, ST, and SF).   

Report styles from VA3.x and prior are not importable due to the many 

changes in the software since. 

Export Report Styles 

You may share your report styles with another VisualAnalysis user by 

exporting them to a style file.  They can then take the style file and use it 

to import the styles into their copy of VisualAnalysis.  Use Report | 
Manage Report Styles to import and export report styles.  To export 

report styles, select the styles in the list and press Export. You can 

choose a set of “VAReport??.dat” style files to export to, or choose a 

directory with no style files at all.  To import a report style, simply press 

the Import button and browse to the location of the style file you wish to 

import. 

Report Troubleshooting 

¶  Problem #1: Report styles are missing. 

¶  Problem #2: VisualAnalysis “crashes” while generating a report. 

Background: 

VisualAnalysis 5 stores report styles in a set of five files located in the 

“IESCommonFiles” folder.  This is typically located at C:\Program 

Files\IES\IESCommonFiles. The report style files are called 

“VA5ReportXX.dat”, where XX is one of {PF=plane frame, SF=space 

frame, PT=plane truss, ST=space truss, PG=plane grid}. These files 

contain report style definitions in a binary (proprietary) format. 

The style tells VisualAnalysis what items to include in the report, and in 

which order. For each table in the report the style defines the units, the 

column order (sorting order) filtering options, and which columns are 

included, among other things. This information may be different for each 

structure type hence the different style files. 

Problem #1: Report Styles are missing. 

Symptoms

Symptoms of this problem include no “Quick” reports appear in the 

Reports menu, or when you go to the Report | Report Wizard
command, you do not see any available report styles predefined. The 

problem is that the report style file for the particular structure type {PF, 
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SF, PT, ST, PG} you are using is either missing or corrupt. This file may 

have been damaged if VisualAnalysis or your system crashed while the 

file was open for editing. 

Solutions

To solve this problem, you need to replace the style file that 

VisualAnalysis is currently using with one that is not corrupt. You cannot 

do this within VisualAnalysis, but it is easy to do this using Windows 

Explorer, browsing to the IESCommonFiles folder, deleting the current 

file (if it exists) and putting another file in its place. There are two 

possibilities for replacement files. 

The first, and best choice, is to use a report backup file that 

VisualAnalysis should have created for you. This should preserve most of 

the report styles that you have created and modified since installing 

VisualAnalysis. These files have names like “VA5ReportPF Version 

X.dat”, where X is some number, the higher the number, the more recent 

the file. Generally, you should rename the highest numbered file, back to 

the original file name. For example, rename “VA5ReportPF Version 

7.dat” to “VA5ReportPF.dat”. Then restart VisualAnalysis, and try to 

create reports again. If this file is also corrupt, which is possible, you 

may need to go back to a previous version. 

The second choice is to restore the style file to the original version 

shipped with the software. This file is located on your latest IES CD in 

the folder \IES\DataFiles. This file should always work, but you will lose 

any custom changes you have made.   

Problem #2: VisualAnalysis Crashes while 
generating a report. 

Symptoms

When you try to generate a report, either from double-clicking (say in a 

Result View), or picking a report style from the Report Menu, or using 

the Report Wizard, the software “crashes” or gives error messages. 

Solutions

This problem is probably due to a corrupted report style file.  The 

solution will follow the same procedure as outlined in problem #1 above. 

Conclusions 

IES recommends that you pay close attention to your customizable data 

associated with VisualAnalysis. Most of the customizations you make in 

VisualAnalysis are stored in the IESCommonFiles folder. You might 

consider including this folder in your backup plan for your machine. 

If you continue to experience problems with the Report Wizard, or report 

crashing, after following the above trouble-shooting steps, please contact 

IES technical support to report the problem!  We are committed to 

providing robust and accurate software to meet your needs.
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Customizing VA 

We recognize that not everyone appreciates the colors we have chosen to 

use as defaults in VisualAnalysis.  Similarly, there are many other 

features in the software that can be modified according to your needs or 

preferences.  This chapter will help you understand how to work more 

efficiently by customizing the software. 

Custom Views 

Understand Named Views 

VisualAnalysis provides four major graphic views (five in the advanced 

level), a dozen standard view orientations, and many filter settings.  

Named Views allow you to save the many adjustments you have made to 

a window for future recall.  They are extremely helpful when dealing 

with 3D structures because you can essentially save your Cut Planes.  For 

example, you can create a Cut Plane of each floor level, save each as a 

Named View, and quickly return to any one to modify loads or find 

results after the analysis.  There are two types of Named Views; project 

specific and global.  A global Named View only saves filter settings, 

while project specific views save filter settings, zoom factors, rotation 

angles, and Cut Planes.   Global views become available to all future 

projects.  Normally, you will want to use the more complete project 

specific type. 

Save a Custom Named View 

Set up a graphic view that you would like to save and choose View | 
Name Current View.  You will be prompted for a name, and to choose 

whether the view is to be global or project specific.  Click the OK button, 

and note that the name you just entered for the view appears in the 

Window Type dropdown box on the Status Bar.  To retrieve your saved 

view, pick it from the list of window types. 

Update a Named View 

Use View | Update Current View after you make additional changes 

to an existing Named View.  This will overwrite the existing name with 

the current settings. 
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Delete a Named View 

To delete a Named View use View | Delete Named Views.  A list of 

all global and project specific views comes up and you can choose from 

the list which view(s) to remove. 

Custom Toolbars 

Dock or Float Toolbars 

The toolbars in VisualAnalysis are docked by default, just under the Main 

Menu.  You can make these bars dock along any edge of the window, or 

they can float wherever you like.  To move a toolbar, simply Drag the 

“gripper” bar along the left edge or top edge of a docked toolbar.  Hold 

down the Ctrl key to prevent the toolbar from docking.  If the toolbar is 

floating, you can Drag it by the title bar. 

You may also position the Find tool and Project Manager.  These 

positions are remembered by the software and will be reused the next 

time you start VisualAnalysis.

Caution: It is possible to drag your toolbars off the screen so that it is no 

longer visible.  If this happens, you will need to reset the toolbars to their 

default states—losing any customizations you have made. 

Move Buttons Around 

You may move a toolbar button from one toolbar to another.  Hold the 

Alt key and Drag the button.  If you Drag a button off of the toolbar, 

but not on to another, the button is removed. 

Add Buttons to Toolbars 

To add a button to a toolbar use Tools | Customize Toolbars and go 

to the Commands tab, then locate the button by selecting the 

appropriate category on the left.  Drag the button from the dialog box 

onto the toolbar of your choice. 
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Show or Hide Toolbars 

VisualAnalysis comes with two toolbars on by default.  There are two 

more predefined toolbars available.  Toggle toolbars on and off using 

Tools | Customize Toolbars and the Toolbars tab in this dialog.  If 

a toolbar is floating, you can Right-Click on the title bar and choose 

Hide from the Context Menu to hide it. 

Create Your Own Toolbar 

Create your own toolbars for commands you use most often.  Use Tools
| Customize Toolbars and on the Toolbars tab, Click the New
button and give your toolbar a name.  You can then Drag buttons to the 

toolbar from the Commands tab in the dialog. 

Reset All Toolbar Changes 

Sometime you may want or need to reset the toolbars to their default 

locations.  This could be desireable if the program crashes immediately 

after startup, or if you have "missing" features!  If the software is running 

normally, you can use the Tools | Restore Defaults command.  If the 

software is not running, though, you can hold down the Shift key when 

you run VisualAnalysis.  Keep the Shift key down until VisualAnalysis 

appears on the screen—this will restore toolbars to their default 

positions.  If you then exit VisualAnalysis normally the default toolbars 

will be saved in the system registry, overwriting any customizations that 

were their previously.  If you "kill" VisualAnalysis with the Windows 
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Task Manager, then the customized settings in the registry may remain 

intact. 

Custom Keyboard Shortcuts 

Add, Modify, or Remove a Shortcut 

Notice the Ctrl+C next to the Edit | Copy command.  This is the 

keyboard shortcut for Edit | Copy in all Windows applications that 

follow Microsoft’s software interface guidelines (these are published in a 

book titled: Windows User Experience).  VisualAnalysis allows you to 

change the keystrokes used to access commands in the menu.  Choose 

Tools | Customize Keyboard to add, modify, or remove the default 

shortcuts.  The dialog that follows will allow you to choose from a list of 

all VisualAnalysis menu commands.  To set up a hot key for a command  

select the command name in the list and press the Create Shortcut
button.  You will be allowed to enter a combination of keystrokes that 

you can use to access that command.  A message will appear if you have 

chosen a keystroke combination that is already being used by another 

command. 

Reset Default Shortcuts 

Use Tools | Customize Keyboard, and press the Reset All button to 

restore VisualAnalysis shortcuts to the default or "factory" settings. 

Custom Behaviors 

Data

Use the Data tab under Tools | Customize Behavior to set the 

default properties for nodes, members, springs, and plates.  These 

settings apply to the first objects you create in a new project or 

immediately after restarting VisualAnalysis.  Once you edit an object, 

your changes become the new default, unless you have checked the box 

to always use default values.  
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You can also change the coordinate tolerance.  This is the minimum 

distance between two nodes.  If a new node falls within this distance of 

an existing node, the new node is not created and the existing node is 

used instead. 

The node tolerance is mostly used when generating models or importing 

from DXF or other sources.  The default value works for most 

civil/structural projects, but if you are modeling very large or very small 

structures, you may need to change this value. 

Desktop

Use the Desktop tab under Tools | Customize Behavior to toggle 

messages and actions that usually happen automatically.  This includes 

menu hints, a warning before destroying results, a warning before 

deleting objects, opening result windows, and updating the path to 

project files.   

Program startup options are here to control whether to create a new 

project, open your last project, or do nothing when VisualAnalysis starts. 

There is also an option here to disable the "bright" colors used on the 

Project Manager tabs to help you distinguish between the Modify,

Filter, and Cut/Grid tabs. 

Timed Backup Files 

Use the Files tab under Tools | Customize Behavior to control the 

automatic saving of project files at specified intervals.  VisualAnalysis
offers some disaster prevention by automatically saving your work 

periodically.  These files always go in the TEMP folder defined by 

Windows.  (Please consult the Windows documentation for the location 

of this folder on your system.)  The file is given the name “Your 

Project_Timed_Backup.va!” and is overwritten every X minutes, where 

you control the timing. 
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The timed backup file is deleted when you successfully close a project.  

If the software or the system crashes, the timed backup file is not deleted 

and is recognized when you restart VisualAnalysis.  You will be 

prompted to open the file or delete it. 

Project History Files 

Use the Files tab under Tools | Customize Behavior to customize 

the use of History Files.   VisualAnalysis will create one or more copies 

of your project file each time you open the project.  You set the limit on 

the number of history files to retain, from 1 to 10.  Once this limit is 

reached, older files are deleted.  History files are stored in a folder of 

your choosing, or the TEMP folder by default.  The files are given names 

like “Your Project Version 1.vap”.  This feature may let you get back to a 

previous version of your project in the event of file corruption, or 

undesirable changes that have been saved. 

This history feature is also used on customizable report style files, to help 

prevent losses to customized reports. 

Data Files 

Use the Files tab under Tools | Customize Behavior to define the 

locations of a number of shared or customizable data files.  These data 

files can be located anywhere on your system, but VisualAnalysis needs 

to know where to look for them.  (By default these files are located in the 

\Program Files\IES\IESCommonFiles folder.)  

Some of the files are shared with other IES applications, so if you move, 

or rename one of these files, you will need to update both VisualAnalysis
and the other program(s).  If you make customizations to these files you 

should be careful to make a backup copy of the original and also of your 

customizations. 

Data File Description 

VA5ReportSF.dat

VA5ReportPF.dat

etc. 

This is a set of five files containing report styles for each 

structure type.  The files are binary, but you can edit them 

using Report | Manage Report Styles.

MaterialDB.dbm This database contains all of the available materials in 

VisualAnalysis.  Materials range from various steel grades 

to general materials such as rubber and marble.  The 

material database may be edited with the Material Database 

Editor.

ShapeDB.dbs This is the shape database and contains all of the predefined 

as well as user defined shapes in VisualAnalysis.  The 

database contains all of the general industry standard shapes 

from AISC, AISI, NDS, Canadian Steel, British Steel, and 

others.  The database also has full support for user defined 

shapes.  User defined shapes may be entered into the 

database using ShapeBuilder or the Shape Database Editor.

LoadCombo.txt This text file contains the information for the building code 

service load combinations.  It comes with some common 

building code combinations already defined but you can 

easily add your own as well.  In the IESCommon Files 

folder you will also find a LoadCombo.xls file.  It is 
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Data File Description 

recommended that you edit this file in your favorite 

spreadsheet then save it as a tab delimited text file. 

GenerateStandard.txt This text file contains the parametric structure definitions 

for most of the Model | Generate Standard options.  

Modified in version 5 this text file now handles expressions 

and allows looping over members to make structure 

generation more powerful than ever.  You may open this 

file (instructions are in the file) to add your own custom 

parametric structures. 

Spectrum.txt This text file contains dynamic design spectrum or 

earthquake data.  You may add your own spectra following 

the instructions included within the file.  There is also a 

VisualTools module to write spectra. 

VA5NamedViews.dat This file contains your global Named Views.  You may not 

edit this file directly, but use the View menu commands to 

add, update, or remove named views. 

VA5UnitStyles.dat This file contains the definitions for unit styles.  Use Edit | 
Project Units to save or delete unit styles. 

Load Case 

Use the Load Case tab under Tools | Customize Behavior to 

control which service load cases are created automatically when starting 

a new project.  The Load Case tab also controls which building code 

combinations you want to use by default. 

Reports

Use the Reports tab under Tools | Customize Behavior to make 

changes to headers and footers in reports, report margins and report 

related options.  Many of the options are pretty self-explanatory but a few 

require a little clarification.  Note that to edit any of the numerical values 

in this window, click on the number once to select it, then click on it 

again to actually edit the value.   

¶ Fast Format Reports >= N pages: If a report is greater than  

"N" pages, it will be created in a fast format.  This format 

eliminates nearly all formatting in order to generate very fast.  If 

you have a large report and still want the formatting preserved, 

increase this number. 

¶ Member Output Sections:  This value controls the number of 

member sections at which results are reported.  Note that this 

does NOT icrease the number of sections that are analyzed.  

VisualAnalysis simply linearly interpolates between analyzed 

points to obtain the additional values.  To increase the number 

of sections per member that are analyzed go to Analyze | 
Performance vs. Accuracy.
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Custom Appearances 

Fonts

Use the Fonts tab under Tools | Customize Appearance to change 

the character size and styles used to display text in graphic views and 

reports.  Click directly on the text to open a font selection dialog.  Fonts 

for menus and dialog boxes are controlled in Windows using the Control 

Panel, Display Properties item. 

Picture View 

Use the Picture View tab under Tools | Customize Appearance to 

change  the background color, double buffering, perspective, and lighting 

controls for Picture Views.  

The best way to use these options is by trial-and-error.  Display this 

dialog alongside a Picture View, adjust one of the controls, and use the 

Apply button to immediately see the effect.  Note that the Apply button 

will not work with the double buffered option turned on.  Double 

buffering improves the rendering speed of the Picture View.  Usually, 

there is no reason to not use double buffering.  However, if you do 

uncheck this option, you will have to recreate the picture view for the 

changes to take effect.  This can be done by switching to a Model View, 

then back to a Picture View. 

Default Colors 

Use the Default Colors tab under Tools | Customize Appearance
to change the colors of objects in a Model View.  Every visible object 

type shown in graphic views have a default color.  For example, 

members are blue by default.  If you find these colors offensive, 
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distasteful, or uninspired you may change them here.  Click on the name 

of the item to open a color selection dialog to choose a new color.   

Filters

Use the Filters tab under Tools | Customize Appearance to change 

the default appearance of new windows.  These are mostly the same filter 

options found under the Filter tab in Project Manager.  These settings 

only affect windows you create with Window | New View commands. 

Name Colors 

Use the Name Colors tab under Tools | Customize Appearance to 

change the colors of named objects in graphic views.  If the first letters of 

a member element’s name matches the letters specified here, the object 

will be given this color rather than the default color.  Use this to separate 

different types of member elements.  Using good descriptive names also 

has other advantages for reporting and filtering.  Names are case 

sensitive.  Click on the color box to the right of each name field to 

change the colors. 

Sizes

Use the Sizes tab under Tools | Customize Appearance to change 

how objects are drawn in graphic views.  If you have a hard time seeing 

objects in a Model View, you can increase their size (length or thickness) 

using these controls.  Changing the thickness of Member elements, for 

example, may also make them easier to select.  If you have large, 

complicated models, you may want to make objects one unit wide so the 

display is less cluttered. 
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Restore Factory Defaults 

The Tools | Restore Factory Defaults command lets you restore 

Appearance changes, Behavior changes, Keyboard shortcuts, and 

Toolbar locations and changes back to their original factory setting.  Any 

of all of these items can be reset.   

Note: Reseting toolbars will destroy any custom toolbars you may have 

created, and will reset the locations of the Find tool and Project Manager. 
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Engineering

This chapter contains background material, theoretical discussions, and 

information to help you understand what VisualAnalysis does behind the 

scenes.  The material is meant to supplement the available literature on 

finite element analysis in a practical way, relating the technology to 

specific implementation details in VisualAnalysis.

Structural Models 

Structure Types 

Structure types determine the displacement behavior of a model.  Each 

structure type allows a different set of nodal degrees of freedom.  These 

are sometimes referred to as global degrees of freedom.  There are five 

structure types available: 

Structure Type 
& Nodal DOF 

Displacement Rotation 

DX DY DZ RX RY RZ 

Plane Truss Yes Yes No No No No 

Plane Frame Yes Yes No No No Yes

Plane Grid No No Yes Yes Yes No

Space Truss Yes Yes Yes No No No 

Space Frame Yes Yes Yes Yes Yes Yes 

Structure type affects the default connections between elements.  Trusses 

have pin connections by default.  All members may freely rotate where 

they connect to other members.  A truss model is an ideal truss; members 

may not bend and therefore loads may NOT be applied to them except at 

the nodes.  This behavior does not model most real world situations.  In 

fact, most trusses have continuous chord members that do indeed bend 

between panel points.   

In frame and grid structures the opposite is true: joints are rigid (moment 

connections) by default.  Members bend and moments are carried across 

the joints. 

Selecting a structure type is an efficiency consideration--your efficiency.  

Use the structure type with just the degrees of freedom you need to 

reduce the amount of input data and to simplify the results.   
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You can always use a structure type with more degrees of freedom than 

you really have. If you select a structure type that omits a displacement 

you need, the results will be incorrect.  If all the members really do not 

bend and all the joints are ideal pins, use a truss structure.  In most cases, 

you will need to use a frame or the grid. 

Global Coordinates 

A global coordinate system is one that all entities in your structural 

model share.  VisualAnalysis has a single global coordinate system 

available for this purpose.  Nodal coordinates are specified relative to the 

global system.  Most graphic views show the direction and location of 

the global coordinate system.  If the global origin is not visible the global 

orientation is shown with dashed axes as shown.  Global coordinates are 

always represented with these upper case letters {X, Y, Z, R, Q, F}.

VisualAnalysis also uses element local coordinate systems that are 

distinct to each element.  It is extremely important that you know the 

difference between element local coordinates as defined below and the 

global coordinates. Some data (both input and output) is defined relative 

to the global system and other data is relative to an element's local 

system.  

Nodes are entered and edited in global coordinates.  These are Cartesian 

(X,Y) or (X,Y,Z) coordinates by default, but polar coordinates (R,Q) and 

spherical coordinates (R,Q,F) are also available in the Modify tab of 

Project Manager and in the Node Edit Dialog. 

The Sketch Grid for drawing models may also be defined in a polar 

fashion.  Otherwise, VisualAnalysis uses Cartesian coordinates 

throughout. 

Why Have Load Cases? 

Load cases are used to organize and combine the physical loads on a 

model, with an eye toward design.  VisualAnalysis supports many 

different load types to represent physical loads on your model such as 

concentrated nodal loads, distributed member loads, etc.  These physical 

or actual loads are grouped inside a container called a Service Load Case.   

Each Service Load Case has a load source associated with it.  The source 

defines the physical origin of the loading.  Common load sources include 

dead load, live load, and wind load.  Load sources are used to make load 

combinations easier.  They are described in more detail below.   
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Most design codes require that you check various combinations of loads.   

The LRFD specification for steel, the ACI specification for concrete, and 

the IBC specification for buildings define combinations using equations 

like 1.2D + 1.6L.  In these combinations, loads are grouped according to 

their sources and given factors to account for the relative uncertainties. In 

many cases it is important, as a designer, to look at other loading 

configurations that may also take place.  One such technique is called 

patterned loading.  VisualAnalysis supports these operations through load 

cases.

Case Type Description 

Service Load Case A container for holding physical loads, usually 

grouped by load source.  May also include self-

weight of the model. 

Equation Combination A way of combining service cases, with load 

factors based on load source. 

Factored Combination A way of combining service cases with arbitrary 

load factors. 

Dynamic Response Case A way of specifying a seismic event along with 

direction factors.  Dynamic response case results 

are computed by combining results from mode 

shapes. 

In summary, you should place physical loads that have a common source 

(dead load for example) into a Service Load Case.  These service load 

cases may then be combined using either Equation Combinations or 

Factored Combinations.  Generally, the Equation Combination is the 

most useful when you have partitioned your loads according to load 

source.

What are Load Sources? 

VisualAnalysis provides convenient ways to both organize and combine 

your loads.  Each Service Load Case can be defined as coming from a 

particular load source.  These load sources are derived from the most 

common design specifications such as those produced by organizations 

such as ASCE, AISC, ACI, and IBC.    

The existence of a load source type in the software does not mean that a 

corresponding physical load is supported.  For example, there are no 

“creep” loads that you can apply to a concrete frame.  However, you can 

create member loads and place them in a load case that represents the 

effects of creep on your structure. 
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Load Source Code Explanation 

Creep/Shrinkage TC Loads on concrete, which are continuous over time. 

Dead D Structure weight or permanent fixtures on or in the 

structure.

Earth Pressure H Soil or rock pressures on a foundation. 

Fluid Pressure F Water or other fluid pressures. 

Live L Loads do to moveable equipment or occupancy. 

Live

(Public Assembly) 

Le Garage loads, Public Assembly areas,  

or loads greater than 100psf. 

Impact I Impact from live loads (as might be applied 

separately). 

Roof Live Lr Live loads on a roof. 

Rain or Ice R Initial rainwater or ice exclusive of ponding 

contributions.

Snow S, Sns Snow loads,.Sns is snow on a non-shedding roof. 

Seismic 

(directional) 

EX, E-X, 

EY,E-Y,

EZ, E-Z 

Earthquake or Seismic loads.  EX is for seismic loads 

in the positive global X direction, E-X is in for the 

negative global X direction, and similarly for the Y 

and Z directions. 

Seismic E Earthquake or seismic loads to include with each of 

the directional seismic loads.  (You should rarely 

need to use this, it is provided primarily for backward 

compatibility and ultimate flexibility!)   

Settlement TS Loads due to differential settlement. 

Temperature T Thermal loads. 

Other loads U User defined source not in any predefined category. 

Wind loads 

(directional) 

WX, W-X, 

WY, W-Y,

WZ, W-Z 

Wind pressure loads.  As in the seismic loads above, 

using just W will apply the same load in all directions.  

WX is for wind loads in the positive X direction, W-X 

is for wind loads in the negative X direction, and 

similarly for the Y and Z directions. 

Wind Loads W Wind loads to include with each of the directional 

wind loads.  (You should rarely need to use this, it is 

provided primarily for backward compatibility and 

ultimate flexibility!)   

Load sources are used in VisualAnalysis to create Equation Combination 

load cases.  These load combinations allow you to combine groups of 

service loads together, while automatically applying the appropriate 

multiplication factors based on the source type.  VisualAnalysis can also 

generate the set of factored combinations you need for working with 

LRFD, UBC, IBC, or ACI codes.  The support is not entirely foolproof 

however, as you will still need to pay attention to patterned loading 

situations and other possible complications.  For more information refer 

to the Loading section. 
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Member Elements 

Taper

VisualAnalysis supports a single or double linear depth variation along 

the length of a member.  You may select the starting and ending offsets 

(measured from the starting node) for the variation.  This will allow you 

to create nonprismatic members with many profiles, as suggested by the 

sketch below. 

Connections

Member connections in a frame are rigid by default.  In other words, full 

force and moment transfer exists between the member and the joint 

itself, and therefore to all other members framing into this joint.  In some 

situations this is not realistic.  A common situation in steel is the clip 

angle connection where little or no moment transfer exists.  In this case, 

you should release the moment at this joint.  This is accomplished, in 

VisualAnalysis, using a moment end release.  On the Modify tab of 

Project Manager you may quickly define the most common end 

conditions using the Connection Type list. 

If you wish to have a truss member in a frame model, you can use the 

"Simple Connect" connection type.  This will release the end moments at 

both ends of the members so that no moment will be transferred in or out 

of the member.  (The member can still carry a moment due to applied 

loads or self-weight, however.)  The simple connections are typical for 

cross bracing members in steel construction. 

Other situations involving slotted holes may require force releases in the 

direction of the slot.  Again member end releases are used for this 

application.  To create advanced member end releases, you may need to 

use the Connection tab in the Member Edit dialog. 

Member releases are always specified in member local coordinates.  The 

member local system is presented below.  In the most realistic connection 

situations, there is a partial release of force transfer between the member 

and its joint.  This situation is commonly called a partially restrained  

(PR) joint.  End zones described below may help you model this situation 

more accurately.   

For modeling and analysis of partially restrained connections, refer to the 

VisualAnalysis 5 Advanced level documentation. 
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End Zones 

Members connections in VisualAnalysis are modeled at their centerlines, 

which is normally accurate enough for most problems.  In some cases, 

however, you may wish to be more precise in your modeling.  Member 

end zones allow you to account for a number of different situations you 

may encounter. 

In structural steel connections, the beam to column joint is not totally 

rigid or totally flexible.  The column may have a thin, flexible web that 

will allow some additional rotation.   

In other situations, say when a concrete beam frames into a very stiff 

wall or column, you may want to assume there is no rotation between the 

face of the support and the centerline. 

In an attempt to approximate this behavior, a special end zone may be 

specified at end of the beam element.  The end zone allows different 

member stiffness over a short region to linearly approximate the 

moment-curvature relationship.  Internally, a short member element is 

inserted with modified properties.   



User's Guide VisualAnalysis Engineering ¶ 119 

To specify end zones enter the width of each end zone (zero for a normal end) and 

the percentage of stiffness.  This can be done on the Project Manager, part of which 

is shown, or on the End Zone tab of the Edit Member dialog.  This percent factor 

multiplies the modulus of elasticity of the member when determining overall 

stiffness characteristics of the end zone member.  The reduced EI and EJ values have 

the effect of creating the partially restrained joint. If you select a rigid end 

VisualAnalysis uses a multiplier of 1000 on the member modulus to determine the 

end zone member stiffness. 

For modeling and analysis of partially restrained connections, refer to the 

VisualAnalysis 5 Advanced level documentation. 

Centerline Offsets 

A common situation arises when plate elements are combined with 

member elements.  The plate usually is placed on top of the member and 

thus the beam centerline is offset below the plate element.  Floor slabs, 

metal deck, and wood sheathing supported by beams are all examples.  

The sketch below shows beams and girders aligned at the top flange. In 

order to model effects like this, you may use centerline offsets.  In many 

cases the effects of offsets are negligible and the performance cost can 

make this feature undesirable.   

Centerline offset lengths are specified in a local coordinate y or z 

direction, so a beta or theta angle rotation will change the direction of the 

offset. 

One-Way Behavior 

Many situations exist where either supports or members are capable of 

having a force in one direction only.  VisualAnalysis offers tension only 

or compression-only elements to model these conditions. 

For example, soil is typically able to produce a compressive reaction 

only.  When a footing uplifts from soil, the supporting effect is gone.  

You may use a compression-only spring support to model the soil.  The 

stiffness of the spring is normally calculated using the soil subgrade 

modulus multiplied by the area the spring supports. 

Another example is a slender bracing member such as a rod that will 

buckle under a small axial compression, yet is able to carry a large tensile 

force.  You may use a tension-only member to model a slender bracing 

element. 

There is no support for a cable element in the Basic and Standard levels 

of the software.   
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Refer to the documentation for VisualAnalysis 5 Advanced for 

information about cable elements.   

Continuous Members 

In construction it is common to have main members such as girders that 

support multiple members framing in along their length.  In any finite 

element program, including VisualAnalysis, you need nodes along the 

length of the girder for connecting these supported members.  This 

necessitates dividing the girder into pieces.  For reporting and design 

purposes, you may want to treat the girder as one single continuous 

member. 

You can convert connected member elements into a continuous member 

using Model | Combine Members.  We recommend that you first 

build your model to the point where you have members all connected.  

Then find your continuous members and combine the individual 

elements.  Then you can assign member properties, apply loads and 

complete the analysis. 

When you create a continuous member, the first member in the chain 

defines the shape, material, orientation and other properties.  The end 

releases are taken from the first element and the last element for the 

respective ends.  If you try to combine a group of tapered members, only 

the taper settings for the first element in the chain are used, and those will 

be interpreted for the entire continuous member. 

Hint: While very convenient, continuous 
members are best used after you have 
completed your modeling.  You might 

wish to save a copy of your model without 

continuous members because they cannot 
be "undone". 

The continuous member feature does not support some operations 

that are supported for other member elements.  Once a group of 

member elements is marked as continuous you cannot go back to the 

individual elements, unless you do so immediately with Edit | Undo.  If 

you try to copy continuous members you will get only a single member 

that may need adjustments.  You may not be able to move nodes that lie 

along the continuous member.  We will continue to work on this feature 

to make it more robust and flexible in the future. 

Local Coordinate System 

Member elements each have a local coordinate system that is defined by 

their connectivity and orientation in the model.  Local coordinates are 

always represented with lower case letters {x, y, and z}.  Members also 

use a section coordinate system, described below under the heading 

Section Coordinate System. 

The local system is used to define loads applied in the member's local 

directions.  For example, a force applied in the local x direction is always 

an axial force.  End releases are also oriented according to the direction 

of the local coordinate system.  Finally, member local forces and 

displacements are reported with respect to the local coordinate directions.   

The local x-axis is directed from the start node to the end node.  The 

local y-axis originates at the start node perpendicular to the x-axis and 

will lie in the plane formed by local x and a vector parallel to global Y.  

For plane frame structures, the local z and the global Z will always be 

parallel. The picture below clarifies this idea: 
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A special case exists when the member's local x-axis is parallel to the 

global Y-axis, then the plane for the local y-axis is undefined.  This can 

happen in both the positive and negative global Y directions.  The picture 

above shows the defined orientation for these two situations. 

You can reorient the local coordinate system in a space frame model by 

using the Beta Angle.   The Beta Angle is available for space frame 

structures only.  Please see the sketch in the next section for a picture of 

how the Beta Angle rotates the local system. 

Section Coordinate System 

Cross-sectional properties of members are described with respect to a 

section coordinate system.  These properties include area, moments of 

inertia, and section modulii.  Normally, this system is identical to the 

local system described previously.  A non-zero Theta Angle causes the 

section coordinate system to rotate, about the x-axis, with respect to the 

local system. 

Member stresses are always reported with respect to the section 

coordinates.  Stresses are reported separately for bending (fb) in each 

direction and for axial stress (fa).  The software will also calculate a 

corner stress using a simple algebraic sum of the bending stress for each 

direction and then superimpose the axial stress.  The report notation for 

these combined stresses is fc.

Be aware that if your shape is not rectangular or does not have fibers in 

the corners of the bounding rectangle (like a wide flange does), the 

corner stresses for biaxial bending reported in VisualAnalysis will be 

incorrect.  Consider a tee section; the corner stress is actually calculated 

in two positions that are off the member and will be overestimated. 
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The biaxial corner stresses for the side near the web could be higher than 

true values because the software blindly combines the stresses at the 

extreme fibers in both directions.  In reality, the extreme fibers at the tip 

of the web are a short distance from the neutral axis for bending about 

the plane of the web. 

Beta and Theta Angles 

Beta Angles and Theta Angles are used to change the default orientation 

of the local coordinate system and the section properties.  The two angles 

are defined as shown in the picture below. 

The Beta Angle rotates the local and section coordinate systems about the 

x-axis.  The Theta Angle rotates the section axes with respect to the local 

axes.  Positive rotation follows the right-hand-rule. 

Theta is most commonly used to rotate a column member 90O to re-orient 

the strong direction.  When the member orientation is different than the 

default orientation of the local coordinate system, you should use the 

theta angle to adjust the orientation. 

Beta and theta are somewhat redundant.  Space frame structures only use 

the Beta Angle, while all other structure types use the Theta Angle.  

Please be aware that the Beta Angle will also rotate local direction loads, 

local member end releases, and member local results. 

Member Load Types 

Members may be loaded at discrete points or with distributed loads.  The 

loads may be forces, moments, or thermal changes. 

Concentrated loads are applied at a specific point along the member's 

length.  You do not need to split members to get a node at a concentrated 

load point. When multiple concentrated loads exist, you may specify 

their starting offset and spacing and the sequence can be generated 

automatically. 

Distributed loads can cover the length of the member or just a small 

portion of it.  Uniform and linear loads are treated separately in the 

software.  For example, they are reported using separate tables in a 

report. 

Temperature change loads cause a member to shrink or expand along 

their length. Gradient temperature causes a member to expand on one 

side and shrink on the other to produce a bending effect.  Note thermal 

loads are not in the Basic level. 



User's Guide VisualAnalysis Engineering ¶ 123 

For more information on applying loads and load types refer to the 

Loading section of this document. 

Member Load Directions 

The choice of directions depends on the structure type and the load type.  

In general, loads may be applied with respect to the global coordinate 

system or with respect to each member's own local coordinate system. 

Working with the local system is usually preferred, as it is much easier to 

be certain of the direction and type of load.   

With global loads, the actual effect on the member depends on the 

orientation of the member.  For example, a concentrated force in the 

global X direction might act on a beam as an axial load, while the same 

load applied to a column could be a transverse force. Directions are 

shown with coordinate letters (X, Y, or Z for global coordinates and x, y, 

or z for local coordinates) and labeled as a shear force, axial force, or 

moment.   

Use a negative magnitude to apply a load in the opposite direction.  For 

example, a negative axial force might indicate compression while a 

positive force means tension.  For the other directions, a negative value 

means the load acts opposite to the coordinate system direction.  For 

rotation, a positive load follows the right-hand-rule, which means that the 

load rotates counter-clockwise when the axis is pointed toward you. 

Global distributed loads may be applied directly on the member or they 

may be distributed over the projected length of the member.  The total 

value of the load is reduced if it is over a shorter projected length. 

Member Load Offsets 

Member loads are located from the starting node of the member.  This is 

defined by node 1, or more simply, by the direction you sketch the 

member.  For distributed loads, both the starting offset and the ending 
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offset are measured from the starting node.  A full span load has a 

starting offset of zero and an ending offset of L, the span length. 

Multiple distributed loads may be applied on a member, but for display 

purposes, they may not overlap. 

Member Results 

Member local forces use the strength of materials sign convention.  

Positive bending moment about the z-axis causes tensile stresses on the 

negative y side.  Positive bending moment about the y-axis causes tensile 

stresses on the negative z side.  Positive local displacements and rotations 

are in the same direction as the positive local coordinate directions, or 

rotating about a local axis according to the right-hand-rule, respectively.  

Axial stresses are calculated assuming that the axial force, Fx, is applied 

at the centroid, therefore: fx = Fx/A, where A is the cross sectional area.  

Axial tension forces and stresses are always positive, while compression 

is negative. 

Bending stresses are calculated and reported with respect to the section 

axes, which are assumed principal axes.  These bending section axes are 

identical to the local coordinate axes, unless a nonzero Theta Angle is 

used. 

Member Finite Element Formulation 

The finite element used for member elements is a 2-noded prismatic line 

element.  The axial displacements are based on a linear displacement 

assumption and the transverse displacements are based on a cubic 

displacement assumption.  Shear effects are included only for user-

defined sections with nonzero shear areas.  The stiffness matrix is the 

standard found in most finite element textbooks.  Special cases such as 

end zones and centerline offsets are all handled internally using multiple 

member elements. 

Plate Elements 

Plate elements have changed rather significantly in VisualAnalysis 5.  

Two new formulations have been added to the new plate element to 

account for bending with transverse shear effects in thick plates and 

rotational drilling degrees of freedom.   



User's Guide VisualAnalysis Engineering ¶ 125 

It is important to note that these formulations are not coupled during the 

initial analysis. The stiffness matrix for each formulation is computed 

separately in local coordinate space. The two formulations are assembled 

into a total 6 degree of freedom (dof) global element matrix. Once 

assembled into the global element matrix, the element is combined into 

the total structural stiffness matrix. Membrane and bending coupling is 

achieved with the addition of geometric stiffness terms in the overall 

stiffness matrix. The additional stiffness terms result from membrane 

strains which are calculated during the initial analysis. Once the 

membrane strains are found the element stiffness is automatically 

updated to account for the extra stiffness terms resulting from membrane 

strains.

Plate Bending Formulation – Discrete Shear 
Triangle (DST) 

The bending part of the plate element is now based on the discrete shear 

triangle (DST) formulation originally presented by Batoz et. al. in 1989, 

which includes transverse shear effects.  Prior versions of VisualAnalysis

and many finite element analysis packages use the discrete Kirchoff 

triangle (DKT) as their primary thin plate element. Although the DKT 

element is a reliable and widely used element for plate analysis, it cannot 

accurately model thick plates. The DST element has been widely 

accepted as a reliable plate element capable of modeling both thin and 

thick plate behavior.  The new element accounts for transverse shear 

effects present in structures that might contain areas with thick plates, 

such as footings or thick floor slabs. 

1. Batoz, J.L. And Lardeur, P., "A Discrete Shear Triangle Nine 

DOF Element for the Analysis of Thick to Very Thin Plates." 

International Journal for Numerical Methods in Engineering, v. 

26, 533-560 (1989).  

2. Cook, Robert D., Malkus, David S. and Plesha, Michael E., 

Concepts and Applications of Finite Element Analysis, Wiley, 

1989.  

Plate Membrane Formulation – Independent Drilling 
DOF

Drilling degrees of freedom, previously unavailable in VisualAnalysis,

have been added to the plate element resulting in a 6-dof per node plate 

element. This means that the user may apply a moment perpendicular to 

the surface of the plate element at any of the three (triangle element) or 

four nodes (quad element). Elementary membrane elements ignore 

drilling dofs in order to avoid membrane locking. However, drilling dofs 

are part of many structural engineering problems. Membrane locking in 

the new element was avoided by independently interpolating the drilling 

rotations over the element and introducing a penalty stiffness based on 

the shear modulus. The new membrane element presented in 

VisualAnalysis is based on the early work of Ibrahimbegovic et. al. The 

element is similar to the standard serendipity membrane element and 

yields similar results for all cases not involving applied drilling moments. 
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1. Ibrahimbegovic, Andan, Taylor, Robert, and Wilson, Edward, 

"A Robust Quadrilateral Membrane Element with Drilling 

Degrees of Freedom." International Journal for Numerical 
Methods in Engineering, v. 30, 445-457(1990). 

2. Cook, Robert D., Malkus, David S. and Plesha, Michael E., 

Concepts and Applications of Finite Element Analysis, Wiley, 

1989.  

Plate Thickness 

You can safely model both thin and thick plates in VisualAnalysis.  

Thick plates automatically include the effects of transverse shear 

deformations important for modeling foundations and footings. 

Plate Shapes 

Plate elements can be quadrilateral (4-nodes) or triangular (3-nodes) in 

shape.  The quadrilateral element is generally better than the triangle, but 

the triangular element has been improved over VisualAnalysis 4.0 and 

prior versions, which used a constant strain triangle (CST) element.  The 

new triangle membrane element is not a CST. However, the mid-side 

(drilling dof) nodes are linearly interpolated and added into the corner 

nodes.  Furthermore, we are using single point integration to avoid 

membrane locking.  

For the best results, you should use quadrilateral elements where 

possible, and use triangular elements for modeling transition zones or 

complex geometries only.   

The element formulation is good enough that you do not generally need 

to worry about making the quadrilateral elements square or even 

rectangular.  Quadrilaterals may be distorted significantly without 

problems.  We have run tests comparing the results of long thin elements 

and they work well—to a point.  For the very best results you should 

keep the aspect ratios close to 1:1, but you should not expect any 

problems, for example, with ratios of 5:1. 

Plate Connections 

Unlike member elements, plate elements are always assumed rigidly 

connected to the nodes in all directions.  There is no provision for 

partially restrained (PR) or plate element releases at their connections. 
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For efficiency reasons, you should avoid situations where you have 

dozens, or hundreds of plate elements all connected to a single node.  

This situation commonly happens at the center of a circular disk, with 

radially generated plate elements.  You may with to adjust the mesh near 

the center to alleviate the situation. 

Plate Local Coordinate System 

Plate elements have their own local coordinate systems.  The local 

system has its origin at the centroid of the plate.  The local x-axis is 

parallel to and in the direction of a vector from the first node to the 

second.  The y-axis is perpendicular to the x-axis and in the plane of the 

plate.  Note the right-hand rule where the local z-axis points out of the 

plane defined by the counter-clockwise node ordering. The picture below 

clarifies this, using a triangular plate element as an example. 

For plate elements, the local systems are used for directing pressure 

loads.  Local forces and stresses are also reported in these directions.   

From a practical standpoint, it is usually necessary to be consistent in the 

creation of plates.  The convention is to draw elements in a counter-

clockwise manner, from the lower left.  Generated plate elements in 

VisualAnalysis are usually oriented this way.   You can use the Filter tab 

in Project Manager to show plate local coordinates to verify their 

directions. 

As mentioned, the local coordinate system becomes very important when 

applying plate pressures.  If the plates are randomly drawn in either 

direction the local z-axis will point in opposite directions and loading 

will become rather difficult. 

Plate Behavior and Structure Type 

Plate elements exhibit two general behaviors, depending on the structure 

type.  The first behavior develops membrane stresses which are in-plane 

stresses resulting from stretching, compressing or shearing the element. 

The second behavior develops bending stresses, which are the result of 

out of plane pressure loads, or rotations out of the plane.  The structure 

type will dictate which of these behaviors are present. 
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Plate Behavior 
& Structure Type 

Membrane
(in-plane) 

Bending
(out-of-plane) 

Plane Truss Yes No

Plane Frame Yes No

Plane Grid No Yes

Space Truss Yes Yes 

Space Frame Yes Yes 

Determine Plate Size 

One of the more difficult tasks you have as an engineer is to verify the 

validity of your results.  Plate elements are approximate—the more 

elements you use, the better your results.  There is a tutorial project 

called Element Mesh Demonstration, installed in the Examples folder, to 

demonstrate this concept. 

Determining a plate element size that gives accurate results and 

minimizes your model (and your time) is critical.  VisualAnalysis uses a 

plate element with good convergence characteristics.  Use the following 

procedure to minimize the number of plates in your models: 

Plate Modeling Procedure 

1. Start with an element size that matches the natural geometry in the 

model.  Use nodes at locations where other plates connect or where 

members connect.  Try to minimize the number of plate elements in 

a reasonable way—do not bother with a single plate, though! 

2. Run the analysis and record your results.  If you have reason to 

question the results or if you have no way of knowing whether or not 

they are reasonable, proceed to step 3. 

3. Subdivide your initial element meshes into smaller elements.  

Model | Split Plates makes this process easy.  Analyze again with 

the refined model. 

4. Compare the results of step 3 with the previous analysis.  If the 

results are similar, assume you are near the converged solution and 

feel somewhat confident of your results.  Otherwise, if the results 

differ substantially, return to step 3. 

As a general rule, you will want to place more elements in areas where 

stresses and forces in the plates are changing the most per unit length of 

mesh.  Stress concentrations or locations near concentrated loads may 

require smaller element size.  At locations under uniform loading or no 

loading, and away from geometric irregularities, large elements may be 

sufficient. 

Plate Load Types 

Plates may be loaded with a perpendicular pressure or a thermal change. 

Pressures and thermal gradient loads will cause bending in the plate, and 

are only available for 3D models and the Plane Grid. 
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Plate pressure loads act only in the local z-axis, or perpendicular to the 

plate.  These loads may be uniform, linear or warped.  There are two 

ways to define plate pressures.  First, you can define the load on an 

element-by-element basis, where pressures are specified for each corner 

of the plate.  Alternatively, you may apply a linear or hydrostatic load to 

an entire mesh of plates, where the load is defined based on global 

positions and directions and the individual pressures on each element are 

calculated automatically. 

Plate elements may also resist thermal loads.  Currently both a 

temperature change load and a temperature gradient load may be applied.  

The temperature change load acts uniformly through the thickness in all 

directions.  The net effect of this type of load is a stretching or shrinking 

in the plane of the plate.  A gradient load is a linear varying temperature 

through the thickness.  This load is specified as a change in temperature, 

dT.  The top surface is set to dT/2 and the bottom surface to –dT/2.  This 

load causes pure bending. 

Plate Results 

Plate forces are reported per unit length of plate and may be output 

relative to the global or local axes.  Moments have units of 

force*length/length and shears have units of force/length.  The positive 

sign convention for moments produces tensile stresses on the +z local 

coordinate face of the element, as shown in the sketch.  This is typical 

plate notation as found in most texts on plate theory. 

Plate membrane stresses may also be output relative to the global or local 

axes. The picture below shows the sign convention for positive stress 

directions.  As usual, positive normal stress indicates tension. 
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If plates in your structure can also bend, stresses may be reported at each 

of the top and bottom faces.  Stresses at the face are combined bending 

and membrane stresses.  If plates are subject to bending stresses only, the 

mid-plane is the neutral axis and therefore the normal stresses at this 

plane will be zero. 

Plate forces and stresses may be reported with respect to the global 

coordinate system.  This simplifies result interpretation when the local 

axes are not aligned.  Consider the case where you have a mesh of 

triangular or odd shaped quadrilateral elements.  For these elements, 

aligning local x-y axes with the global direction would be extremely 

difficult.  If you choose global X and Y result values however, all local 

results will be transformed to the global directions providing for 

consistent contour plots and report results.  The global forces follow the 

right-hand-rule for sign convention.  That is, a positive MX moment is at 

the global X edge of the plates and rotates about the global Z-axis. Some 

results may be zero after the transformation to the global directions, for 

example the global-Z moment for a mesh lying in the X-Y plane. 

Spring Supports 

Elastic Supports 

Spring supports are often used to model support conditions that are not 

truly rigid.  For example, many soil-based footings have some elastic 

compression behavior that results in support settlement.  When these 

cases exist, you may place a spring at the support node and set its 
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stiffness relative to the soil elastic properties.  More information on 

calculating the stiffness is given in a section below.  If you wish to model 

a compression-only support, you will need to orient the spring in the 

correct direction to get the correct behavior. 

Spring supports “take load out” of a structure and should be used as 

support only.  They are not used for modeling partially rigid connections 

between elements.  To model a settlement at an elastic support, you 

should use a Nodal Settlement Load. 

Inclined Supports 

VisualAnalysis currently only allows you to create nodal supports in the 

global coordinate directions.  To model an inclined support, you should 

use a spring support.  It is possible to use a spring support in combination 

with nodal supports (in different directions) at the same node.  The spring 

may be elastic or infinitely rigid, and oriented at any direction. 

Determine Soil-Spring Stiffness 

When spring elements are used to model soil stiffness, the following 

procedure should be followed.  The first step is to acquire a measure of 

the elasticity of the soil supporting the structure.  The most common 

metric for this is the subgrade modulus.  Many references give values of 

this parameter based on general classification (dense gravel for example) 

or based on blow count measurements.  The subgrade modulus has units 

for force per length cubed.  To convert from subgrade modulus to a 

spring constant, simply multiply by the area of soil covered by the 

footing or plate.  For example if you had a 3 foot by 3 foot square footing 

resting on a soil with a subgrade modulus of 300 lb/ft3 you would use a 

spring whose stiffness was 2.7 kips/foot (assuming just one spring for the 

whole footing). 

Spring Results 

Spring element output is based on the following sign convention.  For 

displacement springs, a positive force indicates a tensile force exists in 

the spring.  Similarly, a negative displacement spring force indicates the 

spring is being compressed.  For rotational springs, a positive moment 

indicates the spring is being twisted about its rotational axis according to 

the right hand rule. 

Finite Element Formulation 

The spring element used in VisualAnalysis simply adds a term to the 

diagonal of the structure stiffness matrix equal to the spring constant 

value.  For inclined springs, a transformation matrix yields a coupling 

term similar to a truss finite element.   
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Nodes

Degrees of Freedom 

Depending on the structure type, nodes may move or rotate with respect 

to the global coordinate system.  The ways a node can move or rotate are 

called degrees of freedom.  In a plane frame for example, nodes may 

translate in the X and Y directions, and they may also rotate about the Z-

axis.   

Free or Supported? 

Most nodes in a model will be free from external supports.  Nodal 

supports are used to restrain the entire structure against rigid body 

translation or rotations.  Typically you will use nodal supports at the base 

of columns.   

Choose your supports wisely.  A support should only be used at a 

location where load is taken out of the model or where you are specifying 

a nodal displacement.  Do not support nodes at locations where you are 

applying external loads.  Also, do not support nodes in directions where 

you have placed a spring support, as this will render the spring support 

ineffective.   

Nodal Loads 

You may apply concentrated nodal loads in the form of forces, moments, 

settlements or rotations.  These loads are applied with respect to the 

global coordinate system.  They may act only in a direction where a 

degree of freedom exists for the structure type. Nodal settlements and 

rotations must be applied in a supported direction.  The support can come 

from a nodal support, or a spring support. 

In order to apply an inclined load (not parallel to one of the global axes) 

you will need to break it into components and apply the global direction 

component loads separately. 

For dynamic analysis, nodes may also be loaded with additional lumped 

mass.  For more information see the chapter on Analyzing. 

Nodal Results 

Nodal results include displacements and rotations for unsupported 

degrees of freedom.  In supported directions, reaction forces and 

moments are produced.  If you apply a nodal settlement or rotation load 

to a node, that becomes the displacement results for that direction.  

However, force reactions are still calculated. 

Validate Your Results 

Before You Analyze 

Before you perform an analysis, you should carefully check all input 

data.  You should always use the Analyze | Check model for errors
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menu command.  You still may want to manually note that features like 

end releases and support conditions are correct.  You may also want to 

take a look at the Picture View to visually observe member sizes, 

member materials, orientations, and locations to ensure they are correct. 

In a Model View you may also want to check the local axes, theta angles, 

and other properties using the Modify tab (as an inspector) or the Filter
tab options.  Use the Find tool to sort objects based on any property 

shown in a column—mistakes tend to float to the bottom or top of the 

list!

Reports are available to record the data you have entered and provide 

another way to find mistakes.  Refer to the Reporting section for more 

information about reports. 

Total Load Checks 

One of the first checks that should be made after an analysis is to verify 

your total structural loading.  Use the Result tab of Project Manager to 

see the Statics Check for each load case.  The applied loads are totaled in 

each direction. 

This information is also available in a statics check report.  Included in 

this report will be the total load applied to the structure in each global 

coordinate direction for each load case.  Check these numbers against an 

estimate of the actual loads applied.  Verify that the reported totals are in 

the ballpark with your estimates.  If there is a discrepancy, use the Model 

View to verify load directions and magnitudes.   

Static Checks 

The Statics Checks available under the Result tab of Project Manager, or 

in a Report View will help you find many types of problems.   

Check for nearly unstable structures.  If you have poor geometry or very 

flexible members in critical areas, the structure can be on the verge of 

collapse due to instability.  Many times, unbalanced reactions can be a 

tip-off for these problems.  This imbalance is automatically checked at 

the end of the analysis phase.  You might receive a warning message if 

the Statics Check imbalance is significant. 

Displacement Checks 

Look at the deformed shape of your model.  Does it make sense based on 

the loading and structure?  Remember that the displaced shape is usually 

exaggerated so you can see it.  For true displacement display use a zero 

for the Displaced Shape Factor in the Filter tab for a Result View. 

Look at the magnitude of the largest displacement shown using the 

Result tab in Project Manager.  Is it large?  If displacements are too 

large, the basic assumption of small displacement is violated and results 

must be questioned. 
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Reasonable Stress Checks 

When you are comfortable with the loads, statics, and displacements you 

should also check stresses.   Use the Filter tab for a Result View to show 

stress values and the legend.  Look at the extreme value presented in the 

legend.  Are the stresses reasonable?  The software will blindly place 

1,000,000 ksi on a wood member without warning!  Would you?  It only 

takes a second to zoom in on the extreme color and see where it exists.  

Make a decision as to whether or not it is reasonable. 

Validation is Up to You 

Finally, use your experience and engineering judgment.  If something 

just does not look right, investigate it carefully.  Convince yourself that 

the results are correct before continuing. 

Getting correct results is up to you as an engineer.  We make every effort 

to test the software, but it is impossible to prove it correct under all 

circumstances.  If you have a problem, please investigate it carefully. 

Compare the results with another program, hand calculations or 

estimates.  Before you contact us, please prove to yourself that there 

really is a problem in the software—we do not provide consulting 

support, or “model checks” for you. 

If you find an error giving you incorrect results, we want to know about 

it!  Carefully document the problem and then contact us using the support 

channels outlined in the Troubleshooting chapter or on our web site.  IES 

is committed to maintaining a high quality tool in VisualAnalysis.  We 

stand behind the software and will work quickly to solve any problems 

you might expose. 

FEA Modeling Issues and Errors 

This section is taken from a multi-part series that was sent out with our 

monthly newsletter.  This section will help you avoid the problems that 

IES technical support staff have seen over the past few years.  Perhaps in 

the future the software will automatically fix modeling problems or 

prevent them from happening at all, but for now, the structural analyst 

must rely on experience and detective skills to uncover bugs in a model. 

This section is intended to uncover bad assumptions, common mistakes, 

and discuss structural modeling issues in modeling for Finite Element 

Analysis.  This section should not be taken as a definitive method for 

modeling structural problems using finite element software in general, or 

using VisualAnalysis in particular!  While we hope this section will help 

you become a better practitioner, and help in learning the art of finite 

element modeling, our recommendations and conclusions in this section 

should not replace your sound engineering judgment. 

Introduction

VisualAnalysis is a typical finite element analysis program.  While it 

supports a great user interface that makes modeling fast and easy, and 

provides built-in checks to help prevent errors, it will not entirely prevent 

you from making mistakes.  VisualAnalysis will often issue warnings 
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and will provide diagnostic messages when things go wrong, but 

sometimes unraveling these messages is not so trivial. 

Connections

Connection problems top the list at IES technical support for errors in 

customer models.  There are four primary causes for problem 

connections: 

1. Mistaking external supports for moment connections in a frame. 

2. Misunderstanding the nature of the connection between a plate 

element and a beam element in the same plane. 

3. Unconnected members that appear to be connected. 

4. Members along the boundary of a plate mesh that are only 

connected to the plates at their end-points. 

We will look at each of these errors and how to solve them. 

PROBLEM: All Nodes Fixed 

The first problem consists of misunderstanding how beam elements 

connect in a frame model.  When you first create a model in 

VisualAnalysis, you are asked to specify whether the model is a truss or a 

frame.  In truss models all joints are pure, frictionless hinges.  In a frame 

model all joints, by default, are rigid moment-type connections.  Some 

customers have missed this distinction and try to create moment 

connections in a frame by using external supports.  Typically every node 

in the structure is marked as "fixed".  The confusion probably is due to 

terminology changes from one software program to the next, or perhaps 

this is a first-time use of finite element software.   

SYMPTOMS: 

There are two ways to identify this situation in a model.  First, when you 

try to apply a nodal load to the model, you will get an error "Nodal loads 

may not be applied in the direction of a nodal support."  Another 

symptom of this error is that all of the results (nodal displacements) are 

zero.

SOLUTION:

The "all nodes fixed" problem is easily solved by removing all of the 

external supports on nodes, except those nodes that truly have external 

support.  In a typical building frame this is just the nodes at the base of 
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the structure, where the frame sits on a foundation, or where the 

foundation rests on the ground. 

PROBLEM: Members Not Connected 

Another common problem is to create a model that looks like it has 

connected members, but the members do not in fact share any nodes.  

This is something that VisualAnalysis will normally warn against as you 

draw or copy members.  But it is entirely too easy to create models like 

this anyway.   

SYMPTOMS: 

You will often get an error when you try to analyze an unconnected 

model: "Members exist in your model which are not connected.  Would 

you like them deleted?"  If you say yes, you will find out immediately 

which members are missing.  (Just make sure your model is saved before 

you say yes, so that you don’t lose a lot of work.) You will probably get a 

message after they are removed that your structure is no longer stable! 

SOLUTION:

The solution is in understanding that the finite element formulation 

requires members to connect at nodal points.  So if a member crosses 

another, it must be split and both members joined at common nodes. 

Note:  You can later "recombine" the columns as continuous members 

for simpler reporting! 

PROBLEM: Members Not Connected to Plate Mesh 

The final example of connection problems again involves both plate and 

member elements.  When creating a floor slab it is tempting to use a 

single plate element, which is almost always incorrect—you should use a 

mesh of plate elements.  Even if you have a mesh, it is very tempting to 

keep the model simple and to create single beam elements that span 

between columns.  The problem is that without the intermediate 

connections between the beam element and the mesh, you will not get 

consistent deflections or any load transfer between the two element types, 

except at the end points. 
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SYMPTOMS: 

When you inspect results you will find that beam elements and plate 

elements deflect differently.  If you have loaded the plates they will 

deflect but the beam will not.  If you have loaded the beams, then the 

reverse will be true. 

SOLUTION:

The solution in this situation is to split the member elements along the 

plate mesh boundary to get common nodes connecting the two types of 

elements.  When you create a plate mesh by splitting a single plate 

element, VisualAnalysis will automatically do this for you. 

Conclusion

Connection errors are surprisingly easy to create, yet are usually solved 

easily.  With some basic knowledge of finite element behavior and 

implementation, they can usually be avoided altogether. 

For more information about FEA modeling issues and errors, IES 

recommends the following textbook: 

Finite Element Modeling for Stress Analysis

By Robert D. Cook 

1995, John Wiley & Sons 

ISBN: 0-471-10774-3 

Mechanisms

Some of the connection problems discussed above result in mechanisms 

(structures that have moving parts), but there are other ways to create 

mechanisms in a VisualAnalysis model.  Some of these are obvious once 

you "see" the problem.  Others are more subtle mathematical instabilities 

that would not happen in a "real" structure, but cause problems in the 

matrix analysis. 

PROBLEM: Rotating Columns  

Here is a problem that many engineers involved in steel building design 

will see at one time or another.  When modeling a braced frame in 3D, 

you will often have columns that are pinned at the base, supporting 

simple beams, and possibly bracing members.  This is how the structure 
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is built, but your model is a mechanism.  Here is a picture of an isolated 

column in such a model, and a Picture View snapshot showing the 

framing detail. 

Typically you will model this with end releases on all the beam members 

because you do not want them to carry moments through the simple clip 

angle or shear tab connections. 
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SYMPTOMS: 

When you try to analyze the model, VisualAnalysis tells you that node 

N7 (at the top of the column) is not supported in the RY direction. 

SOLUTION:

This can be a confusing message!  What does node N7 have to do with 

anything  (Often there are members framing into this node as well, in all 

four directions!)  It helps if you figure out that "RY" means, rotation 

about the global Y-axis, as defined in the Help file, search for "Notation". 

The answer is that the entire column is free to rotate about its own axis.  

The pin support at the base provides no rotational restraint, and if all the 

beams have weak-axis moment releases, then they provide no resistance 

to this rotation either.  The error is in modeling the connection to the 

foundation, which will not rotate.   Fix the column base with a nodal 

support in the RY direction. 

PROBLEM: Spinning Nodes  

Here is a similar problem, also involving incorrectly modeling the base 

support condition.  We have a model of a swing set, which is a pure truss 

model, although modeled as a frame in VisualAnalysis to allow the 

continuous top chord to carry the swings.  The main support members are 

pinned at both ends because the designer marked the connection type as 

"truss member" under the Modify tab of Project Manager.  The base 

nodes are pin supported. 

SYMPTOMS: 

When you try to analyze the model, the software complains about one of 

the base nodes not being supported in the "RY" direction. 

SOLUTION:

Although this is the same message that we received in the previous 

problem, you may try to solve the problem differently.  Perhaps these 

aluminum posts are just sunk into the sand and there is nothing to prevent 

them from rotating at the base.  You could fix the posts at the top because 

they are definitely not going to rotate there, but this creates a moment 

connection that you do not want!   
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The solution in this case is to remove the end releases at the base of the 

supports.  These releases are separating the member from the node in a 

rotational sense, and because the node itself is not restricted, it can spin.  

We have a mathematical ‘singularity’ in the stiffness matrix that 

effectively prevents analysis.  Once you remove the end releases at the 

base, the node is tied to the support member and is mathematically stable. 

PROBLEM: Four-Node Truss Panels 

Perhaps one of the most embarrassing problems you will face in 

structural modeling is when you create a situation that you know is 

unstable from your first structural analysis course in college.  Everybody 

knows that a truss is made out of triangles and that a four-node truss 

panel is unstable.  And yet, it is easy to create a 3D space truss like this: 

The problem is that we often think about structural analysis in 2D rather 

than 3D! 

SYMPTOMS: 

If you analyze this 3D model, you will find that it works just fine!  At 

least it appears so at first.  For gravity loads the model is stable and you 

get reasonable results.  However, for a laterally applied wind load (hitting 

the bridge sideways) you will find some tremendously large 

displacements! 

SOLUTION:

The solution is to look at the structure from the end.  Now you can see 

the four-node truss panel.  The solution depends on the structure you 

intend to build.  Most real structures are not pure trusses, but will carry 

moments.  You may also wish to provide some knee braces or similar 

supports.
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PROBLEM: One-Way Members are Removed 

Another mechanism problem that you can run into in VisualAnalysis is 

not really a problem with your modeling, but in the non-linear analysis of 

tension-only or compression-only members or spring supports. 

When you analyze a model with one-way elements, the analysis is 

iterated.  Elements are checked after each analysis to determine whether 

they need to be removed or put back.  This continues until the solution 

converges—that is, no elements need to be removed from or replaced in 

the model.  Unfortunately, you do not always get convergence and you 

have to resort to manual solutions or modeling changes. 

Sometimes however, you can end up with a different type of problem.  

Because elements are removed from the model automatically, and 

somewhat randomly, your model can become unstable.  The following 

simple structure demonstrates the problem.  The diagonal brace is 

defined as tension only, but the load will put it in compression so it will 

be removed during analysis. 
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SYMPTOMS: 

When you try to analyze you will receive a message: "Analysis has 

stopped due to an instability in the model..." 

SOLUTION:

The trick is to remember that you have these one-way elements.  Mark all 

of your one-way elements to behave normally (perhaps in a copy of your 

project file) and see if the analysis will run in a linear fashion.  If so, you 

are closer to solving it.  The solution though, may be involved and is 

placed under the heading "The Art of Modeling"; in other words, IES 

Technical Support is not going to help you solve this one! 

Element Definition Problems 

After you have built dozens or even hundreds of models, it is easy to get 

careless.  The class of problems we discuss in this section represent 

simple oversights or mistakes.  They are subtle problems that can cause 

some strange analysis results.  While they are easy to solve, you may not 

know where to start looking.  This section will provide some practical 

ways to quickly eliminate trouble spots in your models. 

PROBLEM: Members are Oriented Incorrectly 

Member orientation refers to the directions of the strong and weak axes. 

There are four common reasons that members are created with an 

incorrect orientation.  All four are easily solved once you understand how 

members are oriented in VisualAnalysis and how to check their 

orientations. 

1. Columns are rotated 90 degrees 

2. Model is imported from a DXF file (Z is vertical) 

3. Model is created in VA with vertical Z axis 

4. Roof purlin is not aligned with the roof slope 

SYMPTOMS: 

If you have columns rotated the wrong directions, you may get large 

story drifts, if you have beams rotated the wrong directions, you will 

probably see large bending stresses or deflections. 

Many of these types of problems do not have obvious symptoms.  You 

will need to watch out for these conditions without any warnings or 

errors from the software. 

SOLUTION:

The solutions to member orientation problems are an understanding of 

default orientation for members in VisualAnalysis, and knowing how to 

check the orientations.  The strong axis of a member is bending about 

local z. 

Default Orientation: 
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How to Rotate Members:  Use the theta angle in a plane structure to 

rotate the cross section.  Use the beta angle in a space structure to rotate 

the member local coordinate system (and the cross section).  To edit the 

rotation angle, use the Modify tab of Project Manager. 

How to Check Member Orientation:  One of the quickest ways to 

check member orientations is with the Picture View.  Using the zoom 

and rotate commands you can quickly scan your structure and make sure 

the members are all correct.  You can also display the rotation angle 

(theta or beta) as a number on each member in a Model View.  The 

rotation angle also is displayed in the Edit | Find window and in Member 

reports.  Another way to check in a space frame is to turn on the Local 

Coordinate filter item.  This will display the local coordinate system of 

each member graphically in a Model View.  If the view or local 

coordinate system is skewed it may be difficult to see the exact 

orientation.    

PROBLEM: Members have the Wrong Material 

VisualAnalysis is a fairly smart program.  If you choose a W12x14 from 

the AISC shape database, VisualAnalysis will automatically recognize 

that this member is steel and will set the material accordingly.  (At least 

most of the time!)  However, it is entirely possible to create a concrete 

W12x14, or a steel 2x4. 

SYMPTOMS: 

If you do not catch this problem before analysis, you may get some rather 

strange deflections.  Otherwise the problem can go unnoticed.  

VisualDesign may protest by ignoring this member during unity checks. 

SOLUTION:

One quick way to check for this type of problem is to look at your model 

in the Picture View.  Members and plates are colored according to their 

material and you will quickly spot the "bad" element.  Here is an 

example: 
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The Edit | Find window will also show members or plates in a list and 

you can sort them based on material type. 

PROBLEM: Elements Have Zero Area 

It is possible to create a four-node plate element that used the same node 

for two corners.  When you create a three-node plate element you define 

node 1 the same as node 4 and this is OK.  But if any other two nodes 

(1,2), (2,3), or (3,4) are identical, this is an error condition and will result 

in a plate element with a zero or negative area. 

SYMPTOMS: 

VisualAnalysis will optionally perform an element check before the 

analysis and will stop with an error indicating a plate element has a zero 

area or length.    

SOLUTION:

The simple solution is to redefine the plate element’s nodal connections.  

You can do this by editing the element.  This is the best solution if you 

have loads defined on the element.  Although it may be easier to delete 

and redraw the element, than to figure out the names of the nodes it 

should be connected to, doing so will delete the loads on the plate. 

Dynamic Analysis Models 

For many structural engineers, dynamic analysis is something rarely 

used.  It is also something that usually gets limited treatment in 

undergraduate programs.  This means that many engineers simply try to 

rely on a software program to do the right thing when it comes to 

investigating the dynamic behavior of a structural model. 

In this section we will look at three common points of confusion 

customers may face when building models for dynamic analysis. 
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PROBLEM: Not Enough Member Elements 

If you run a static analysis of a typical frame or truss made of member 

elements, you will get great results without worrying at all about the 

concept of mesh refinement.  When it comes to dynamic analysis, 

however, accurate modeling becomes more difficult. 

Consider the relatively simple problem of finding the fundamental 

frequency of a cantilevered beam.  Here is a model that works just fine 

for a static analysis: 

What happens if we run a mode shape analysis on this model? 

SYMPTOMS: 

The mode shape below looks very reasonable and in fact the shape is 

correct.  This is due to VisualAnalysis 5's use of distributed mass 

methods.  Previous versions of VisualAnalysis simply lumped half the 

mass at each end of the element giving inaccurate results for non-refined 

elements.  However, despite the improved mass distribution, more 

accurate mode shape frequencies are obtained if the element mesh is 

refined. 

SOLUTION:

The solution is to split the member elements into pieces.  The more 

pieces you use the more accurately you will the shape of the vibrating 

structure.  This is similar to plate elements during a static analysis, where 

you only get approximate results.  To check the accuracy of the model, 

you can run two or more analyses using mesh refinement and comparing 

the results.  When you get close to the theoretical solution, the results 

will change very little.  In the example above, the second mode shape 

frequency was found to be 22.325 Hz for the two element model.  

Refining the beam by using 5 elements resulted in a frequency of 28.471 

Hz.  Using 10 elements resulted in 29.784 Hz and using 50 elements 

resulted in 30.238 Hz.  It is clear that not much was gained by refining 

the beam further than 5 – 10 elements but there was a substantial 

difference between 2 elements and 5 elements. 
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PROBLEM: Incorrect Mass 

Consider the same cantilevered beam problem.  We have now modeled 

the problem more accurately, by splitting each span into multiple 

member elements.   

In addition, we have created a dead load case and a live load case with 

the expected loads on the beam because we remember that the frequency 

will vary with the mass of the system.  Next we run a mode shape 

analysis and VisualAnalysis calculates the fundamental frequency of 

vibration. 

SYMPTOMS: 

Unfortunately this is not the correct answer, but VisualAnalysis has no 

way of letting you know that you have made a mistake.  The answer is 

simply wrong. 

SOLUTION:

The reason the answer is wrong is because the correct mass of the 

structure was not used.  While the mass of the model itself is included, 

VisualAnalysis does not automatically include loads in the dynamic 

analysis.

In order to include the dead load and live load mass into the analysis, you 

need to create a Factored Load Case, to combine the two service cases 

into one, with factors of 1.0 on each.  Then when you run the dynamic 

modal analysis, you need to specify this load combination as included 

mass in the analysis dialog. 

PROBLEM: Too Few Mode Shapes in Dynamic 

Response

When doing a dynamic response analysis of a building frame the 

tendency of an inexperienced engineer is to include an arbitrary number 

of mode shapes and then call it good.  Part of this reasoning is sound: the 

response analysis computes dynamic forces by combining the effects of 

mode shapes.  The lower modes (calculated first) tend to be much more 

important than the higher modes.  The inclusion of too many modes will 

just increase the analysis time and may not affect the results significantly. 

SYMPTOMS: 

So how do you know if you have enough mode shapes included?  

Unfortunately, there are no warnings or messages in VisualAnalysis.  It 

is up to you to double-check the results. 

SOLUTION:
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Building codes typically require that a dynamic response analysis include 

a certain minimum percentage of participating mass in the response 

analysis.  VisualAnalysis provides a report item called Dynamic Analysis 

Summary that will show you the mass participation of each mode shape 

and then total them as a percentage of the mass of the structure (and any 

loads you included as mass).   You can then use this to determine if you 

have enough mode shapes.  If not, you will need to increase the number 

of modes. 

Dynamic Analysis Summary 
Response Case: Example 10 

Mode    X-Modal     Y-Modal     Z-Modal

Shape   Mass        Mass        Mass

Number  Part. (%)   Part. (%)   Part. (%)

   1       0.000       0.000      60.976

   2       0.000       0.000       0.000

   3       0.000       0.000      32.466

   4      80.257       0.000       0.000

   5       0.000       0.000       0.000

   6       0.000       0.000       6.493

   7      15.067       0.000       0.000

   8       0.000       0.000       0.000

   9       4.606       0.000       0.000

Totals    99.930       0.000      99.934
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Troubleshooting

This chapter will help you get past problems or errors in VisualAnalysis

in an efficient manner.  We have built VisualAnalysis to be stable, 

accurate, and error free.  You should expect it to perform flawlessly!  If it 

does not, please follow the procedures in this chapter to get back on 

track—or to set IES back on track. 

Common Solutions 

General Issues 

One of the very first things to do if you think there is a problem with the 

software or something does not seem to be behaving correctly is make 

sure you have the latest versions of the software.  This can usually be 

checked by going to Help | iesweb.com | Update VisualAnalysis.

If no updates are available, then you are probably up to date.  For a "hard 

numbers" approach to checking for updates you can use the Help | 
About VisualAnalysis menu command.  This will bring up a window 

that will indicate the version you are running.  You can then go to our 

Customer Center (www.iesweb.com/customer.htm) where you can find 

an option to Install Updates.  Here you will find the various software 

programs and their version numbers.  If your number is earlier than the 

posted one, you can simply download the update. 

Crashing While Working 

If VisualAnalysis fails while you are working with a message like 

“General Protection Fault”, or “Application Error”, or “Dr. Watson 

Error”, or similar, there might be an error in the software.   

Try to reproduce the problem.  Sometimes these errors cannot be 

reproduced, in which case you should take a wait-and-see approach to 

see if it happens again.  If you can reproduce the problem, please let us 

know.  Contact technical support to report the problem. 

For the best service, try to include as much information about the 

problem, when it happens, what messages you received, etc. 

Printing

If you experience problems when using File | Print or File | Print 
Preview, you may need to update your system. 
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Out-of-date printer drivers can cause many problems.  You can usually 

download the latest driver for your printer from the printer 

manufacturer's web site. Here are a few popular printer manufacturers: 

www.hp.com   www.epson.com

www.canon.com   www.lexmark.com

  www.xerox.com

Display 

If you see screen garbage, things get scrambled, portions turn black, 

buttons disappear, or windows remnants appear, you may need to update 

windows and/or your video card drivers.   

Out-of-date video drivers may cause problems with the display.  It may 

happen with only some programs on your system and not others.  

VisualAnalysis and other IES products take advantage of the OpenGL 

graphics system and having the latest video card drivers will ensure you 

get the best graphics performance. 

As mentioned above, updating Windows can also help remedy any 

graphics problems you may be having.  Most Windows service packs 

include an updated OpenGL32.DLL file.  Again, keeping Windows up to 

date can certainly help prevent any graphics issues. 

Accuracy and Validation 

If you are having trouble getting results, or getting accurate results for an 

analysis, please read the chapter on Analyzing and the chapter on 

Engineering in this User’s Guide. 

Project Files 

If you get error messages when opening a project (.vap) file, it may be 

that the file is corrupt, or program or data files are missing or modified. 

Files can become corrupt for a variety of reasons including hardware 

failure or operating system failures.  If you are unable to open your file, 

you may try using File | Open and un-checking some of the options at 

the bottom (such as Read Results).  These options tell VisualAnalysis

what information to read from the project file.  Things like results can 

easily be recreated if necessary.  If you are still unable to open the current 

project file, look to one of the history files or the timed backup files for a 

safe copy. 

Data Files 

Some of these files are customizable.  The most likely cause of the 

problem is that you customized one of the files and made some changes 

that violated its format requirements. To solve the problem, first open the 

file (for those that can be opened – text files) and examine it for obvious 

format requirements.  Original files can be found on your CD in the \Data 

folder.  You may copy these files to overwrite the corrupted or missing 

files.  Be sure to mark the file as not "read-only".  (All files on the CD 

are marked "read-only".) 
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One common problem we have seen is modifying a file and then saving 

it in a word processing format, which adds formatting symbols that 

VisualAnalysis does not understand.  Open the file again in your word 

processor and save it as ASCII text. 

If the software simply cannot find the file, then you may need to adjust 

the file location.  Choose Tools | Customize and go to the Files tab.  

At the bottom of the dialog you can specify the location of each data file. 

Support Services 

Please Contact IES 

¶ If you cannot get VisualAnalysis installed. 

¶ If the software or the documentation is confusing. 

¶ If terminology is not explained well. 

¶ If features or documentation cannot be found. 

¶ If VisualAnalysis fails to perform flawlessly. 

¶ If VisualAnalysis crashes. 

Do Not Contact IES 

¶ Please do not call with questions about how to model a particular 

structure.  Such questions are your responsibility as an engineer.  

IES is not in the business of consulting. 

¶ Please do not call with questions about engineering theory.  IES is 

not in the business of educating engineers. 

¶ Please do not call with questions about the Windows operating 

system on your PC.  IES is not Microsoft, HP, Dell, or Gateway! 

Support Resources 

Built-in Support 

IES has gone to significant lengths to provide resources right in 

VisualAnalysis for resolving problems you may encounter.  Your first 

source of information and answers to questions should be the Help
menu.  

Help | What’s This? is available for most screen items.  You can 

access it using the Main Menu command, the Context Menu command or 

the Question Mark button in the upper right corner of dialog boxes and 

wizards.  Once you have accessed What's This? your cursor will change.  

Simply click on the item in question and a helpful dialog should appear.  

This is the front-line of help because it provides concise information 

when and where you need it.   

Help | Contents provides a complete reference for VisualAnalysis and 

add-on products.  There is a table of contents, index and a keyword 
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search to help you find the information you need quickly.  Use this for 

more detailed discussions of how to accomplish  

Help | iesweb.com | Update VisualAnalysis will make sure that 

your files are the same as our files.  We generally release updates or 

patches frequently to address minor problems or suggestions.  Running 

the latest version is a great way to avoid the problems we have already 

addressed. 

Help | iesweb.com | Customer Center is the central hub for IES 

customers on our website.  The Customer Center has links to many items 

of interest to customers including updates, newsletters, FAQs, tips & 

tricks, and much more.

Help | iesweb.com | Email IES Technical Support brings up a 

new email message in your default email program.  This message will 

already have the correct address in it and will also have a couple files 

attached to it.  These files are diagnostic files that allow IES Technical 

Support to look for any potential problems in your installation.  The only 

thing you need to do is provide as much detail as you can about the 

nature of the problem you are having in the body of the message.  Send 

the message off and we will get back to you as soon as we can. 

Additional Resources 

VisualAnalysis comes with resources outside of the software itself to help 

you avoid problems, learn faster and easier, and to give you ideas.  This 

includes printed or PDF books: this User’s Guide, a Tutorial, and a Quick 

Start.  Add-on products like VisualDesign and VisualTools also come 

with printed or PDF manuals describing their features. 

There are a number of example projects installed with the software in an 

Examples folder.  Easily access these by choosing File | Open 
Examples.  These go along with the tutorial book, but you may open 

them and experiment with them on your own.   You should also look on 

the distribution CD for presentations, and other documents that may be 

helpful. 

Send Your Ideas 

We encourage you to send us ideas and constructive criticism.  Help | 
iesweb.com | Make a Suggestion is the easiest way to remind us 

that VisualAnalysis is not perfect yet.  As you use the software you will 

find yourself saying, “I wish VisualAnalysis could…” Before you forget 

the thought, just pull down this menu item and let us know through our 

web site suggestion box. 

Contact IES 

Before you contact us directly, please try the above resources first.  If 

you find that your particular issue is not addressed, feel free to contact us. 

We operate most efficiently by email and will often respond within a 

couple hours (possibly even sooner!). We are dedicated to making sure 

your questions get answered and problems resolved as quickly as 

possible. 
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The following methods put you in direct contact with the engineers that 

develop the software.  Please resort to these only after you have tried the 

alternatives above: 

¶ Direct Email: Use the Help menu command if possible, otherwise 

you may send a message to support@iesweb.com

¶ Business: If you need a quote on additional products, upgrades, or 

extra licenses, please use sales@iesweb.com.

¶ Phone Support: 406-586-2665, 8:30-4:30 MST. Please do not use 

our 800-number for technical support questions! 

¶ Fax Support: 406-586-2665 (a switched line) 24 hours. 
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Glossary of Terms 

PDF

PDF stands for Portable Document Format.  PDF files can be read with 

Adobe Acrobat Reader which can be downloaded for free at 

www.adobe.com. 

right hand rule 

Thumb points in the axis of rotation direction, positive rotation follows 

curl of fingers. 

Result Case 

A set of results for a specific load case or combination.  There may be 

multiple result cases for a single load case.  Results may be 1st order, 2nd 

order, or (in the advanced level) dynamic time history results at a specific 

time. 

ShapeBuilder

A stand-alone IES program for the creation of built-up and custom cross 

sections. 

VisualTools

An add-on suite of tools that extend the functionality of VisualAnalysis.  

Tools are integrated directly into the VisualAnalysis menu system. 

Shape Database Editor 

A stand-alone program for modifying the shape database that 

VisualAnalysis and other IES products use.  If it is installed, you will 

find it in the Start menu. 

Material Database Editor 

A stand-alone program for modifying the material database that 

VisualAnalysis and other IES products use.  If it is installed, you will 

find it in the Start menu. 
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Cut Plane 

A 2D slice (with depth) in a 3D view.  Use Cut Planes to show a floor 

plan, wall elevation, or some other portion of a 3D model. 

Dialog Box 

A data entry window, usually with an OK and a Cancel button along with 

other "controls" such as check boxes, lists, radio buttons, and edit fields.  

Normally a dialog box takes control of the software and must be 

dismissed before other commands can be given. 

Graphic View 

The Model, Picture, Result and Design views are referred to collectively 

as graphic views.  They display a graphic sketch of your model. 

Keyboard Shortcuts 

A keystroke that is equivalent to selecting a menu item or clicking on a 

dialog control.  Usually Alt+Letter, where the letter is underlined in the 

menu or control name. 

Name Filter 

Used to show or hide objects by name.  These are lists of names or name 

prefix strings and regular expressions to control which objects are 

visible. 

Object

A selectable model or load object.  Model objects are nodes, members, 

plates, and spring supports.  Load objects are nodal loads, member loads, 

and plate loads.  Also referred to as selectable items. 

POL Script 

Problem Oriented Language file used to describe a structure, model and 

loads.  These are simple ASCII text files, usually with a POL extension.  

They are useful for exchanging basic project information between 

different software packages or for merging information from multiple 

projects.  Some people use spreadsheets and other tools to generate these 

scripts to model things that are difficult to do directly in VisualAnalysis.  

POL commands are documented in a separate help file installed with the 

software. 

Project

The complete information about your model, loads, results, and design 

information is referred to as a project.  The term may also refer to the file 

created when you save your work. 
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Regular Expression 

A coded string for pattern matching.  Name filters can use regular 

expressions.  You have probably used wildcard symbols when searching 

for files (e.g., *.txt or File??.txt).  Regular expressions are like wildcards, 

but more powerful. 

Service Load Case 

A container for real, physical loads on a structure. 

Sketch Grid 

A rectangular or polar pattern that determines where new nodes will be 

created.  Turn it on and adjust the spacing to allow you to sketch models 

to exact coordinates. 

Statics Check 

A check on the software and your model to ensure that the sum of 

applied loads balances the sum of reactions in each direction.  An 

imbalance can indicate problems. 

Structure

The type of finite element model.  Structure type determines 

dimensionality, degrees of freedom at nodes, possible element behaviors, 

and default joint behavior.  Available types are: truss, frame and grid. 

Unit Styles 

A set of units for each of the physical quantity types in the software.  For 

example, member depth, modulus of elasticity, etc.  Spend a few minutes 

creating a style and then reuse it on all of your projects. 
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acceleration 60 
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cable 120 
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Clip to Selected 118, 139 

cluster factor 86 
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compression 45, 70, 87, 124–25, 

131, 142 
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CQC Method 73 
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Custom Toolbars 112 
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108

D

damping factor 73, 86 

Data Files 4–9, 108, 152 

decimal point 40 

default value 69, 74, 107 

deflected shape 26, 66–67 

deformation 64 

delete load case 54 

Design code 90 

design groups 19, 29 

design parameters 89 

Design View 17, 21–22, 29–30 

diagrams 21, 74, 77, 79–81 

disaster prevention 107 

displaced shape 78–79, 134 

Distributed Member Load 88 

distributed shear forces 79 

distributed twisting moment 79 

draw 19, 24, 40, 43–44, 127, 137 

DXF files 34 
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dynamic analysis 59–60, 64, 71–72, 

75, 133, 145, 147 

Dynamic Response Case 52, 147 

E

edit selected 28 

elastic support 45 

elasticity 73, 87, 119, 132 

elevation 41 

elevations 41 

emulators 3 

End forces 73 

end release 39, 55, 136 

end releases 39, 55, 66, 118, 121, 

134, 139, 141 

End Zones 87, 119 

ending node 89, 92 

envelope 77 

equation combination 52 

Equation Load Combination 52 

equilibrium 64, 67, 70–71, 73 

Esc key 43–44 

examples 26–27, 47, 120, 129, 154 

export 36, 81–83, 96, 98 

exporting 36, 81–83, 96, 98 

expressions 26, 32, 109 

extreme value 81, 92, 135 

F

Factored Load Combination 52 

file corruption 108 

Filter tab 19, 22–24, 25–27, 45, 57, 

77–80, 111, 128, 134–35 

filtered 29, 57 

Find tool 16, 19–20, 27–28, 29, 31, 

45, 56–58, 104, 112, 134 

finite elements 64 

first order 70 

float 18–20, 104, 134 

floor plan 27, 41, 42 

floor systems 42 

fluid density 56 

font 82, 93, 110 

Fonts 82, 93, 110 

footers 33, 95, 109 

formatting 33, 84, 109, 153 

frame instability 65, 71 

fundamental frequencies 71 

G

geometric stiffness correction 71 

girder 47, 82, 120 

global axes 23, 133 

Global Coordinates 45, 114, 123, 

131–34

graphics issues 152 

gripper 18–19, 104 

H

hardware requirements 3, 152 

headers 33, 95, 109 

Help 6, 8–11, 20–21, 34, 140, 151, 

153–55

hinge 39, 55, 136 

huge reports 85 

I

iesweb.com 8, 11–12, 20–21, 151, 

154–55

import 8, 34–35, 41, 96–98 

internal forces 12, 81, 91 

invert selection 19, 28 

isotropic 23, 65 

iteration limit 69, 74 

iterative 65, 69–71, 74 

K

Keyboard Shortcuts 7 

L

large deflections 64, 67, 71 

large displacements 68, 141 

large rotations 64 

length 32, 48, 55, 70, 73, 88–89, 111, 

117, 120, 123–24, 129–30, 

132, 145 

license agreement 10 

linear 55–56, 58, 69, 117, 123, 125, 

130, 142–43 

linear analysis 89 

Linear Analysis 69, 142 

load combination 52–53, 59, 89, 147 

load factor 52, 59, 89 

load reduction 88 

Load Sources 51, 59, 114, 116 

Local Coordinate System 48, 78–79, 

121–23, 128, 144 

local forces 78, 91, 121, 124, 127 

local stresses 78 

LRFD 114, 117 

lumped nodal mass 60 
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M

machinery 51, 71 

magnitude 52, 54–56, 60, 67, 88, 94, 

124, 134 

margins 33, 109 

material nonlinearity 70 

materials 1, 12, 21, 65, 68, 86, 108, 

124, 134 

maximum extreme 92 

Mechanism Errors 63, 66, 139, 142 

Member Graphs 61, 81, 93 

member results 21, 70, 73–74, 78, 

91–92, 124 

membrane stresses 71, 78–79, 88, 

128, 130–31 

menu hints 16, 18, 107 

metafile 81 

mid-pla 79, 89, 131 

minimum extreme 92 

mirror 42 

modal analysis 71, 147 

modal weight 72 

Mode Shape 71–72, 146–48 

mode shapes 71–72, 147 

model 17–27, 29, 31, 34–36, 39–47, 

51, 53–61, 63–65, 67–69, 71–

74, 78, 80, 84–85, 89–90, 109–

10, 113–14, 116, 118, 120–22, 

125–26, 129, 131–47, 153 

model size 65, 74 

Modify tab 19, 27–28, 30–31, 45–46, 

48, 53, 58, 60, 114, 118, 134, 

140, 144 

mouse 1–2, 16–18, 20, 24, 29–30, 

43, 57, 77, 80–81, 95 

move nodes 41, 46, 121 

multiple selections 30 

N

Name Colors 111 

Network Installation 4, 6 

Nodal Load 86–88, 136 

nodal settlement 133 

node 19, 22, 25, 27, 30, 40, 43–48, 

54–57, 59, 63, 65, 66, 71–72, 

75, 81, 85, 106–7, 113–14, 

120–21, 126, 129, 133, 136–

38, 140, 145 

node tolerance 107 

nodes 19, 22, 25, 27, 30, 40, 43–48, 

54–57, 59, 63, 65, 66, 71–72, 

75, 81, 85, 106–7, 113–14, 

120–21, 126, 129, 133, 136–

38, 140, 145 

nonlinearity 64, 70 

notation 78, 86, 122, 130, 140 

O

Object View 21 

One-way Elements 69, 142 

one-way members 63, 69 

one-way spring supports 63 

OpenGL 3, 152 

options 31, 34–36, 42, 63, 78, 84–85, 

94, 96, 98, 107, 109–11, 134, 

152

organize 25, 51, 94, 114, 116 

orientation 18, 33, 46, 114, 121–23, 

143

orthotropic 23, 65 

P

P Delta 63, 89 

parametric definitions 42 

participation factors 72, 90 

patches 9, 21, 154 

P-Delta 63, 70, 89 

P-Delta Analysis 70 

performance 3, 22, 43, 65, 69, 73–

74, 84–85, 109, 120, 152 

Period of vibration 90 

Picture View 2, 21, 26, 110, 134, 

139, 144 

plane frame 98, 121, 133 

plane truss 98 

plate element size 129 

plate loads 30, 56, 89 

plate mesh 21, 44, 47, 56–57, 74, 82, 

136, 137 

plate pressures 56 

point loads 55 

PR 70, 86, 88–90 

pre-defined reports 85 

prefix 17, 45 

prevent selection 29 

Previous View 24 

Print Preview 33–34, 77, 81–83, 96, 

151

printed reports 77 

printer drivers 152 

program files 4–7, 13, 98, 108 

Project 8, 11, 18, 27, 32, 34–36, 39, 

41, 43, 51–52, 59, 69–70, 84–
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85, 94–96, 103–4, 106–9, 129, 

143, 152 
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28, 30, 32, 40, 45–48, 53, 57, 

60–61, 64, 67, 77–81, 104, 

107, 111–12, 114, 118–19, 

128, 134, 140, 144 

projected length 89, 124 
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quick report 91 

R
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Redo 31 
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Rename Objects 45, 99, 108 
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84–86, 91–99, 108–9, 122–23, 
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Report Notation 86 

report style 93, 98 
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result case 18, 77, 89, 92, 95 

result tables 74, 94–95 

Result View 17, 19, 21, 25, 61, 77, 

80–82, 91, 95, 99, 134 
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rotation 17–18, 23, 27, 33, 39, 46, 
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119–20, 122–24, 133, 140, 144 
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self-weight 41, 51, 53–54, 59–60, 66, 
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semi rigid 70, 86, 88–90 

semi-rigid 70, 86, 88–90 

Service Load Case 51, 53, 59, 88 

Serviceability 61 

settlement 133 

settlement 51, 54, 117, 131–33 

ShapeBuilder 12, 108 

shear forces 78–79 

Shortcuts 7, 16, 106, 112 

sign convention 78, 124, 130–32 

simple 3–4, 7, 26, 31, 36, 43, 69–70, 

91, 118, 122, 137–38, 142–43, 

145

sketch 13, 16, 19, 22, 25, 40, 43–44, 

114, 117, 120, 122, 124, 130 

slabs 42, 120, 126 

slice 19, 24–25 

small displacement 134 

soil 45, 120, 131 

sorting 19, 27, 94, 98 

Space Frame 98, 122, 144 

space truss 98, 141 

specified displacement 54 

spectrum.txt 60 

Spherical coordinate 46, 89–90, 114 

spherical coordinates 46, 89–90, 114 

Split Members 47, 123 

spreadsheet 53, 59, 96, 108 

Spring supports 22, 25, 63, 85, 87, 

120, 142 

SRSS Method 73 

stability 2, 65–67, 69–70, 134, 143 

starting end 87, 88 

starting node 44, 89, 92, 117, 124 

static analysis 43, 69, 146 

Steel 12, 36, 40, 68, 108, 114, 118–

19, 138, 144 

stiffness 66, 70–72, 86–87, 90, 119–

20, 125, 131, 141 

Strength 61, 124 

stress colors 82 

Structure Types 44, 65, 93, 96–98, 

108, 113–14, 123, 128, 133 

Style Manager 93, 97 

subgrade modulus 120, 132 

suggestion box 154 

summaries 84, 93 

summary 84, 93 

superposition 69, 72 

support settlement 54, 131 

system registry 4–5, 105 

T

Tab Delimited 53, 96, 108 
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Table Duplicates 96 

Table of Contents 153 

tables 74, 84, 91–94, 123 

tanks 42 

Taper 90, 121 

tapered members 2, 72, 121 

TEMP folder 107–8 

temperature change 56, 123, 130 

tension 36, 78, 87, 120, 125, 142 

tension-only 69, 74, 89, 120, 142 

thermal loads 56, 123 

Theta Angles 120, 123, 144 

Thick Plate 2, 125–26 

time history 54 

time history analysis 54 

Timed Backups 35, 108, 152 

time-history 54 

tolerance 67, 107 

torsional moment 78 

transformed 88–90, 131 
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trial and error 11, 65, 75 

triangular element 44, 126 
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Troubleshooting 98, 135, 151 
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video drivers 152 

virtual memory 65 
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